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Welcome 

Mapping Exclusive Electromagnetic Space with Cutting-edge Testing 

Ceyear 1466 series signal generator 

is a general test instrument used for 

microwave and millimeter wave 

cutting-edge testing. It features wide 

frequency coverage, large RF modulation 

bandwidth, high signal spectrum purity, 

power output with high accuracy and wide 

dynamic range, excellent vector 

modulation accuracy and ACLR 

performance. With the design of 

single-unit dual-RF channel and cascade 

of multiple instruments, it can meet 

various test requirements. It has built-in 

functions including analog sweep, analog 

modulation, digital modulation, fading 

simulation, arbitrary wave, and AWGN, 

making daily testing easier. By 

cooperating with simulation software, it 

can achieve multi-scenario signal 

simulation, making the testing that is 

performed in complex scenarios such as 

wireless communication, mobile 

communication and electronic warfare 

easier. It incorporates newly upgraded 

human-computer interaction that supports 

a series of new functions including 

large-screen touch graphic guided 

interaction, mobile browser access control, 

multi-manufacturer power meter 

connection recognition, multi-client 

deployment, SCPI command recording, 

control interface customization and 

baseband waveform preview, in order to 

create happiness for users during testing. 

Ceyear 1466 series signal generator is 

ideal for demanding testing from 

components to systems in cutting-edge 

technology areas such as radar, 

communications, aerospace and defense. 
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Foreword 

Thank you for choosing and using 1466 series signal generator developed and 

produced by Ceyear Technologies Co., Ltd.! With high, precision and frontier technologies 

comprehensive, the product enjoys high quality and cost performances compared with 

similar products. 

We will take the responsibility to meet your needs and provide you with high-quality 

measuring instruments and first-class after-sales service. We aim to provide "high quality 

and considerate service”, and operate on the principle of making customers satisfactory 

with our products and services. 

 

Manual No. 

2.827.1576 SSCN 

 

Version 

A.2  2024.01  

Ceyear Technologies Co., Ltd. 

 

 

 

 

 

 

 

 

 



 

 

Main features 

Excellent RF performance and rich functions: 

• Coaxial frequency coverage 

6kHz~13GHz/20GHz/33GHz/45GHz/53GHz/67GHz/90GHz/110GHz; 

• Excellent spectrum purity, SSB - 132 dBc/Hz (typical value, 10 GHz carrier wave, 

10 kHz frequency offset), spurious < -80 dBc (10 GHz carrier wave); 

• Excellent bandwidth bottom noise, SSB - 161 dBc/Hz (typical value, 20GHz carrier 

wave, 30MHz frequency offset); 

• Large output power dynamic range which can be -150dBm~+25dBm (settable) at 

most; 

• Support AM, FM, ΦM and pulse modulation with minimum pulse width of 20ns; 

• Support step sweep, list sweep, power sweep, and analog sweep; 

• Maximum 2GHz RF modulation bandwidth, 500MHz/1GHz/2GHz bandwidth can 

be flexibly selected; 

• Excellent vector modulation accuracy, EVM <0.8% (5GNR, FR2 28GHz); 

• Support single-unit dual-channel, each of which can be set independently. 

 

Rich built-in functions 

• Rich modulation functions, covering analog modulation, pulse modulation and 33 

digital modulations; 

• Support user-defined arbitrary wave data sampling rate playback; 

• Support continuous wave multi-tone and complex multi-carrier modulation; 

• More than 600 mobile communication TestModel/FRC covering 5G NR, LTE and 

other protocols; 

• Integrated WLAN standard wireless connection signal simulation; 

• Multi-type noise addition and real-time fading simulation; 

 

Multi-scenario signal simulation 

• Support simulation of emission, echo, clutter and other radar pulse signals; 
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• Support multi-target dynamic radar scenario signal simulation; 

• Support editing simulation with multiple communication protocols and flexible 

signals; 

• Single-unit dual-channel + cascade of multiple instruments, multi-channel 

independent or phase-coherent output flexible configuration; 

Newly-upgraded human-computer interaction 

• Large-screen touch graphic guided interaction that supports user-defined menu; 

• Cross-platform client and browser access control; 

• SCPI command real-time recording and programmed control example project 

automatic-generation. 

For more information, refer to product sample and data manual. 

Documentation Overview 

This section summarizes the user documentation about Ceyear 1466 series signal 

generator. Unless otherwise stated, you can find the file on the Ceyear product page: 

www.ceyear.com  

About the Manual 

This manual introduces the basic functions and basic operating methods of the 1466 

series signal generators. It describes such contents as product features, basic operations, 

configuration guide, maintenance, technical indicators and testing methods, etc. of the 

instrument to help users get familiar with and master the operation method and key points 

of the instrument as soon as possible. To facilitate your skillful use of such instrument, 

please read carefully and follow this manual in advance for correct operation. 

Related Documents 

Documents of 1466 series signal generator include: 

 Quick Start Guide 

 User's Manual 

 Remote Control Manual 

 Product sample 

 



 

 

Quick Start Guide 

It introduces the configuration of the instrument and basic operations for starting 

configurations with the purpose of: making users quickly understand the characteristics of 

the instrument, master the basic settings and basic local and program-controlled 

operations. Main chapters include: 

 Get Prepared 

 Typical Applications 

 Get Help 

 

User's Manual 

It introduces the functions and operation methods of the instrument in detail, including 

configuration, program control, and maintenance, etc.. The purpose is to guide users to 

fully understand the functional characteristics of the product and master common testing 

methods of the network analyzer. Main chapters include the following: 

 Manual Navigation 

 Overview 

 Quick Start 

 Operation Guide 

 Technical Indicators and Testing Methods 

 

Remote Control Manual 

It introduces such contents as programmed control programming foundation, SCPI 

foundation, SCPI commands, programming examples and I/O driver function library in 

detail. The purpose is to guide users to quickly and comprehensively master the remote 

control commands and methods of the instrument. Main chapters include the following: 

 Remote Control 

 Remote Control Commands 

 Programming Examples 

 Error Description 

 Annex 

 

Product sample 
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The product features, functions, technical indicators, selection instructions, etc. are 

introduced in detail. 

Manual Authorization 

The contents of this manual are subject to change without notice. The contents and 

terms used in this manual are interpreted by Ceyear Technologies Co., Ltd. 

The copyright of the manual belongs to Ceyear Technologies Co., Ltd, no 

modification can be made to the manual contents by any unit or person without approval 

of the Institute, and no reproduction or propagation of the manual can be made for profits, 

otherwise, Ceyear Technologies Co., Ltd reserves the right of pursuing legal 

responsibilities from any infringer. 

Scope and Content 

This description assumes that the Ceyear 1466 series signal generator is provided 

with all available options. Depending on the model of your product and installed options, 

some functions are not available on your instrument. 

Matters needing attention in the attached figure 

We describe product functions using example screenshots. The screenshots are 

intended to illustrate as much as possible the functions provided and the possible 

interdependencies between the parameters. The values displayed may not represent 

actual usage scenarios. 

The screenshot typically shows the product with complete options, i.e., all options are 

installed. For this reason, some function shown in the screenshot may not be available in 

your specific product configuration. 

Obtaining Information and Help 

In case of any failure to the Ceyear 1466 series signal generators, check and save 

the error message, analyze possible causes, and refer to the methods provided in 

“Troubleshooting and Failure Removal” for preliminary troubleshooting. If the problem 

cannot be solved, contact the service and consultation center of the Company as per the 

contact information provided below and provide us with the error collected. We will 

coordinate with you to solve the problem as soon as possible. 

 



 

 

 

 

 

 

Contact information: 

Service Consultation: 0532--86889847   400--1684191 

Technical Support: 0532--86880796 

Quality Supervision: 0532--86886614 

Fax:0532--86889056 

Website: www.ceyear.com 

E-mail: techbb@ceyear.com 

Address: No. 98, Xiangjiang Road, Huangdao District, Qingdao, Shandong Province 

Post Code: 266555 

file:///C:/Users/liuqingsong/AppData/Local/Temp/www.ceyear.com
file:///C:/Users/liuqingsong/AppData/Local/Temp/techbb@ceyear.com
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Safety and Regulatory Information 

Please read carefully and strictly observe the following precautions! 

We will spare no effort to ensure that all production processes meet the safety 

standards and provide users with the safety guarantee. The design and testing of our 

products and the auxiliary equipment used meet relevant safety standards, and a quality 

assurance system has been established to monitor the product quality and ensure the 

products to always comply with such standards. In order to keep the equipment in good 

condition and ensure operation safety, please observe the precautions mentioned in this 

manual. If you have any questions, please feel free to consult us. 

In addition, the correct use of this product is also your responsibility. Please read 

carefully and observe the safety instructions before starting to use this instrument. This 

product is suitable for use in industrial and laboratory environments or field measurement. 

Always use the product correctly according to its restrictions to avoid personal injury or 

property damage. You will be responsible for problems caused by improper use of the 

product or noncompliance with the requirements, and we will not be held responsible. 

Therefore, please always observe the safety instructions to prevent personal injury 

or property damage caused by dangerous situations. Please keep the basic safety 

instructions and the product documentation properly and deliver them to end users. 

Safety Instructions 

Safety marks on the products are described as follows: 

Products safety marks 

Symbol Meaning Symbol Meaning 

 

 

 

Notice, reminding users of 

information to be paid special 

attention to. It reminds users of 

the operation information or 

instructions to be paid attention 

to. 

 

 

 

Power ON/OFF 

 

 

 

Notice, handling heavy 

equipment. 

 

 

 

Standby indication 

 

 

Danger! Hazard of electric shock.  

 

DC 
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Warning! Hot surface.  

 

 

AC 

 

 

 

Protective conductive end  

 

 

DC/AC 

 

 

 

Ground  

 

 

Reinforced insulation 

protection of the instrument 

 

 

 

Ground terminal  

 

 

EU mark for batteries and 

accumulators. 

Please refer to Item 1 of "2.2.8 

Waste Disposal/Environmental 

Protection" in this section for 

specific instructions. 

 

 

 

Notice, please handle classical 

sensitive devices with care. 

 

 

 

 

EU mark for separate 

collection of electronic devices. 

Please refer to Item 2 of "2.2.8 

Waste Disposal/Environmental 

Protection" in this section for 

specific instructions. 

 

 

 

Warning! Radiation.  

 

 

 

 

In order to remind users to operate the instrument safely and pay attention to relevant 

information, the following safety warning marks are used in the product manual, which are 

explained as follows: 

 

   Danger mark, personal injury or equipment damage may 

be caused if not avoided. 

  Warning mark, personal injury or equipment damage may 

be caused if not avoided.    

   Caution mark, slight or medium personal injury or 

equipment damage may be caused if not avoided. 

Danger !
      

Warning !
      

Caution !
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  Notice mark, indicating some important information which 

will not cause danger. 

  Tips on information about the instrument and its operation. 

 

Operation Status and Locations 

Unless otherwise stated, the operating environment of 1466 series signal generators 

should meet the requirements of Class 3 environment level in GJB3947A-2009. 

Non-operating temperature: -40°C ~ + 70°C; Operating temperature: 0°C ~ 50°C; Relative 

Humidity: (5% ~ 95%)+5% RH; Random vibration: frequency 5 ~ 100 Hz, power spectral 

density 0.015g2/Hz; Frequency 100 ~ 137 Hz, gradient -6 dB; Frequency 137 ~ 350 Hz, 

power spectral density 0.0075g2/Hz; Frequency 350 ~ 500 Hz, gradient -6 dB; Frequency 

500Hz, power spectral density 0.0039g2/Hz; Functional impact: 20g semi-sinusoidal 

impact; Tilt drop: with one side as the fulcrum, lift the opposite side of the base to the 

height of 10cm, and allow the base to fall freely onto the test bench. 

Do not place the instrument on surfaces with water, vehicles, cabinets, tables and 

other objects that are not fixed and do not meet the load conditions. Please place the 

instrument securely and fix it on the surface of a solid object (e.g., an ESD workbench). 

Do not place the instrument on the surface of a heat-dissipating object (e.g., a 

radiator). The operating environment temperature shall not exceed the value specified in 

the description of relevant indicators of the product. Overheating of the product will lead to 

electric shock, fire and other risks. 

The instrument is required to be pre-heated for 30 min for cold start, and it will reach 

internal temperature balance after pre-heating for 2 hours at a stable ambient temperature. 

After the instrument is placed at ambient temperature for 2h, preheated and passes 

thorough  user calibration, it should meet various performance indicators. 

Electrical safety 

1) Before the instrument is powered on, the actual supply voltage should match the 

supply voltage marked on the instrument. 

2) According to the power requirements of the real panel of the instrument, a 

three-core power cord should be adopted while ensuring reliable grounding of the ground 

wire during operation. Either floating ground or poor grounding may cause damage to the 

instrument and even cause injury to operators. 

3) Do not damage the power cord, otherwise electric leakage will be caused, 

resulting in damage to the instrument and even injury of the operators. If an external 

power cord or extension socket is used, it should be checked before use to ensure 

electrical safety. 

Notice 

Tips 
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4) If the power supply socket does not provide an on/off switch,to cut the power of 

the instrument, you can just directly unplug the instrument, and therefore, it should be 

ensured that the power plug can be inserted or drawn conveniently. 

5) Do not use damaged power cords. Before connecting the instrument to the 

power cord, check the integrity and safety of the power cord, and properly place the power 

cord to avoid the impact due to human factors, such as, too long power cord that may trip 

the operator. 

6) Keep the socket clean and tidy, and ensure the plug and the socket in good 

contact and reliable engagement. 

7) Neither the socket nor the power cord can be overloaded, otherwise fire or 

electric shock will be caused. 

8) Unless otherwise allowed, do not open the housing of the instrument, which may 

expose internal circuits and devices of the instrument and cause unnecessary damage. 

9) If the instrument needs to be fixed at the test site, a qualified electrician is 

required to install the protective earth wire between the test site and the instrument first. 

10) Take appropriate overload protections to prevent overload voltage (caused by 

lightning, for instance) from damaging the instrument or causing personal injury. 

11) When opening the housing of the instrument, do not place objects not belonging 

to the interior of the instrument, otherwise, short circuit, damage to the instrument and 

even personal injury may be caused. 

12) Unless otherwise stated, the instrument has not received any waterproof 

treatment, so keep the instrument from contacting with liquid to prevent damage to the 

instrument or even personal injury. 

13) Do not place the instrument in an environment where fog is easily formed, for 

example, moving the instrument in a environment where cold and heat are in alternation, 

where water droplets formed on the instrument may cause electric shock and other 

hazards. 

 

Set the instrument 

Always place the instrument on a stable, flat, and level surface with its bottom facing 

downward. 

To save space, you can install multiple instruments in a single rack. Before stacking 

up instruments, keep in mind that stacked instruments can tilt and cause injury. 

In case the instrument has foldable feet, you must always completely fold the feet to 

ensure stability. If the foot is not completely folded or the instrument can be moved but 
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cannot be lifted, the foot may collapse. The foldable feet are designed to carry the weight 

of the instrument without adding additional load. 

Connect to the power supply 

The maximum power consumption of the power supply of the instrument is 400W. 

The power supply should be adaptive supply with 50 Hz ~ 60 Hz, single-phase 110V or 

220V. The steady-state condition of the power supply should meets the requirements of 

3.5.1.3 in GJB3947A-2009. The allowable range of steady-state voltage is 10% of the 

rated value and the allowable range of steady-state frequency is 5% of the rated value. 

Transportation 

1) If the instrument is heavy, please handle it with care. If necessary, use tools (a 

crane, for instance) to move the instrument so as to prevent damaging the body. 

2) The handle of the instrument is suitable for personal handling of the instrument 

and cannot be fixed on the transportation equipment when during the transportation of the 

instrument. To prevent property loss and personal injury, please follow the manufacturer's 

safety regulations on the transportation of the instrument. 

3) When operating the instrument on the vehicle, the driver should drive carefully to 

ensure transportation safety, and the manufacturer is not responsible for any emergencies 

during the transportation. Therefore, please do not use this instrument during the 

transportation, and reinforcement and preventive measures should be taken to ensure the 

transportation safety of the product. 

Product Cleaning 

Use lint-free, dry cloth to clean the product. When cleaning, remind in mind that the 

case is not waterproof. Do not use liquid cleaners. 

Waster Disposal/Environmental Protection 

1) Do not dispose of devices marked with batteries or accumulators together with 

unclassified waste; Instead, such devices should be collected separately and disposed of 

in a suitable collection location or through the customer service center of the 

manufacturer. 

2) Do not dispose of waste electronic devices together with unclassified waste; 

Instead, such devices should be collected separately. The manufacturer has the right and 

responsibility to help end users dispose of waste products. If necessary, please contact 

the customer service center of the manufacturer for corresponding disposal so as not to 

damage the environment. 

3) During mechanical or thermal processing of the product or its internal 

components, toxic substances (dust of heavy metals, such as lead, beryllium, and nickel, 

etc.) may be released. Therefore, specially trained technicians with relevant experience 

are required to disassemble the product to avoid personal injury. 
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4) During the reprocessing, please refer to the safety operation rules recommended 

by the manufacturer to dispose of toxic substances or fuel released from the product with 

specific methods to avoid causing personal injury. 
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Start 

Content 

• Get Prepared 

• Guide to Panel 

• Understanding and Preliminary Use of Instrument 

• New Functions and Features of Instrument 

• Instrument Control 

Get Prepared 

This chapter describes the basic steps to follow when setting the Ceyear 1466 series 

signal generator for the first time. 

Content 

• Lift and Handle 

• Unpackage and Inspect 

• Preparation for Test 

• Connect to the Power supply 

• Proper Operation of Connectors 

• Connect to LAN 

• Connect USB Device 

• Connect to RF Output A/RF Output B 

• Connect to LO I/O 

• Connect to Reference I/O (RF Coherent I/O) 

• Connect to High-speed Optical Port 

• Turn on/off 

• Operating System Configuration•

 



Start 

Get Prepared 

 

Lift and Handle 

Ceyear 1466 may be heavy if necessary. Use the lifting equipment.  

Use the two front handles to lift and carry the Ceyear 1466 signal generator. 

The Ceyear 1466 signal generator can be installed in the rack by removing the 

handle. 

 

Unpackage and Inspect 

1. Carefully unpack the Ceyear 1466 signal generator. 

2. Keep the original packaging material. These materials are used to protect control 

elements and connectors during future shipping or transportation of Ceyear 1466 signal 

generator. 

3. Check the integrity of the equipment against the delivery note. 

4. Check the device for damage. 

If the delivery is incomplete or the equipment is damaged, please contact Ceyear 

Technologies Co., Ltd. 

 

Content 

• Place Ceyear 1466 Signal Generator On the Bench 

• Install Ceyear 1466 Signal Generator In the Rack 

Place Ceyear 1466 Signal Generator On the Bench 

Place Ceyear 1466 Signal Generator On the Bench 

Place Ceyear 1466 signal generator on a stable, flat and level surface. Make sure the 

surface can carry the weight of Ceyear 1466 signal generator. For information on weight, 

please refer to the data sheet. 

 Stacked instruments may fall and cause damage. Never stack more than three 

instruments on top of each other. Instead, you should install them in a rack. 

Warning !
      

Danger !
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Stack the instruments as follows: 

• It is better that all instruments have the same dimensions (width and length). 

• The total load of the lowest instruments should not exceed 500 N. 

• For smaller instruments on top of the lowest instruments, the total load of the 

lowest instrument should not exceed 250 N. 

 

 

 

Overheating can damage Ceyear 1466 signal generator. 

Measures taken to prevent overheating are as follows: 

• Keep at least 10 cm between the fan opening of the Ceyear 1466 signal 

generator and any nearby objects. 

• Do not place Ceyear 1466 signal generator next to the radiator, other 

instruments and heat-generating equipment. 

 

Installing Ceyear 1466 Signal Generator in the Rack 

 

Preparation for Rack 

Follow the requirements and instructions in Instrument Settings. The rack shall be 

designed as an efficient ventilation structure. 

 

Warning !
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Insufficient airflow can cause overheating and damage to the Ceyear 1466 signal 

generator. The rack shall be designed or provided with a means of efficient ventilation. 

 

Installing Ceyear 1466 Signal Generator in the Rack 

1. Prepare the instrument for rack installation using adapter kit that fits the size of the 

Ceyear 1466 signal generator. For information on dimensions, please refer to the data 

sheet. 

a. Order adapter kit for the rack that is designed specifically for Ceyear 1466 signal 

generator. For order numbers, please refer to the data sheet. 

b. Install the adapter kit. Follow the assembly instructions accompanied with the 

adapter kit. 

Ceyear 1466 signal generator can be heavy if fully equipped. Use the lifting equipment 

to lift the Ceyear 1466 signal generator to shelf height. 

 

2. Grasp the handle and push the Ceyear 1466 signal generator onto the shelf until the 

rack bracket fits closely against the rack. 

3. Tighten all screws on the rack bracket to 1.2 Nm to secure the Ceyear 1466 signal 

generator to the rack. 

Steps to Remove Ceyear 1466 Signal Generator From the Rack 

1.  Loosen the screws on the rack bracket. 

Ceyear 1466 signal generator can be heavy if fully equipped. Lift the lifting equipment 

to shelf height. 

 

2. Remove the Ceyear 1466 signal generator from the rack. 

Danger !
      

Danger !
      

Notice 
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3. To place the Ceyear 1466 signal generator on the bench again, you must 

remove the adapter kit from the Ceyear 1466 signal generator. Follow the instructions 

accompanied with the adapter kit. 

Preparation for Test 

Cable selection and electromagnetic interference (EMI) 

EMI can affect the measurement result. 

To suppress electromagnetic radiation during operation: 

• Use high-quality shielded cables, especially for the following types of connectors: 

– BNC 

Double-shielded BNC cable. 

– USB 

Double-shielded USB cable. 

– LAN 

At least CAT6 straight-through processing cable. 

• Ensure that connected external devices comply with EMC regulations. 

• Connect the cable of the same type and length to I/Q and I/Q panel interfaces of 

the instrument. 

• Connect a cable to the high-speed optical interface of the instrument. 

Signal input and output level 

Information about signal levels is provided in the data sheet. Keep the signal level 

within the specified range to avoid damage to the Ceyear 1466 signal generator and 

connected equipment. 

Prevent electrostatic discharge 

Electrostatic discharge is most likely to occur when you connect or disconnect the DUT. 
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Electric static  

Risk of discharge. Electrostatic discharge can damage electronic components and 

DUT of Ceyear 1466 signal generator. 

Ground to prevent electrostatic discharge as follows: 

Ground yourself using wrist straps and ropes. 

Use anti-static floor mat together with the anti-static heel strap. 

Connect to the power supply 

1. Insert the AC power cord into the AC power connector on the back panel of the 

instrument. Use only the AC power cord that came with the Ceyear 1466 signal generator. 

2. Insert the AC power cord into a grounded power socket. 

The desired rated values are listed next to the AC power connector and in the data 

sheet. 

The internal power supply module of the Ceyear 1466 series signal generator is 

equipped with 110V/220V adaptive AC power supply module, which can be powered with 

110V AC or 220V AC power, when the internal AC power supply module adopts the 

adaptive working mode to automatically switch the working state according to the voltage 

of the external AC power supply. Therefore, please carefully check the power supply 

requirements of on the rear panel of the instrument before using the signal generator. The 

table below lists the requirements for external power supply when for normal working of 

the signal generator. 

 

Power supply 

parameter 

Applications 

Voltage, frequency 220V±10%, 50 ~ 60Hz 110V±10%, 50 ~ 60Hz 

Rated output current >3A >6A 

Power consumption 

(startup) 

Basic 

configurations 

All 

configurations 

Basic 

configurations 

All 

configurations 

＜400W ＜700W ＜400W ＜700W 

Power consumption 

(standby) 

＜20W ＜20W 

Notice 
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Ceyear 1466 series signal generators adopt three-core power cord interfaces, which 

conform to national safety standards. Before turning on the power of the signal generator, 

it is necessary to confirm reliable grounding of the ground wire of the signal generator, 

Either floating ground or poor grounding may cause damage to the instrument and even 

cause injury to operators. Using a power cord without protective grounding is strictly 

prohibited. When the instrument is connected to a suitable power outlet, the power cord 

connects the housing of the instrument to the ground. The rated voltage value of the 

power cord should be greater than or equal to 250V, and the rated current should be 

greater than or equal to 6A. 

When connecting the instrument to the power supply: 

Step 1. Confirm that the working power cord is not damaged; 

Step 2. Connect the power plug of the rear panel of the instrument to a well-grounded 

three-core power socket with the power cord. 

 

Prevent mutual interference of power supplies 

To prevent mutual interference among multiple devices through power supplies, 

especially spike interference caused by high-power devices which may cause damage to 

instrument hardware, it is recommended to use a 220 V or 110 V AC stabilized power 

supply to supply power to the signal generator. 

 

Grounding 

Poor or wrong grounding may cause damage of the instrument or personal injury. 

Before turning on the power of the signal generator, make sure that the ground wire is in 

good contact with the ground wire of the power supply. 

Please use a power outlet with grounding protection. Do not use external cables, 

power lines and auto-transformers without grounding protection as institutes of the 

grounding protection wires. If an auto-transformer is necessary, it is required to connect 

the common terminal to the protective grounding of the power connector. 

 

 

 

Tips 

Warning !
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Proper Operation of Connectors 

Connectors are often used in various tests of signal generators. Although the 

connectors of calibration pieces, test cables and analyzer measuring ports are designed 

and manufactured according to the standards, the service life of all these connectors is 

still limited. Due to the inevitable wear and tear during normal use, the performance 

specifications of the connectors will decrease or even be unable to meet the 

measurement requirements. Therefore, correct maintenance and measurement 

connection of the connectors can not only ensure accurate and repeatable measurement 

results, but also prolong the service life of the connectors and reduce the measurement 

costs. In actual use, the following aspects should be paid attention to: 

Connector check 

When conducting connector inspection, anti-static wrist band should be worn. It is 

recommended to use a magnifier to check the following items: 

1) Whether the electroplated surface is worn or not and whether there are deep 

scratches; 

2) Whether the thread is deformed; 

3) Whether there are metal particles on the threads and the joint plane of the 

connector; 

4) Whether the inner conductor is bent or broken; 

5) Whether the screw sleeve of the connector rotates improperly. 

Check the connector to prevent damaging ports of the instrument 

Any damaged connector may damage the good connector connected to it even when 

measuring the connection for the first time. In order to protect each interface of the signal 

generator itself, the connector must be checked before connector operation. 

Connection method 

Before the connection, the connectors should be inspected and cleaned to ensure 

cleanness and intactness. Anti-static wrist straps should be worn before connection. The 

correct connection method and steps are as follows: 

Step 1. Align the axes of the two interconnecting devices to ensure that the pin of the 

male connector slides concentrically into the socket of the female connector. 

Caution !
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 Axes of interconnected devices in a straight line 

Step 2. Move the two connectors leveled together so that they can be smoothly 

engaged. Rotate the screw sleeve of the connector (note, not the rotating connector itself) 

until it is tightened, and there can be no relative rotational movement between the 

connectors during the connection.  

Connection method 

Step 3. Tighten the connectors with a torque wrench to complete the connection. Pay 

attention that the torque wrench should not exceed the initial folding point. Use an 

auxiliary wrench to prevent the connector from rotating. 

 

 

Finish the connection with a torque wrench 

Disconnection 

Keep it 
unmoved  

Rotate the 
screw 

Keep it 
unmoved  
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Step 1. Support the connectors to prevent any connector from being twisted, shaken 

or bent; 

Step 2. An open-ended wrench can be used to prevent the connector body from 

rotating; 

Step 3. Loosen the screw sleeve of the connector with another wrench; 

Step 4. Rotate the screw sleeve of the connector by hand to complete the 

disconnection; 

Step 5. Pull the two connectors levelly apart. 

Usage of a torque wrench 

The use of a torque wrench is shown in the figure. The following points should be 

paid attention to when using it: 

 Confirm that the torque of the torque wrench is correct set before use; 

 Ensure that the angle between the torque wrench and another wrench (used to 

support a connector or a cable) is within 90
o
 before applying force; 

 Grasp the end of the torque wrench handle gently, and apply force in the 

direction perpendicular to the handle until reaching the folding point of the wrench. 

 

 

Use and storage of connectors 

1) The connectors should be covered by protective sheath when not in use. 

2) Do not mix various connectors, air lines and standard calibration pieces in a box 

because this is one of the most common causes of connector damage. 

3) Keep the connectors and the analyzer at the same temperature. Holding a 

connector by hand or cleaning a connector with compressed air will significantly change 

its temperature. The connectors should be calibrated after its temperature is stable. 

4) Do not touch the joint plane of the connectors because the grease and dust 

particles on the skin are difficult to be removed from the joint plane; 

5) Do not put the contact surface of a connector downward on a hard table surface. 

Direction of moment 

Stop applying force 

when the handle is bent 



Start 

Get Prepared 

25 
 

Contact with any hard surface may damage the electroplated layer and the joint surface of 

the connector. 

6) Always wear anti-static wrist straps and work on a grounded conductive workbench 

pad, which can protect the analyzer and the connectors from electrostatic discharge. 

Connector cleaning 

When cleaning the connectors, always wear antistatic wrist straps and observe the 

following steps: 

1) Remove loose particles on the thread and joint plane of the connectors with clean 

low-pressure air, and thoroughly inspect the connectors. If further cleaning treatment is 

required, proceed as follows: 

2) Soak (but not thoroughly soak) a lint-free cotton swab with isopropyl alcohol; 

3) Remove the dirt and debris from the joint plane and threads of the connectors with 

cotton swabs. When cleaning the inner surface of a connector, be careful not to apply 

external force to the central inner conductor and not to leave the fibers of cotton swabs on 

the central conductor of the connector. 

4) Let the alcohol volatilize, then blow the surface clean with compressed air; 

5) Check the connector to make sure that it is free of particles and residues. 

If any defects of the connector is still obvious after cleaning, it indicates that the 

connector may have been damaged and should not be used again. Make clear the cause 

of the connector damage before connection. 

Use of adapters 

When the output port of signal generator and the connector type used are different, 

adapters must be used for the connection before measurement. In addition, even if the 

output port of signal generator and the connector type of the DUT port are the same, it is 

also advisable to use adapters. Both cases can protect the measurement port, prolong its 

service life and reduce the maintenance cost. Before connecting an adapter to the 

measurement port of an analyzer, it is required to carefully check and clean the adapter. 

And a high-quality adapter should be used to reduce the influence of mismatching on 

measurement accuracy. 

Joint plane of connectors 

An important concept in microwave measurement is reference plane. And an 

analyzer, it is the benchmark reference plane for all measurements. During the calibration, 

the reference plane is defined as the plane where the measurement port and the 

calibration standard are engaged. Good connection and calibration depend on thorough 
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and level contact between the connectors on the joint plane.  

Connect LAN 

Ceyear 1466 series instrument allows users to remotely control or operate via LAN. In 

the following, we will describe how to connect the instrument to LAN. 

The connector is located on the back panel. 

 Connect the instrument to LAN via a LAN connector located on the back panel of the 

instrument. 

Click "System" menu in the lower left corner of the main interface, select "LAN 

Interface" menu item, and open the LAN configuration window where you can view the 

current network settings and network connection status. The DHCP switch is OFF by 

default, and the instrument is set using a static IP address. For more information, please 

refer to "Network Operation and Remote Control”. 

 

Connect USB Device 

The USB connector is located on the front and rear panels. You can disconnect all 

USB devices from the Ceyear 1466 signal generator during operation.  

Steps To Connect USB Storage Device 

USB storage devices such as memory sticks allow easy data transmission from/to Ceyear 

1466 signal generator. You can also use them for firmware updates or plug-in updates. 

Steps To Connect USB Device Using External Power Supply 

Notifications! A connecting device with an external power supply can feed current back 

into the 5V power supply of the USB interface, damaging the Ceyear 1466 signal generator. 
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Ensure that there is no connection between the positive terminal of the power supply 

and the +5 V supply pin of the USB interface (VBUS). 

Connect the USB storage device to any USB connector. 

Steps To Connect Keyboard 

 Connect the keyboard to any USB connector. 

Once connected, the Ceyear 1466 signal generator will automatically detect the keyboard. 

Connect the mouse 

 Connect the mouse to any USB connector. 

Once connected, the Ceyear 1466 signal generator will automatically detect the mouse. 

Connecting Power Meter 

You can connect the power meter of the Ceyear series signal generator to any USB 

connector of the Ceyear 1466 signal generator. The Ceyear 1466 signal generator 

supports real-time display, zeroing, and input frequency coupling settings for power 

meters. 

Connect RF Output A/RF Output B 

The connector is located on the front panel. 

If the instrument is equipped with a back panel connector option (Ceyear 1466 H92 

option), the RF output connector will be located on the rear panel. 

Preparation for Connecting "RF Output A/RF Output B" 

1. If the Ceyear 1466 signal generator is turned on, please deactivate the RF output 

before connecting the RF cable to the RF output A/RF output B connector. 

On the instrument screen, switch among channel A, channel B, and front panel, and 

click the "RF" switch button. 

2. Use a high-quality RF cable that matches the RF connector type. 

3. Two types of connectors can be connected: 

• "Connect to a non-screwable connector (BNC)" 

• "Connect to a screwable connector PC 1.0/1.85/2.92/3.5 mm)" 

1. Use a high-quality cable that matches the connector type. 
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Risk of instrument damage and connector damage. Over-tightening can damage 

cables and connectors. However, if the connector is not tightened enough, the 

measurement results may be inaccurate. 

 

To connect the cable to the connector, please perform the following operations: 

a. Carefully align the cable connectors and connectors along the common axis. 

b. Connect the connector along the common axis until the male pin of the internal 

connector engages with the female receptacle of the external connector. 

c. Turn the nut of the external connector until the connector is firmly coupled. 

d. Use a calibrated torque wrench to tighten the nut to the specified torque limit. 

Secure the opposite connector part with a wrench. 

Connector type and torque limit 

Type Torque limit Nut opening 

 Inch*lb. N*m Inch mm 

N 13.3 1.5 3/4 20 

SMA 5 0.56 5/16 8 

3.5 mm 8 0.9 5/16 8 

2.92 mm 8 0.9 5/16 8 

2.4 mm 8 0.9 5/16 8 

1.85 mm 8 0.9 5/16 8 

1.0 mm 3 0.34 0.236 6 

Prevent reverse power 

 

 

  If the set output level is too high, the reverse power may exceed a limit, resulting in 

damage to Ceyear 1466 signal generator. 

Set an RF output level not higher than the maximum allowable RF power given in the data 

manual. 

 

Notice 

Notice 
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Connecting LO Input/Output (RF Coherent Input/Output) 

The LO input/output (RF coherent input/output) connector is an SMA connector. 

The connector is located on the back panel. It is mainly used for 4- -20GHz common 

LO connection when creating multichannel coherence among multiple 1466-V signal 

generators. When connecting the LO output interface of one Ceyear 1466-V signal 

generator to the LO input interface of another signal generator, the two instruments will 

respectively set the host and slave in the phase coherent setting interface. When setting 

the coherent mode ON, the two instruments will share a LO, to achieve frequency 

common LO and signal phase coherence. 

Connect to reference input/output 

The connector is located on the back panel. 

Connect "10MHz Reference Output"/"1~100MHz Reference Input" 

In terms of connection, the Ceyear 1466 signal generator offers BNC connectors. 

Connect “100MHz/1GHz reference output” 

In terms of connection, the Ceyear1466 signal generator offers SMA connectors. 

Connect High-speed Optical Port 

The high-speed optical port includes 12-way parallel connectors and sockets. For 

each way of connectors, the maximum rate is 10.3125Gbps, the operating temperature 

range is -40°C~+85°C, the storage temperature range is -55°C~+100°C, and the relative 

operating humidity RHO range is 5%~95%. 

 

 

1. The maximum rate of each way of the 12-way parallel connectors is 10.3125Gbps; 
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2. Receptacle; 

The connectors are located on the back panel. 

Turn on/off 

The table below summarizes the power supply state, LEDs, and power switch 

locations. 

Overview of Power State 

Status Light emitting diode Power switch position 

Off Grey [0] 

Standby Orange [1] 

Preparation White [1] 

1. Set the switch on the power supply to position [I]. 

 The [PWR On/SBY] key indicator is orange. 

2. Wait until the instrument oscillator (OCXO) warms up. For warm-up time, please 

refer to the data sheet. 

3. Press the [PWR On/SBY] key. 

The keys and LEDs are located on the front panel. 

The indicator turns white. 

On first start, Ceyear 1466 starts with default settings. When restarting the instrument, 

the settings depend on the configuration of the instrument reset state before shutdown. 

When the instrument is turned on, it will automatically monitor major errors and 

warnings. You can query the list of errors. 

Turn off Ceyear 1466 

Ceyear 1466 is in Ready state. 

 Press the PWR On/SBY key. 

Operating system is turned off. The indicator turns yellow. 

In Standby state, the power switch circuit and OCXO are active. To deactivate them, 

disconnect the instrument from the power supply. 

Cut off the power 

Ceyear 1466 is in Standby state. 
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Risk of data loss. If the power supply is disconnected while the Ceyear 1466 is in 

Ready state, the settings and data may be lost. Turn it off first. 

 

1. Set the toggle switch on the power supply to position [0]. 

The indicator of the [PWR On/SBY] key is off. 

2. Disconnect Ceyear 1466 from the power supply. 

Operating system configuration 

Instrument system description 

The host software of Ceyear 1466 series signal generator runs on the custom 

Ubuntu20.04 LTS 64 bit system, which has been installed and configured according to the 

characteristic requirements of the signal generator. The host software of the Ceyear 1466 

series signal generator is based on Ubuntu operating system, which has been installed 

before shipment of the instrument. 

System usage 

The default account name of the instrument is Ceyear. Has the administrator right. 

 

Third party software affects instrument performance 

The Ceyear 1466 series signal generator adopts an open Ubuntu environment. 

Installing third-party software may affect the performance of the signal generator. Only 

software tested by the manufacturer and compatible with the host software can be run. 

 

System configuration 

Before shipment of the Ceyear 1466 series signal generator, its operating system has 

been configured to the normal state, including drive installation and remote service. Any 

change in the operating system settings may cause the performance of the instrument to 

decline. Normally, no changes are required to the settings of the operating system. 

Tips 

Notice 
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Altering system configuration may cause problems 

Once there is a problem with the use of the instrument or a system crash due to any 

change of the system configuration, the operating system and application software can be 

recovered by using the system recovery tool of the instrument, or you may contact our 

service consultation center with the service hotline provided in the foreword of this manual, 

and we will help you resolve it as soon as possible. 

 

BIOS settings cannot be modified 

The signal generator has been specifically set in BIOS. Users should not modify the 

settings in BIOS, otherwise it will cause abnormal startup and operation of the instrument. 

 

System Restore 

1. Select the boot menu. If the instrument operating system fails and the instrument 

cannot be started, you can try to restore the system. 

After booting, select "System restore" in the GRUB menu as shown in the figure 

below to enter the System Restore system. 

2. Confirm the restore operation 

Enter 123 in the password field. 

After the system restores and the software starts, an interface will appear as shown 

below. To confirm system restore operations, click "OK" button in the interface, otherwise 

select "Cancel" to exit the restore software. During the system restore process, only the 

system partition will be restored, and the user data partition will not be affected. 

 

When the restore operation starts, be sure not to operate any key until the 

restore operation is successful or failed, so as to prevent data loss caused by 

interruption in the operation. 

 

3. After the restore is completed, click "Exit" button to enter the command line state, 

and directly press the power button to shut down. 

Notice 

Warning !
      

Warning !
      



Start 

Guide to Panel 

33 
 

 

 

Guide to Panel 

This section illustrates the control panels and connectors of the Ceyear 1466 signal 

generator using the front and rear views. For interface specifications, refer to the data 

sheet. 

Content 

• Guide to Front Panel 

• Guide to Back Panel

Guide to Front Panel 

This section summarizes the control panels and connectors on the front panel of the 

Ceyear 1466 signal generator. 

 

1

2

3
4

5

6

7

8

10

9

11 12 13 14

View of front panel 

1. Display area 2. Power switch 3 Key area 

4. Knob 5 Direction keyt 6 Monitor output A t 

7. Monitor output B 8. Synchronous output 

A/low-frequency output 1 

9 Synchronous output 

B/low-frequency output 2 

10. USB interface 11. External input 1 12 RF output A 

13 V External input 2 14 RF output B  
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No. Name Description 

1 Display zone The LED display is used to display all operating menus, signal 

status and setting information. 

2 Power switch When the instrument is in "Standby" state, the middle indicator 

on the power switch is orange; Press the power switch once 

and the indicator turns white, indicating that the instrument is in 

"Working" state. 

3 Key area It is composed of functional hardkeys on the front panel. The 

keys can be selected to perform operations on the instrument 

including frequency, power, RF ON/OFF, modulation ON/OFF, 

calling up the signal flow diagram, storage and call, 

system/local, reset, and the arrow keys, knobs, ←/– 

(backspace key/negative sign), number keys, etc., can be used 

to perform input operations. 

4 Knob Control selection or data increment/decrement input 

5 Direction keys Control Guidance and Manipulation 

6 Monitor output 

A 

The BNC female connector outputs the pulse signal compatible 

with TTL level of channel A, which outputs the pulse signal 

consistent with the modulation envelope at all pulse modes, 

with rated source impedance of 50Ω. If S12 or S13 is not 

selected, then this connector has no relevant functions. 

7 Monitor output 

B 

The BNC female connector outputs the pulse signal compatible 

with TTL level of channel B, which outputs the pulse signal 

consistent with the modulation envelope at all pulse modes, 

with rated source impedance of 50Ω. If S12 or S13 is not 

selected, then this connector has no relevant functions. 

8 Synchronous 

output 

A/low-frequency 

output 1 

If the BNC female is set to synchronous output, a synchronous, 

TTL-compatible pulse signal from A channel with a pulse width 

<30ns in the internal and trigger pulse modulation process and 

a rated source impedance of 50Ω will be output, and this 

function is available if S12 or S13 is not selected; If set to 

low-frequency output 1, a low-frequency signal with a 

frequency of 0.01Hz~10MHz, an amplitude of 2mVp~5Vp, and 

an output impedance of 50Ω can be output, and there is no 

low-frequency signal output if S14 option is not selected. 

9 Synchronous 

output 

B/low-frequency 

If the BNC female is set to synchronous output, a synchronous, 

TTL-compatible pulse signal from B channel with a pulse width 

<30ns in the internal and trigger pulse modulation process and 
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output 2 a rated source impedance of 50Ω will be output, and this 

function is available if S12 or S13 is not selected; If set to 

low-frequency output 2, a low-frequency signal with a 

frequency of 0.01Hz~10MHz, an amplitude of 2mVp~5Vp, and 

an output impedance of 50Ω can be output, and there is no 

low-frequency signal output if S14 option is not selected. 

10 USB interface To be used for connection with mouses and keyboards, system 

software upgrading and data backup. 

11 External input 1 External input path 1, which can realize external frequency 

modulation/phase modulation/amplitude modulation/pulse 

modulation by setting the input signal in software. If option 

S11/12/13 is not available, the function of this connector cannot 

be used. 

12 RF output A RF output A 

13 External input 2 External input path 2, which can realize external frequency 

modulation/phase modulation/amplitude modulation/pulse 

modulation by setting the input signal in software. If option 

S11/12/13 is not available, the function of this connector cannot 

be used. 

14 RF output B RF output B Optional H01-B. 

 

Content 

• Touch screen 

• Keys 

• Connector 

Touch screen 

The front panel screen displays important parameter setting area, signal flow diagram 

and status information display area, and users can directly click the screen to set 

parameters or open the configuration window. 
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3
 

Screen content: 

1 = Important parameter setting area (frequency, power, RF ON/OFF, and modulation 

ON/OFF) 

2 = Signal flow diagram 

3=state bar 

Clicking on the touch screen is equivalent to mouse click, and the interface elements 

that support the click will respond to the click. Users can directly click the signal 

parameters (input frequency, power, switch RF ON/OFF, etc.) to modify them, or click the 

flow diagram to open the configuration window (frequency configuration window, power 

configuration window, sweep configuration window, etc.), or click the interface element 

pop-up menu (e.g., system menu) on the status bar to perform further operations. 

The function keys on the front panel can be used to set or access the functions of the 

most common instrument. 

Keys 

 

 ON/OFF key 

After the instrument is powered on, the power ON/OFF key will light up in "orange", 

and at this time if the power ON/OFF key is clicked, the instrument will be started and the 

ON/OFF key will turn to "white". When the ON/OFF key is clicked during normal use of the 

instrument, the system will pop up the "shutdown selection" dialog box, indicating the user 

to complete relevant operations according to the instructions. 
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 Function key 

Function keys provide quick access to frequently used functions 

Function key Description 

[Frep] Input frequency. 

[Power] Input power. 

[Signal Flow 

Diagram] 

Minimize all windows and return to the main interface. 

[RF ON/OFF] Switch the RF output to ON or OFF. 

[Modulation 

ON/OFF] 

Switch the modulation to ON or OFF. 

[Storage/Call] Open the Storage/Call configuration window. 

[System/Local] After opening the system menu, if the instrument is under control, 

the system will return to local control. 

[Reset] Reset the instrument settings to the specified state. 

 Digital key 

The numeric key is used to enter parameters 

Digital key Description 

Alphanumeric key Enter numbers and letters in the input boxes. 

Decimal point Insert the decimal point "." at the marker position. 

+/- Change the symbol of a numeric parameter. If it is a string 

parameter, insert "-" at the marker position. 

Unit key (G/n dBm, M/μ 

dBμV, k/m nV and Hz/s 

x1) 

The unit key is used to add the selected unit to the numeric 

value entered and completes the entry. 

When inputting power parameters (e.g., with unit dBm) or 

dimensionless values, all units take the value of "1" as a 

multiplication factor. In this case, their function is the same as 

the [OK] key. 

[CL] key When you are inputting the parameter, you can cancel the 

input, or close the current active window. 

[Backspace] key Remove the character before the marker position. 

[OK] key Confirm the input. 
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 Navigation control 

Navigation controls include knobs and navigation keys. 

 Knob 

The knob has several functions including: 

• Increment (clockwise) or decrement (counterclockwise) by bit when inputting 

characters. 

• Moving the focus, for example: moving the focus of a functional block diagram in 

a flow diagram. 

• Switching parameter input status when clicked. 

 Direction keys 

The navigation key can be used interchangeably with knobs. In addition to increment 

or decrement, it can also be used to move the marker left and right. 

Direction keys 

Key type Description 

[Up and down ] key The [Up] and [Down] keys have the following functions: 

• Increment or decrement by bit when inputting characters. 

• Moving the selection bar up or down in the table. 

[Left/Right] key The [Left] and [Right] keys have the following functions: 

• Moving the marker left and right when inputting characters. 

• Moving the selection bar horizontally in the table. 

Connector 

RF and monitoring outputs and various other interface connectors are located on the 

front panel. 

USB 

Monitor output 

Synchronous output/low-frequency output 

RF A/RF B 
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 USB 

There are three Type-A female USB (universal serial bus) connectors (host USB) on 

the front panel. For example, you can connect a keyboard, mouse, or USB disk. 

On the back panel, there are also three Type-A connectors (host USB) and one 

Type-B USB connector (USB device). 

 Monitor output 

The BNC connector and output are compatible with pulse signal of TTL level, which 

outputs the pulse signal consistent with the modulation envelope at all pulse modes, with 

rated source impedance of 50Ω. 

 Synchronous output/low-frequency output 

Multifunctional output interface. At the pulse mode, the BNC female connector 

outputs sync pulse signal with rated width of 20ns and compatible with the TTL level 

internally, with rated source impedance of 50Ω. 

When the LF output is ON, settings can be done to output the LF signal with 

frequency of 0.01Hz～10MHz, amplitude of 40mVp～4Vp and output impedance of 50Ω. 

 RF A/RF B 

RF signal outputs for path A and path B. 

The connector type depends on the frequency options installed. 

Overview of RF Connector Types By Frequency Range 

Option Connector type 

RF A: Ceyear 1466C/D（-V） 

RF B: Ceyear 1466H11B(V)13/B20 

Test port adapter, PC 3.5 mm male 

Test port adapter, PC 3.5 mm male 

RF A: Ceyear 1466E/G（-V） 

RF B: Ceyear 1466H11 B(V)13/B20 

Test port adapter, PC 2.4 mm male 

Test port adapter, PC 3.5 mm male 

RF A: Ceyear 1466H/L（-V） Test port adapter, PC 1.85 mm male 

RF A: Ceyear 1466N/P Test port adapter, PC 1 mm male 

Guide to Back Panel 
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This section summarizes the connectors on the back panel of the instrument. 

1

8 11 12

13 20

47

49 50 52

2

3 4 5 6 7 9 10

14 15 16 17 18 19 21 22 23 24 25 26

31 42

48 51 53

54 55

56

57

27 302928 32 33 34 35 36 37 38 39 40 41 43 44 45 46

 

View of Ceyear 1466-V Series Back Panel 

1. Power switch 2 Power supply input 3 LO output 

4. LO input 5 RF coherent output 6 RF coherent input 

7.100MHz/1GHz reference 

output 

8.100MHz/1GHz reference 

output 

9 5GHz clock output 

10. 10 MHz reference output 11. 1 ～ 100MHz reference 

input 

12 External detection 

input A/B 

13 V/GHz output A 14 Z-axis blanking/frequency 

A 

15 Stop sweeping 

input/output A 

16 Trigger input A 17 Trigger output A 18 Sweep output A 

19 Flyback output A 20 Sweep output B 21 Trigger output B 

22 Flyback output B 23 Stop sweeping input/output 

B 

24 Z-axis 

blanking/frequency B 

25 Trigger input B 26 V/GHz output B 27 I output A 

28 I output A 29 Q output A 30 Q output A 

31 Optical fiber interface A 32 Marker 1/trigger A 33 Marker 2 

34 5GHz clock output 35 5GHz clock input 36 I input A 

37 Q input A 38 Q input B 39 I input B 

40 Marker 3/trigger B 41 Marker 4 42 Optical fiber 

interface B 

43 I output B 44 I output A 45 Q output B 

46 Q output B 47 Electronic hard disk 48 Network interface 

49 Display interface 50 USB Type-B 51 USB Type-A 
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52 GPIB 53 10G network 54 Synchronous clock+ 

55 Synchronous clock- 56 RF output A 57 RF output B 

 

No. Name Description 

1 Power switch Power switch of mains supply of the instrument. 

2 Power input Instrument power plug, parameter requirements: 220 V 

(±10%), 50 Hz (±5%), 200W. 

3 LO output 4GHz~20GHz coherent signal output. Optional H36. 

4 LO input 4GHz~20GHz coherent signal input. Optional H36. 

5 RF phase 

parameter output 

4GHz~20GHz coherent signal output. Optional H36. 

6 RF phase 

parameter input 

4GHz~20GHz coherent signal input. Optional H36. 

7 100MHz/1GHz 

reference output 

Output 100MHz or 1GHz reference signal with a 

power >-3dBm and impedance of 50Ω. If H07 option is not 

selected, then this connector has no relevant functions. 

8 100MHz/1GHz 

reference output 

Receive external 100MHz or 1GHz reference signal at 

-3dBm~+5dBm and input impedance of 50Ω. If H07 option is 

not selected, then this connector has no relevant functions. 

9 5GHz clock output Provide a clock for the baseband board. For internal use. 

10 10 MHz reference 

output 

BNC female, signal level >+4dBm, typical output impedance 

50Ω. 

11 1 ～ 100MHz 

reference input 

BNC female, receiving frequency reference signals with 

1~100MHz, stepping of 1Hz and -5～+10dBm from external 

time base. 

12 External detection 

input A/B 

Channel A/B external detection signal input to achieve stable 

amplitude of power. 

13 V/GHz output A In channel A analog sweep mode, output 0~10V voltage at 

equal intervals from start frequency to stop frequency. 

14 Z-axis 

blanking/frequency 

A 

BNC female, RF output flyback in channel A analog 

frequency sweep mode or output positive pulse (about +5V 

at 2kΩ load) at band switching; When the RF output 

frequency is the active maker frequency, output a negative 

pulse (-5V). Optional S15. 

15 Stop sweeping BNC female, output TTL high level when sweeping in 
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input/output A channel A analog sweep mode, or output TTL low level when 

sweep stops, external ground can force the instrument to 

stop sweeping. Optional S15. 

16 Trigger input A BNC female, TTL rising edge valid, used for frequency 

hopping in channel A external trigger step and list sweep 

mode. Optional S15. 

17 Trigger output A At the analog frequency sweep mode of channel A, the BNC 

female connector corresponds to each frequency conversion 

and outputs 1 μs wide TTL low pulse. Optional S15. 

18 Sweep output A At the analog frequency sweep mode of channel A, the BNC 

female connector outputs a voltage in direct proportion to the 

sweep frequency: 0V corresponds to the start frequency of 

sweep, 10V corresponds to the stop frequency  of sweep. 

Optional S15. 

19 Flyback output A Output TTL high level when start sweeping in channel A 

analog sweep mode, or output TTL low level at the end of 

the sweep. Optional S15. 

20 Sweep output B At the analog frequency sweep mode of channel B, the BNC 

female connector outputs a voltage in direct proportion to the 

sweep frequency: 0V corresponds to the start frequency of 

sweep, 10V corresponds to the stop frequencyof sweep. 

Optional S15. 

21 Trigger output B At the analog frequency sweep mode of channel B, the BNC 

female connector corresponds to each frequency conversion 

and outputs 1 μs wide TTL low pulse. Optional S15. 

22 Flyback output B Output TTL high level when start sweeping in channel B 

analog sweep mode, or output TTL low level at the end of 

the sweep. Optional S15. 

23 Stop sweeping 

input/output B 

BNC female, output TTL high level when sweeping in 

channel B analog sweep mode, or output TTL low level when 

sweep stops, external ground can force the instrument to 

stop sweeping. Optional S15. 

24 Z-axis 

blanking/frequency 

B 

BNC female, RF output flyback in channel B analog 

frequency sweep mode or output positive pulse (about +5V 

at 2kΩ load) at band switching; When the RF output 

frequency is the active maker frequency, output a negative 

pulse (-5V). Optional S15. 

25 Trigger input B BNC female connector, TTL rising edge valid, used for 

frequency hopping in B external trigger step and list sweep 
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mode. Optional S15. 

26 V/GHz output B In channel B analog sweep mode, output 0~10V voltage at 

equal intervals from start frequency to stop frequency. 

27 I output A BNC female connector, path I output of channel A internal 

baseband signal generator. 

28 I output A BNC female connector, path I output of channel A internal 

baseband signal generator. 

29 Q output A BNC female connector, path Q output of channel A internal 

baseband signal generator. 

30 Q output A BNC female connector, path Q output of channel A internal 

baseband signal generator. 

31 Optical fiber 

interface A 

Optical input interface for external digital baseband signal 

input. Optional H35A. 

32 Marker 1/trigger A SMA female, marker 1 output multiplexed with channel A 

trigger input. Marker 1: Marker 1 in digital modulation, 

arbitrary wave, communication protocol mode; Trigger A: 

Inputting external trigger signal in channel A digital 

modulation, arbitrary wave, communication protocol mode, 

level compatible with 3.3V-LVTTL. 

33 Marker 2 SMA female, during arbitrary wave modulation, outputting 

marker 2 set by arbitrary wave. 

34 5GHz clock output Output baseband 5GHz clock. 

35 5GHz clock input Baseband board 5GHz clock input. For internal use. 

36 I input A Channel A receives the “I” input of I/Q modulation, with input 

impedance of 50Ω. 

37 Q input A Channel A receives the “Q input of I/Q modulation, with input 

impedance of 50Ω. 

38 Q input B Channel B receives the “Q input of I/Q modulation, with input 

impedance of 50Ω. 

39 I input B Channel B receives the “I” input of I/Q modulation, with input 

impedance of 50Ω. 

40 Marker 3/trigger B SMA female, marker 3 output multiplexed with channel B 

trigger input. Marker 3: Marker 3 in digital modulation, 

arbitrary wave, communication protocol mode; Trigger B: 

Inputting external trigger signal in channel B digital 

modulation, arbitrary wave, communication protocol mode, 
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level compatible with 3.3V-LVTTL. 

41 Marker 4 SMA female, during arbitrary wave modulation, outputting 

marker 4 set by arbitrary wave. 

42 Optical fiber 

interface B 

Optical input interface for external digital baseband signal 

input. Optional H35B. 

43 I output B BNC female connector, path I output of internal baseband 

signal generator, used for channel B. 

44 I output B BNC female connector, path I output of internal baseband 

signal generator, used for channel B. 

45 Q output B BNC female connector, path Q output of internal baseband 

signal generator, used for channel B. 

46 Q output B BNC female connector, path Q output of internal baseband 

signal generator, used for channel B. 

47 Electronic hard 

disk 

The storage location of the electronic hard disk of the 

instrument. 

48 Network interface RJ45, used for software upgrading and control 

49 Display interface DP interface, can be connected to an external display 

50 USB Type-B For USB interface programmed control. 

51 USB Type-A To be used for connection with mouses and keyboards, 

system software upgrading and data backup; 

52 GPIB Standard IEEE488 interface, supporting SCPI language. 

53 10G network 10G network interface. (Reserve inerface) 

54 Synchronous 

clock+ 

Cascade signal source synchronous clock+.(Reserve 

inerface) 

55 Synchronous 

clock- 

Cascade signal source synchronization clock-.(Reserve 

inerface) 

56 RF output A RF output A of Back Panel.(Reserve inerface) 

57 RF output B RF output B of Back Panel. (Reserve inerface) 

 

LAN 

The signal generator can be controlled remotely by computers in LAN 10Base-T or T

和 100Base-T. Various instruments are combined into a system in LAN and controlled 

uniformly by computers in it. In order to realize remote control in LAN, the signal generator 

should be equipped with port connector, network card and relevant network protocol in 



Start 

Guide to Panel 

45 
 

advance, and provided with relevant network services. The three working modes of the 

network card are: 

 10Mbit/s Ethernet IEEE802.3; 

 100Mbit/s Ethernet IEEE802.3u; 

 1Gbit/s Ethernet IEEE802.3ab. 

The master computer and the signal generator should be connected to the common 

TCP/IP protocol network through the network port. The cable between the computer and 

the signal generator is a commercial RJ45 cable (Category 5 cable with or without 

shielding). During data transmission, the transmission speed of LAN is faster when data 

packet transmission is applied. Generally, the length of the cable between the computer 

and the signal generator should not exceed 100m (100Base-T and T 和 10Base-T). 

 

GPIB interface 

As an instrument remote control interface widely used at present, GPIB interface is 

connected to different types of instruments through GPIB cable, so as to build a test 

system with the host computer. In order to realize remote control, the host computer 

should be equipped with GPIB bus card, driver and VISA library in advance. During 

communication, the host computer first addresses the controlled instrument through the 

GPIB bus address. The user may set the GPIB address and ID query string, and the GPIB 

communication language may be in the form of SCPI by default. 

GPIB and its associated interface operations are defined and described in detail in 

ANSI/IEEE Standard 488.1-1987 and ANSI/IEEE Standard IEEE Standard 488.2-1992. 

For details of the standards, please refer to the IEEE website: http://www.ieee.org. 

GPIB processes information in bytes at the data transmission speed of up to 8MBps, 

which is fast. Since the data transmission rate is limited by the distance between the 

device/system and the computer, the following points should be noted when connecting 

GPIB: 

 Up to 15 instruments may be built through GPIB interface. 

 The total length of the transmission cable should not be more than 15 m or twice 

the number of instruments in the system. In general, the maximum length of the 

transmission cable between the devices shall not exceed 2 m; 

 If multiple instruments are connected in parallel, a "live" cable is required. 

 The end of the IEC bus cable shall be connected to the instrument or master 

computer. 

 

USB interface 
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USB Type-B interface, which can realize USB programmed control mode of the signal 

generator. When the computer is connected with a signal generator through USB Type-B 

port and VISA library is pre-installed in the computer, VISA will automatically detect and 

configure the instrument to establish USB connection without entering an instrument 

address string or installing a separate driver. 

USB address: 

Addressing string format: USB::<vendor ID>::<product ID>::<serial number>[::RAW] 

Where: 

<vendor ID> Manufacturer code; This code is fixed at 0x3399 (Ceyear Technologies 

Co., Ltd.) 

. 

<product ID> represents the instrument code; 0x2800 for 1466 series signal 

generators 

<serial number>  represents the serial number of the network analyzer; 

This interface can also be connected to a separate frequency multiplier source 

module for extending the frequency range of the signal generator. 

 

Understanding and Preliminary Use of Instrument 

This chapter introduces the principal functions and settings of the Ceyear 1466 series 

signal generator. A full description of the functions and their usage is given below. The 

basic operation of instrument is described in "Operate a Signal Generator". 

Prerequisite 

• The instrument has been set, connected to a power supply, and started as 

described in "Get Prepared". 

• Throughout the description, the instrument is equipped with Ceyear 1466-H31, 

Ceyear 1466-S13, and Ceyear 1466-S34 options. 

 

The screenshots in this description show a fully equipped instrument. With this in 

mind, the block diagram shown on a particular instrument may differ from the one used in 

the example. 

 

Tips 
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The instrument is manually operated via a touch screen. Operate as follows: 

Content 

• Unmodulated Carrier 

• Pulse modulation signal 

• Digital modulation signal

• Use External Signal to Trigger the Instrument 

• Verify the Generated Signal 

• Save and Call Settings 

• Generate 5G NR Signal 

Unmodulated Carrier 

At first, generate a simple unmodulated signal. This is also the basic function of the 

standard configuration of the Ceyear 1466 series signal generator. 

1. On the Ceyear 1466 front panel, press the [Reset] button to reset the instrument to 

a predefined state. 

2. Set frequency: 

a. On the "Status" Bar, click the "Frequency" field. 

b. Use the on-screen keyboard to enter 5.99 and press the "GHz" key. 

 

3. The on-screen keyboard turns off and displays the frequency value. 

4. On the "Status Bar", click on the "Power" field and enter the level in the same way. 
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5. In the "Title" bar, click "RF" to turn on the output of the RF signal. 

 

Alternative ways to access instrument function. To accomplish the same task, you 

can click the [RF ON/OFF] button on the front panel of the instrument. 

 

 

In case of the Ceyear 1466 H11 B(V)13/20/33/45 option (dual-channel model), the 

[RF ON/OFF] button on the front panel is valid for the currently selected channel. If you 

want the [RF ON/OFF] button to work on the two channels, you can set "RF ON/OFF 

Synchronization of Channel A and Channel B " through [System] > [Basic Settings] > 

[Synchronization ON/OFF]. 

 

Connect the RF A of the Ceyear 1466 to a signal analyzer (such as Ceyear 4082) to 

display the generated signal 

Tips 

Tips 
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Pulse modulation signal 

The pulse modulation of Ceyear 1465 series signal generators have the functions of 

stagger, stagger and sliding, and can generate complicated pulse modulated signals. 

1. In the main interface block diagram, click "Pulse Modulation" to open the pulse 

modulation configuration window. 

2. Select the pulse source in the pulse modulation configuration window, and a 

drop-down menu will pop up where you can select “Sliding”. 

 

3. Configure the width, period, sliding step, sliding points and sliding mode of the 

pulse signal. 

4. Enable pulse modulation 
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5. The instrument automatically turns on the modulation, and sets the pulse 

modulation to sliding, so as to generate a sliding pulse modulation signal. 

 

Digital modulation signal 

This example shows you how to generate a simple QPSK digital modulation signal 

through the Digital Modulation function. This is also the basic function of the standard 

configuration of the Ceyear 1466-V series signal generator. 

1. In the main interface block diagram, select "Baseband" and navigate to the 

"Digital Modulation". The Digital Modulation dialog box will open. 
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2. In "Digital Modulation" dialog box, select the “Modulation Type Selection” 

property page, click the “Modulation Type Selection” multi-column drop-down box, and 

select “π/4-QPSK”. 

 

3. Select the “Data Source Configuration” property page and click "Digital 

Modulation ON/OFF" to enable the generation of QPSK digital modulation signals. 
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4. The instrument automatically activates "I/Q Modulation", uses internal trigger and 

clock signals, and generates QPSK signals. 

 

Using External Signal to Trigger the Instrument 

In many cases, the Ceyear 1466 signal generator will not be used as a separate 

instrument. Generally, the instrument will be connected to a device under test (DUT) or 

other measuring devices. When two or more devices are required for test settings, a 

common time base reference shall be provided. For example, when testing a DUT, the 

exact start time of the signal shall be controlled, and the test can be completed through 

the triggering function of the instrument. 
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Single Play of Baseband Signal Trigger by External Signal 

1. In the main interface block diagram, select "Baseband" and navigate to "Arbitrary 

Wave". 

 

2. Open the arbitrary wave configuration window, click "Load Arbitrary Wave" option, 

and select arbitrary wave file <SINTESTWAVE.seg> in the pop-up menu. 

 

3. Click "Interface Mapping" option and set the interface type marker 1/trigger A to 

trigger A. 
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The "Marker 1/trigger A" and "Marker 3/trigger B" interfaces on back panel of Ceyear 1466 

signal generator are multipurpose bidirectional connectors. 

4. Connect the instrument to the external trigger source, and connect the external 

trigger source to the "Marker 1/trigger A" connector of the Ceyear 1466 signal generator 

using a suitable cable. The I-channel and Q-channel output of the back panel of the 

Ceyear 1466 signal generator to the oscilloscope is shown in the figure below. 

Ioutput

Qoutput

Trig

 

Tips 
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5. Click "Trigger Setting" option, select "Single" for the trigger mode, select "Ignore 

Repeated Trigger" for the single trigger type, select "External" for the trigger source, set 

the trigger slope to "Positive" and trigger delay to "OFF". 

 

6. Select "IQ Modulation" on the main interface, open the IQ modulation configuration 

window, select "I/Q Output" option, and set "IQ Output” as ON. 

 

7. In arbitrary wave configuration window, set the arbitrary wave to ON. Set an 

external trigger source to output a pulse trigger signal. 



Start 

Understanding and Preliminary Use of Instrument (All) 

 

 

8. Observe the oscilloscope measurement trace 

As shown in the figure below: signal 1: external trigger signal, signal 2: path I output, 

signal 3: path Q output. Each time an external trigger arrives, the baseband signal starts 

playing. When the second pulse arrives, it triggers a play. During the playback, when the 

next trigger arrives, the trigger is ignored. 

 

9. Change the single trigger type to "Buffer Repeated Trigger". When the first pulse 

arrives, it triggers a playback of the waveform segment. When then next pulse arrives, this 

trigger is recorded and the playback is triggered after the previous waveform segment 

playback is completed. 
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10. Change the single trigger type to "Real-time Repeat Trigger". When the first pulse 

arrives, Stop a playback of the waveform segment. When then next pulse arrives, the 

playback of the current waveform segment is terminated and the trigger is replayed. 

 

Verifying the Generated Signal 

It is convenient for you to verify the correctness of the data in time domain and 

frequency domain in the first place, with the preview function of Ceyear1466 convenient 

baseband enabled when the arbitrary wave signals are played through the arbitrary wave 

function of the instrument. 
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This example shows you how to use this graphical display to verify the generated 

signal. 

1. In the main interface block diagram, select "Baseband" and navigate to "arbitrary 

Wave". 

2. Open the arbitrary wave configuration window, click "Load Arbitrary Wave" option, 

and select arbitrary wave file 4MQPSK-16MCLK.seg in the pop-up menu. 

3. In arbitrary wave configuration window, set Arbitrary Wave to ON. At this time, the 

"Waveform Information" button becomes active, and clicking this button can open the 

waveform information display. Among them, the basic information displays the size of the 

current arbitrary waveform file, clock frequency, number of sampling points and other 

information; The graph displays the IQ data, frequency, power, and other information of 

the current waveform. 

 

Arbitrary wave IQ data display interface 
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Arbitrary wave IQ data spectrum display interface 

Saving and Calling Settings 

In order to use the same instrument settings as this measurement in subsequent 

tests, the instrument parameters can be saved as a configuration file that can be called 

when the same instrument settings are required to simplify the instrument setting process. 

Saving Instrument Settings to a File 

1. Press the [Save/Call] button on the front panel. 

2. In the "Storage Settings" property page, click File "Name", and use the on-screen 

keyboard to enter MyTestConfig. 

3. Click the "Store" button. The file MyTestSignal.zjstate is saved in the folder with a 

default directory /home/ceyear/SgData/user/State/, or you can save the configuration file 

to a folder that you select. 
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Calling Saved Instrument Settings 

1. Press [Reset] button to restore the default instrument settings so that you can 

check if the saved user settings are restored later. 

2. Press the [Save/Call] button on the front panel. 

3. In "Call Setting" property page, select the setting file that you want to call. 

4. By taking the MyTestConfig file as an example, if you click "Call" button, the 

MyTestConfit.zjstate configuration file under the default directory 

/home/ceyear/SgData/user/State/ will be called. You can also select the configuration file 

under other folders. 
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Generating 5G NR Signal 

The Ceyear 1466 series signal generator is mainly applied to generate digital signals 

based on various telecommunication and wireless standards, such as 5G NR, LTE/LTE-A 

or WLAN. In this example, the digital standard 5G NR is used. A 5G NR signal that meets 

the requirements of the protocol can be generated quickly following actions given below. 

In this example, the additional option Ceyear 1466-S34 is required. 

Generating 5G NR TestModel Test Signal 

The following examples are intended to help you become familiar with the settings 

and configuration principles common to 5G NR digital standards. 

By taking the generation of the standard TestModel signal specified by the 5G NR 

protocol as an example, the configuration process is as follows: 

1. On the front panel of the Ceyear1466 signal generator, press [Reset] button to 

define the start of instrument configuration. 

2. In the main interface block diagram, select "Baseband" and navigate to "5G NR". 

The 5G NR configuration dialog box will be displayed, and you can set Link Direction 

to Downstream; Click the "Test Model" button to pop up the test model selection dialog 

box. 

 

Note: The 5G NR signal simulation function is integrated into the instrument in a 

manner of plug-in. It incorporates a unique tree directory in the software, which displays 

the main setting functions of the software in layers, making the function selection and 

jump more flexible and convenient. The tree directory has 4 layers at most, clearly dividing 
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the functional levels and retaining sufficient software parameter settings and operation 

interface range, to avoid excessive congestion of the operation interface. 

3. In "Test Model" dialog box, you can quickly select the test model you need 

according to the filter criteria. For example, when the frequency range is FR1, the test 

model is TM1.1, the duplex mode is FDD, and the channel bandwidth is 10MHz, the 

sub-carrier spacing is 30kHz, the settings are as follows:

 

By clicking "Load" button, the configuration parameters specified by the selected Test 

Model can be loaded into the user interface, making subsequent waveform generation 

and testing easier and faster. 

4. On the title bar of the main interface, click "Frequency" and "Power" fields, enter 

values, and select "RF ON". 

5. In "Common Configuration" property page, set the 5G NR to ON.
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The instrument will generate a 5G NR Test Model test signal at the set frequency and 

level. 

 For a comprehensive description of all functions, refer to "Operate the Signal 

Generator". 

New Functions and Features of Instrument 

The Ceyear 1466 signal generator combines up to two independent signal generators 

in one instrument and offers unmatched RF and baseband characteristics. Because of its 

modular design, the instrument can optimally conform to the requirements of different 

applications. Both can be equipped with one of the available frequency options with 

different frequency limits. The baseband portion of Ceyear 1466 signal generator is fully 

digital. It contains hardware for generating and processing I/Q signals in real time or using 

an arbitrary waveform generator.  

Content 

• List of Signal Flow 

• Excellent spectral purity, making cutting-edge testing easier 

• Power output with large dynamic range and high accuracy 

• 2GHz RF modulation bandwidth, making bandwidth test challenges easier 

• Excellent vector modulation accuracy, making it competent for communication 

equipment calibration and testing 

• Cascade of multiple instruments to achieve multi-source coherent excitation 

• Complete analog modulation 

• Multi-mode sweep functions 

• Comprehensive standard digital modulation modes 

• Arbitrary wave playback 

• Multi-carrier 

• Multiple types of noise addition 

• Intrapulse modulation 

• Real-time fading simulation 

• Multi-scenario signal simulation 

• Newly-upgraded human-computer interaction 



Start 

Instrument Control (All) 

 

List of Signal Flow 

The Ceyear 1466 signal generator is equipped with a large touch screen that displays 

a block diagram. The block diagram indicates the general stages that signal flow and 

signal generation go through. Depending on the options that Ceyear 1466 signal 

generator is equipped with, the appearance of the block diagram will change. 

The following examples are not exhaustive, but are intended to illustrate how block 

diagrams describe installed options.  

• Example of complete dual-channel device (with baseband) instrument 

 

• Example of single-channel instrument. 
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Excellent spectral purity, making cutting-edge testing easier 

Ceyear 1466-V series signal generator supports high-purity spectrum signal output, 

1GHz carrier single sideband (SSB) phase noise typical value -145dBc/Hz@10kHz 

frequency bias, 10GHz carrier typical value -132dBc/Hz@10kHz frequency bias; 20GHz 

bandwidth bottom noise typical value - 161dBc/Hz@30MHz frequency offset; 10GHz 

carrier spurious <-80dBc, harmonic <-55dBc. Purer signals allow you to test microwave 

and millimeter-wave components, systems, and OTAs without being affected by 

interference signals. 

 

Single sideband phase noise measurement of option H04-2 

 

1466D measured harmonic value 
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1466G measured harmonic value 

Power output with large dynamic range and high accuracy 

Typical maximum output power of Ceyear 1466-V series signal generator: +27dBm at 

5GHz, +24dBm at 20GHz, +25dBm at 30GHz, and +22dBm at 60GHz. Minimum output 

power: - 150dBm (settable), dynamic range: >170dB. It has excellent power accuracy 

indicators with typical value <0.5dB (below 20GHz). 

 

Max. output power measurement of 1466D (high-power option H05-20) 
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Max. output power measurement of 1466G (high-power option H05-45.) 

 

Max. output power measurement of 1466L (high-power option H05-67.) 

2GHz RF modulation bandwidth, making bandwidth test 

challenges easier 

The Ceyear 1466-V series signal generator can provide a maximum RF modulation 

bandwidth of 2GHz. Depending on the application scenario, it supports 500MHz, 1GHz, 

and 2GHz bandwidth, and the RF modulation bandwidth can be up to 5GHz when using 

external broadband baseband signal input. Its superior modulation bandwidth 

performance makes it easily cope with test challenges whether using current 5G 

communications or future 6G communications. 
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30GHz carrier, 2GHz modulation bandwidth, multi-tone signal spectrum 

 

Excellent vector modulation accuracy, making it competent for 

communication equipment calibration and testing 

The Ceyear 1466-V series signal generator has excellent vector modulation accuracy, 

and the QPSK modulation EVM measurement value can reach 0.4% (2GHz carrier). It has 

excellent ACPR, 5GNR ACPR<-55dBc@2GHz carrier (typical value) and 

<-45dBc@42.5GHz carrier (typical value). It can be subject to performance evaluation in 

communication equipment research and development and performance testing of 

communication equipment on production lines. 

Cascade of multiple instruments to achieve multi-source 

coherent excitation 

It supports cascade of multiple instruments, and can provide solutions for MIMO, 

beamforming, and signal diversity testing. 
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Channel 1

Channel 2

Channel 3

Channel 4

Channel N

Channel 
N+1

…
…

 

Multiple 1466-V series signal generators are cascaded 

Complete analog modulation 

It supports AM, FM, phase modulation, and pulse modulation. It has complex pulse 

modulation functions such as double pulse, pulse train, stagger, jitter, and sliding. 

 

Analog modulation configuration interface 
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Comprehensive standard digital modulation modes 

It generates up to 33 digital standard modulation signals (PSK, FSK, QAM, APSK), 

covering all important frequency bands and modulation modes of digital communications. 

 

4096QAM modulation configuration interface 

 

16APSK modulation configuration interface 

Arbitrary wave playback 

It supports playback of user-defined arbitrary wave data variable sampling rate. You 
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can use the waveform conversion tool software provided by Ceyear to 

convert .mat/.csv/.txt/.dat/.bin files into arbitrary wave file that can be played by Ceyear 

1466 signal generator. 

Multi-carrier 

It supports continuous wave multi-tone and complex multi-carrier modulations, 

making it easy to create complex signal scenarios. 

 

Multi-tone modulation configuration interface 
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Complex multi-carrier modulation configuration interface 

 

 

Multi-carrier measurement map of different modulation types (QPSK, 5G NR, single 

tone, WIFI6) 

Multiple types of noise addition 

It supports Pure Noise, additive Gaussian noise, CW Interferer and other noise 

functions. 

 

Additive white Gaussian noise configuration interface 

Intrapulse modulation 

It supports many types of intrapulse modulations including LFM, barker codes, and 
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phase modulation codes. 

 

Intrapulse modulation configuration interface 

Real-time fading simulation 

There are 20 maximum fading paths, supporting pure Doppler, Rayleigh, Rice, 

Rayleigh + lognormal and other fading types, preset fading scenario modes. And it can 

simulate the fading channel model defined by 3GPP. 

 

Real-time fading simulation configuration interface 
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Real-time fading multi-path 

Multi-scenario signal simulation 

The Ceyear 1466-V series signal generator integrates with analog software to 

support multiple types of signal simulation and RF output such as communications, radar, 

and electronic warfare. 

The Ceyear 1466-V series signal generator contains 5G NR, LTE and other standard 

protocol signals by embedding, for the purpose of development and production of mobile 

communication base stations or terminals, as well as necessary RF compliance tests in 

the verification and approval of mobile communication equipment networking. 

 

5G NR downlink scheduling settings 
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For the purpose of the development and production of wireless communication 

terminals, it is cable to simulate 802.11a/b/g/n/ac/ax wireless connection PPDU, MPDU, 

A-MPDU and other signals, and supports the simulation of physical frame block signals 

composed of multiple PPDUs with different modulation and coding methods. 

 

WLAN physical frame block configuration interface 

Combined with the radar signal simulation option 1466-S50, a variety of radar signals 

can be simulated, pulse train radar signal with intrapulse modulation can be generated, 

pulse repetition frequency radar signal can be simulated, and envelope shape of the pulse 

can be set. Intrapulse modulation methods include LFM, non-LFM, triangular FM, BPSK, 

QPSK, Barker codes, etc. The type of repetition frequency includes stagger, jitter, sliding, 

and jump. The pulse envelope mainly includes rectangular, trapezoidal, raised cosine, 

raised root cosine, index, etc. 

Combined with the radar scenario simulation software option S55-01/02/03, the 

standard instrument can be turned into a flexible, complex electromagnetic environment 

signal simulator that realizes electromagnetic environment test in the laboratory rather 

than in the outfield. 

The radar scenario simulation software option S55-01/02/03 can simulate and 

generate dynamic electromagnetic environment signal characteristic parameters, and 

drive single/multiple signal generators through the network interface to generate dynamic 

multi-source coherent radar signals for desktop semi-physical simulation testing using 

time difference/phase difference positioning equipment. 

The radar scenario simulation software can construct dynamic application scenarios, 

calculate the actual electromagnetic environment signals that air/ground equipment may 

face, and apply radio wave propagation algorithms to calculate characteristics of various 

signals including signal carrier frequency, pulse arrival time, pulse width, pulse amplitude, 

and Doppler frequency offset transmitted from the antenna of the radiation source to each 

receiving antenna port surface of the receiving end. 
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Newly-upgraded human-computer interaction 

Flexible editing on user control interface 

It supports user-defined menus, customizes personalized user control interface 

according to testing habits, realize multi-functional operations in one window, and avoid 

the too deep menus and repeated searches. 

 

User-defined menu 

 

It supports cross-platform client control 

Cross-platform client and browser access control. It supports simultaneous 

connection of multiple clients and synchronous refreshing of instrument working state. It 

supports web browser access control on mobile devices. 

 

Synchronous recording of SCPI commands, and one-click-script 

Not only can the recorded SCPI commands be exported with one click, but also VS 

(C++, C#), Qt, Matlab, LabView programmed control example projects can be 

automatically generated, making programmed control simpler. 
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SCPI command recording 

Instrument control 

This chapter summarizes the use of Ceyear 1466 signal generator. 

Its contents include: 

Content

• Possible Ways to Operate the Instrument 

• Manual Interaction Mode 
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• Learn About Display Information 

• Input data 

• Programmed Control 

• Remote Operation via Web Browser 

Possible Ways to Operate the Instrument 

There are three ways to operate Ceyear 1466 signal generator: 

Three operation methods of Ceyear 1466 series signal generator: 

• Local operation:  

Operate the instrument locally using the touch screen, buttons and knobs on front panel, 

and optional mouse/keyboard. For details, refer to "Interaction Mode". 

• Remote control:  

Create applications using the remote control commands or APIs provided by the 

instrument to complete the test and measurement of the instrument. For details, refer to 

"Network and Remote Control Operations". 

• Web remote operation:  

On the remote computer, use a major web browser for remote operation. For details, refer 

to "Remote Operation Via Web Browser". 

Manual Interaction Mode 

• Touch screen:  

Touch operation is the most direct way to interact, which can ensure all settings of the 

instrument only through touch. You can touch on the main interface or configuration 

window like using a mouse to complete a series of operations such as setting parameters, 

entering data, and scrolling through. 

Touch operations are similar to mouse actions, including: 

– Quick touch = click: Select a parameter or perform an action. 

– Touch and hold = right-click: Open a context-sensitive menu. 

– Touch and drag = drag and drop: Move the window, browse the window contents. 

• Buttons and knobs:  

The instrument can be operated in traditional ways using buttons and knobs on the front 

panel, such as turning on/off RF, or entering frequency, power, and other parameters. 
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• Mouse/keyboard:  

The optional mouse/keyboard can be used instead of the above touch and button 

operations to complete all settings of the instrument. 

Learn About Display Information 

The block diagram of Ceyear 1466 (-V) shows all the main settings and generator 

status, and it is divided into three main operating areas. 

 

Block diagram 

1=state bar 

2 = Block diagram 

3 = Taskbar 

4=toolbar 

Content 

• Status bar 

• Block diagram 

• Taskbar 

• Tool bar 

• Other Display Characteristics 

Status bar 

1 
1 

1 

1 

2 

3 

1 
4 
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The status bar at the top of the screen indicates the RF and the level of output signal 

supplied to DUT. You can set the two parameters directly here. 

 

1 = Frequency display and editing 

2 = State ON/OFF 

3 = Power display and editing 

4=state indication 

The state indicates key parameters set for the output signal, the state ON/OFF can 

switch instrument state directly, and the power and frequency can be edited directly. 

Block diagram 

The block diagram shows the current configuration and signal flow in a generator 

using the function blocks connected via signal lines. 

The following figure shows almost all the elements that can appear in a block diagram. 

However, it does not necessarily represent an available configuration. 

 

1=function block 

2=signal line 

3 = Connector icon (RF) 

4=channel switch ON/OFF 

When observing from the left to "I/Q Flow Mapper", you can find the function blocks 

provided in the baseband domain, from which the generated digital signal is modulated by 

1 
1 1 1 1 

3 4 4 

1 

1 
2 

1 

1 
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the IQ modulator, then sent to the carrier, and output through the RF interface. In addition, 

the baseband signal can also be superimposed with partial analog modulation. 

 

No. Item Description 

1 Function 
block 

It represents the basic tasks during signal generation. 

It is possible to access relevant setting windows through buttons to 
complete the task. 

The ON/OFF (checkbox) and block label can be used to quickly 
activate basic tasks. 

When the function block is working, the checkbox is turned on, the 
icon on the function block will be played like animation and the 
background color of the function block is illuminated. 

If dual-channel option is available, marks "A" and "B" will appear in 
the lower left corner of the function block, indicating the access to 
setting window of channels A and B, respectively. 

2 Signal line Indicate the direction of signal flow 

3 Connector 
icon 

Indicate interface of RF signal output 

4 Channel 
switch 
ON/OFF 

A switch to switch between channels A and B 

Taskbar 

The "Taskbar" is mainly used to indicate the current working state of the instrument. 

The contents are shown in the following figure: 

1 2 3 4 5 6

 

1=System menu 

2=Working mode 

3 = Programmed control state 

4=Current prompt information 

5=Error message 

6=System time 

 

No. Item Description 

1 System menu Provide access to system settings, port settings, self-test, 

instrument information, and help. 

2 Operation Display the operating mode of the current instrument, including: 
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mode continuous wave and sweep, where the sweep is divided into 

steep sweep, list sweep, and ramp sweep. 

3 Programmed 

control state 

Display whether the current instrument is in controlled state; It is 

Null by default. 

4 Current 

prompt 

information 

Display prompt information; The information only appears for 

about 3S, and if you want to view the historical information, 

please check the "Machine Error". 

5 Error 

message 

Scroll to display the errors generated during the operation of the 

machine. For more details, please refer to "Machine Error". 

6 System time Display the current time of system. 

 

Tool bar 

The "Toolbar" provides convenient functions including returning to home page or 

desktop, switching windows, multi-task, recording SCPI, displaying SCPI recording, Redo, 

Undo, user menu, and help. 

1

2

3

4

5

6

7

8

9

10

 

1=Back to homepage or desktop 

2 = Switch window 
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3 = Multi-task 

4 = Record SCPI 

5 = Display SCPI record 

6 = Take a screenshot 

7 = Redo 

8  Undo 

9 = User menu 

10=Help 

 

No. Item Description 

1 Back to homepage 

or desktop 

Click to return to home page and double-click to return 

to the desktop. 

2 Switch window Switch between recently opened windows in turns. 

3 Multi task Display all recently opened windows in a manner of 

thumbnail to make it easier for users to quickly open 

specified windows. 

4 Record SCPI Turn on the record switch to record the SCPI commands 

received by the instrument. 

5 Display SCPI 

record 

Open "SCPI Record Management Window" to display 

the recorded SCPI commands. 

6 Screenshot After taking a screenshot, the screenshot management 

window will pop up. 

7 Redo Redo the parameter settings you just undo. 

8 Undo Undo the parameter settings you just performed. 

9 User menu Open "User Menu Window" to display user-defined 

menus. 

10 Help Open the helper to display the help document. 

Other display characteristics 

• Control Appearance 

– The focused control is highlighted with an orange outline border. 

– Disabled control is grayed out. 
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• Virtual Keyboard 

When the input is activated, the system will automatically display a virtual keyboard that 

matches the input scenario. (Please refer to "Input Data"). 

• Important Information Displayed in Property Page Tab 

The configuration window generally contains multiple property pages. In addition to 

parameter classification, the property page tab also indicates the state or displays the 

current value of important parameters. 

 

 

1=Status indicator 

2=Important parameter value 

• Scroll Bar Handrail 

When you touch the scroll bar, a handrail with an arrow will appear, and you can drag it to 

scroll through the list. 

• Context-sensitive Menu 

Press and hold or right-click on the active control to access the context-sensitive menu. 

1 

1 

1 

2 
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• Multi-task Display 

With the window opened, you can quickly switch the configuration window through 

multi-task display. 

 

Input data 

In terms of data input in the dialog box, the on-screen keyboard on the instrument can 

be used for entering numeric and alphanumeric values. Therefore, you can always set the 

parameters via the touch screen, the front panel or an external keyboard. 
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The data input box has two states: Selected                                           

and Edition . When the data input box is in Selected 

state, the user cannot enter data. When the data input box is in Edition state, the marker 

appears and the user can edit the data. The left and right arrow keys (←, →) are used to 

move the marker, and the up and down arrow keys (↑, ↓) are used to increase or decrease 

the data value indicated by the marker. Rotating the RPG can also increase (clockwise) or 

decrease (counterclockwise) the data value indicated by the marker. This will be 

described with "continuous wave" as an example: 

Method 1: Tap the “Frequency" data input box on the touch screen, then the 

frequency is in the "Edition Status". When you can input data for edition. 

Method 2: When the "Frequency" data input box is in the selected state, press the 

knob to set the data input box to the edition status, input data and edit it. After edition, 

press the knob again to set the data input box to the selected state. 

Certain parameters correspond to the keys on the front panel, such as frequency and 

power. Click the Frequency (or Power) button on the front panel to set the frequency or 

power in the status bar to Edition state, and enter the number keys and unit keys to set the 

frequency (or power). For dual-channel instrument, pressing the frequency (or power) 

button on the front panel once can set the frequency (or power) of channel A to edition 

state, and pressing the button again will set the frequency (or power) of channel B to 

edition state. 

Correct the entry 

  When the edit box changes from the selected state to the edit state, the marker 

does not flash. Click any key to clear the edit box. Input any number, and the marker will 

change to the flashing state. At this time, use the Arrow key  and the Del key  to 

delete by bit. 

  Press the Arrow key  to delete a bit to the left of the marker. 

  Press the Del key  to delete the bit selected by the marker. 

Complete the entry 

 Press the unit key to select the desired unit to finish the entry, or press the Enter key 

or knob to enter the current unit. 

Stop the entry 
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 Press the [ESC] key and the dialog will close without changing the settings. 

Content 

•  Input numeric parameters 

•  Input alphanumeric parameters 

•  Undo and Redo operations 

Input numerical value parameters 

  Use the on-screen keyboard to enter values 

For numeric settings, the instrument displays the numeric keypad. The units specified 

correspond to the units of the parameter. 

Enter the value and click the unit key to complete the entry. The unit will be added to 

the entry. If the parameter does not require units, press "Enter" to confirm the value 

entered. The data in the edit box will automatically switch the most appropriate unit for the 

current value (the valid digits of the integer part will not exceed 3 digits, but if the unit has 

been switched to the maximum unit, the valid digits of the integer part will be greater than 

3 digits). 

 Use the front panel control to enter values 

Use the knob or the [Up/Down] key or numeric keys to change the value of the 

parameter that is currently in use. If the parameter does not require units, press the [Enter] 

key or knob to confirm the entered value. 

The instrument highlights the edit line to confirm the input. To edit data, the input field 

must be in edit mode: when the field to be edited is selected, press [Enter] or the knob to 

activate the edit mode. 

Input alphanumeric parameters 

If the field requires alphanumeric input, you can use the on-screen keyboard to enter 

letters and (special) characters. 

Undo and Redo operations 

"Undo" allows you to restore one or more actions on the equipment by pressing and 

holding the edit box control to pop up the menubar. Depending on the available memory, 

the "Undo” steps can restore all operations. 
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"Redo" can restore the previously undone actions. 

Programmed control 

In addition to directly operating the instrument locally, it is also possible to control the 

instrument via a remote PC. 

The instrument supports several remote control methods: 

• The instrument is controlled via the LAN (Local Area Network) interface. 

• The instrument is controlled via the GPIB interface. 

• The instrument is controlled via the USB interface. 

• Please refer to "Network and Remote Control Operation" for details. 

Remote operation via Web browser 

The Ceyear 1466 series signal generators provide a more convenient way to operate 

remotely. You can use the mainstream Web browser on any device in the LAN to operate 

the instrument remotely, just make sure that they are in the same network segment. The 

specific operating are as follows: 

• Connect the instrument to the LAN by referring to " Connection to LAN ". 

• Click the "System" menu in the lower left corner of the main interface, select the 

"Basic Settings" menu, open the system configuration window, select the "Web Service" 

property page, follow the instructions in the Figure, use the browser of PC or mobile 

device, and enter the IP address of the instrument in its address bar to remotely operate 

the instrument. Please refer to  "Network and Remote Control Operation " for more 

detailed instructions. 
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Operation Signal Generator 

Content 

•  Definitions and basic terms 

•  System configuration 

•  Internal baseband source configuration 

•  Attenuation and noise addition 

•  I/Q vector modulation 

•  RF signal configuration 

•  Document and data management 

•  General instrument functions 

•  Network operation and remote control 

Definitions and basic terms 

This section introduces signal generation definitions and explains the basic terms 

used in this document. 

Signal flow 

The Ceyear 1466 is equipped with a large touch screen that displays block diagrams, 

indicates the current status of function modules, and allows you to monitor and modify 

signal flow. The signal is processed from left to right in a logical direction, in which the 

active function modules affect the generated signals. 

Signal path 

In the default instrument state (dual channel), the fully equipped block diagram shows 

two signal paths, namely, channel A and channel B. Taking channel A as an example, the 

output of carrier data stream and baseband data stream after IQ modulation and power 

control is described. The low frequency signal is directly output through the function 

generator and the low frequency output interface. 
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carrier data stream + 

baseband data stream

low frequency signal 

 

System Configuration 

The "System Configuration" dialog box displays the configuration and system 

information related to the instrument. The settings provided can help you complete 

configuration tasks. 

Base Config 

Content 

• Reference setting 

• Reset state 

• Language/LANG 

•  Remote control compatibility 

•  Synchro switch 

•  Web service 

•  Baseband mode 

•  Phase coherence 

Reference 

Access: 
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 Select “System” > “Basic Settings” > “Reference Settings”. 

 

Setting: 

└Reference selection 

└Reference manual settings 

└External reference frequency 

└Internal reference accuracy adjustment 

└Reset of factory default values 

└Frequency selection of reference input and output 

└Reference input/output selection 

└Configuration application 

 Reference selection 

Set the reference selection mode: manual and automatic. In the automatic mode, the 

internal and external references are automatically selected by the instrument. Specifically, 

if there is no external reference input, the instrument will automatically select the internal 

reference. If there is an external reference input, the instrument will automatically select 

the external reference. In the manual mode, you need to manually set the reference input. 

If it is set as an external reference, you also need to set the external reference frequency. 

Remote command: 

[:SOURce]:ROSCillator:SOURce:AUTO 

 Reference manual settings 
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If the above “Reference Selection” is set to “Manual Mode”, you need to set the 

reference input manually. If it is set to external reference, you also need to set the external 

reference frequency. 

Remote command: 

[:SOURce]:ROSCillator:SOURce 

 

 External reference frequency 

Set the external reference frequency. The external reference frequency can be set 

only when the reference input is manually set to the external reference. 

Remote command: 

[:SOURce]:ROSCillator:FREQuency:EXTernal 

 

 Internal reference accuracy adjustment 

You can adjust the accuracy of the internal reference output frequency through the 

internal reference accuracy adjustment. 

Remote command: 

[:SOURce]:ROSCillator:REFerence 

 Reset of factory default value 

Restore the internal reference accuracy adjustment to the factory default value, which 

will override your previous settings. 

Remote command: 

[:SOURce]:ROSCillator:DEFaults 

 

 Reference input and output frequency selection 

The instrument supports 100MHz and 1GHz external reference signal input/output 

(Ceyear 1466 H07), which is valid when the parameter input/output is selected to be 

external. The external reference input/output frequency is set as 100MHz or 1GHz. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:FREQuency 
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 Reference input/output selection 

The instrument supports 100MHz and 1GHz external reference signal input and 

output (Ceyear 1466 H07), and 100MHz/1GHz reference input and output is set as 

internal or external. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:SOURce 

 

 Configuration application 

Click to validate the parameter input and output settings. By default, the change of 

reference I/O will automatically take effect on the instrument. This key resolves losing lock 

of accidental reference loop due to improper operation timing of the modified settings and 

rear-panel reference signal input. 

Notice: When configuring the external reference input, if manual mode is selected, 

connect the external reference signal to the input first, and then configure the reference 

frequency. If the timing sequence is not correct, losing lock of reference loop may occur. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:APPLy 

 

Reset 

Access: 

 Select “System” > “Basic Settings” > “Reset State”. 

 

Setting: 
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└Reset type selection 

└Save user state 

└Reset 

 Resetting type selection 

Set the reset type, including manufacturer, user, and last state. When the 

manufacturer's representative performs the reset function, the instrument will be set to the 

factory state; when the user's representative performs the reset function, the instrument 

will be set to the state saved by the user; when the last state representative performs the 

reset function, the instrument will be set to the last state automatically saved before 

shutdown. The reset type selection is stored separately from the instrument state, so the 

reset function does not affect the settings of this parameter. 

Remote command: 

:SYSTem:PRESet:TYPE 

 

 Save user status 

When User is selected as the reset type, you can save the current working state of 

the instrument as the user state, so that the next time the reset function is performed, the 

instrument will be set to the state you just saved. 

Remote command: 

:SYSTem:PRESet[:USER]:SAVE 

 

 Reset 

Performing resetting function. The function is the same as that of the "Reset" key on 

the front panel. 

Remote command: 

*RST 

 

Language/LANG 

Access: 

 Select “System” —> “Basic Setting”—> “Language/LANG”. 
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 On the Language/LANG property page, you can configure: 

•  Language/LANG, including Chinese and English. 

Setting: 

└Language/LANG 

 Language/LANG 

Set the language of the software interface, including Chinese and English. This 

settings take effect only after the instrument is restarted. It is stored separately from the 

instrument state, so the reset function does not affect the settings of this parameter. 

Remote command: 

:SYSTem:DEVice:LANGuage 

 

Remote control compatibility 

Access: 

 Select “System” > “Basic Settings” > “Remote Control Compatibility”. 
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 In the “Remote Control Compatibility” property page, you can configure: 

•  Remote control compatible command sets, including SCPI and SMW. 

•  Remote control command recording switch. 

Setting: 

└Remote control compatible command sets 

└Remote control command record 

 Remote control compatible command sets 

Set the programmed control compatible command sets, including SCPI and SMW. 

 Programmed control commands record 

If the programmed control command recording switch is turned on, the instrument will 

save all received commands to the specified directory. 

Synchro switch 

Access: 

 Select “System” > “Basic Settings” > “Synchro Switch”. 
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 In the “Synchro Switch” property page, you can configure: 

• RF switch and modulation switch synchronization of two channels  for dual 

channel model. This synchronization is only valid for the physical keys of "RF switch" and 

"modulation switch" on the front panel. 

Setting: 

└Channel A and channel B RF switch synchronization 

└Channel A and channel B modulation switch synchronization 

 Channel A and channel B RF switch synchronization 

Set the RF switch synchronization of channel A and channel B. 

Remote command: 

:OUTPut:ALL[:STATe]  

 

 Channel A and channel B modulation switch synchronization 

Set the modulation switch synchronization of channel A and channel B. 

Remote command: 

:OUTPut:MODulation:ALL[:STATe]  

 

Web service 

Access: 
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 Select “System” > “Basic Settings” > “Web Service”. 

 

In the “Web Service” properties page, you can use a Web browser to remotely 

operate the instrument according to the instructions in the Figure. 

Baseband mode 

Access: 

 Select “System” > “Basic Settings” > “Baseband Mode”. 

 

 In the “Baseband Mode” property page, you can configure: 

•  Baseband modes, including standard, advanced, and real-time multicarrier. 

•  Application of baseband settings 

Setting: 

└Baseband mode 

└Application 
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 Baseband mode 

Set the baseband mode and configure for different functions or options. It includes 

standard, advanced, and real-time multicarrier. Standard mode is the default mode. The 

advanced mode is mainly for the attenuation (Ceyear 1466 S05) function. 

Remote command: 

:SYSTem:BASebandLMODE 

 

 Application 

Application of baseband settings After selecting the baseband mode, click "Apply" to  

take effect in the instrument. 

 

 Switching baseband mode causes the instrument to reset and reload the baseband 

configuration file, which may take a long time.  

 

Remote command: 

:SYSTem:BASebandLMODE 

 

Multi-instrument coherence connection 

Access: 

 Select “System” > “Basic Settings” > “Phase Coherence”. 

 

Tips 
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 In the “Phase Coherence” property page, you can: 

• Set the dual channels or connect with other instruments to form a phase 

coherence system (used with Ceyear 1466 H36 options). Multiple instruments needs 

to be connected by network cable. This property page is used to set the coherence 

system configuration, including adding devices, modifying phase coherence 

calibration values, and performing phase calibration. 

Setting: 

└Phase-coherent switch 

└Phase calibration table 

└Adding device 

└Deleting device 

└Sending data to slave 

└Phase calibration 

 Phase coherence switch 

Set the phase coherence switch. If it is turned on, the instrument will be used as the 

host and automatically connect to other instruments according to the configuration to form 

a phase coherence system. 

 Phase calibration table 

The phase calibration table provides a list of devices to be correlated. You can edit 

the IP address, port number, signal power, phase offset, and RF switch of the device. 

Besides, the last column shows the current connection state of the device. 

 Adding device 

Add a device for phase coherence system. 

 Deleting device 

Delete a device for phase coherence system. 

 Sending data to slave 

Send the device information in the phase calibration table to the appropriate slave.  

 Phase calibration 
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Click to execute the phase coherence calibration function. 

Storage/Call 

Access: 

 Select “System” > “Storage/Calling”. 

 

 

 

In the “Storage Settings” property page, you can: 

•  Store the instrument predefined and custom states. 

In the “Calling Settings” property page, you can: 

Call the instrument predefined and custom states. 

This function is the same as that of "Storage/Calling” key on the panel. 

Setting: 

└Storage status 1- -4 
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└Store 

└Calling status 1- -4 

└Call 

Storage status 1- -4 

It provides a shortcut to store the instrument state. The instrument has predefined 

state 1- -4. The user can directly click to store the state without entering the file name. 

Storage 

In custom state, user needs to select the storage path of the state file and input the 

name of the state file. 

Remote command: 

*SAV 

 

Call state 1--4 

It provides a shortcut to call the instrument state. The instrument has predefined 

states 1- -4. The user can directly click to call the state without entering the file name. 

Notice: If the state 1- -4 is not stored but called directly, the instrument will be 

automatically configured to the factory default state. 

Recall 

To call the custom state of the instrument, the user needs to select the storage path of 

the state file and select the corresponding state file. 

If no file is selected, the configuration item will be invalid. 

Remote command: 

*RCL 

 

Port settings 

Content 

• GPIB interface 

• LAN Interface 
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• USBinterface 

GPIB interface 

Access: 

 Select “System” > “GPIB Interface”. 

 

 In the “GPIB Configuration Window”, you can configure: 

•  Host GPIB address and command terminator. 

Setting: 

└Host GPIB address 

└Terminator 

 Host GPIB address 

Set the host GPIB address in the range of 0--30. The default host GPIB address is 

19. 

Note: After the GPIB address configuration is completed, the instrument will 

automatically save the last configuration. 

Remote command: 

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess 

 

 Terminator 

Set the command terminator. 
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LAN interface 

Access: 

 Select “System” > “LAN Interface”. 

 

 In the “LAN Configuration Window”, you can configure: 

•  Host IP address and service port number. 

Setting: 

└Network status 

└Network restart 

└Instrument name 

└ working group name 

└DHCP 

└Host IP address 

└Subnet 

└Gateway 

└Port No. 

└MAC address 

 Network status 

Display the current network connection status of the instrument. 

 Network restart 

Reapply the network settings. 
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Remote command: 

:SYSTem:COMMunicate:LAN:RESTart 

 

 Instrument 

Set instrument name. 

Remote command: 

:SYSTem:COMMunicate:LAN:HNAMe|HOSTname 

 

 Working group name 

Set the work group name of the instrument. 

 DHCP 

Set the DHCP switch. If it is on, the IP address of the instrument is automatically 

configured by the network device, and the manual setting option is no longer provided. 

 Host IP address 

Set the host IP address. 

Remote command: 

:SYSTem:COMMunicate:LAN:ADDRess|IP  

 Subnet 

Set the subnet mask. 

Remote command: 

:SYSTem:COMMunicate:LAN:SMASk|SUBNet 

 Gateway 

Set the gateway. 

Remote command: 

:SYSTem:COMMunicate:LAN:DGATeway|GATeway 

 

 Port number 
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Set the port number for the remote service. 

Remote command: 

:SYSTem:COMMunicate:LAN:PORT 

 MAC address 

Display the MAC address of the instrument. 

Remote command: 

:SYSTem:COMMunicate:LAN:MAC? 

USB configuration 

Access: 

 Select “System” > “USB Interface” > “USB Configuration”. 

 

 In the “USB Configuration”, you can view: 

•  Host VID, PID, equipment number and equipment identification. 

Setting: 

└VID 

└PID 

└Device No. 

└Equipment mark 

 VID 

Display the host VID. 
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 PID 

Display the host PID. 

 Device No. 

Display the equipment number. 

 Equipment mark 

Display the equipment identification. 

USB power meter 

Access: 

 Select “System” > “USB Interface” > “USB Power Meter”. 

 

 In the “USB Power Meter”, you can view: 

• USB power meter currently connected to host, and set some parameters. Ceyear 

1466 supports up to 4 USB power meters simultaneously. 

Setting: 

└Power value 

└Power meter switch 

└Frequency coupling 

└Frequency 

└Power level offset switch 

└Power level offset 

└Zero 

└Serial number 

 Power 

Display the power meter measurement. 

 Power meter switch 

Set the power meter switch. If it is off, the measurement is stopped and the 

measurement result is not displayed. 
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 Frequency coupling 

Set the frequency coupling switch. If it is on, the frequency factor of the power meter 

will be set automatically and synchronously when the frequency of the instrument is set. 

 Frequency 

Manually set the power meter frequency factor. 

 Power level offset switch 

Set the power level offset switch of the power meter. 

 Power level offset 

Set the power level offset value of the power meter. 

 Zero 

Perform the power meter zeroing. 

 Serial number 

Display the power meter serial number. 

Self-test 

Content 

•  Instrument self-test  

•  Manual test 

Complete machine self test 

Access: 

 Select “System” > “Instrument Self-test”. 



Operation Signal Generator 

System Configuration (complete) 

 

 

 

 

Execute the automatic test of all test items of the instrument. Before the test, the user 

will be prompted to disconnect all external connections. After the test, the test result 

information box will pop up. For other functions, please refer to  "Manual Test" . 

Manual test 

Access: 

 Select "System” > "Manual Test". 
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 In the "Manual Test" window, you can select the test item, set the test mode, and 

execute the self-test. 

Setting: 

└Loop test 

└Times of cycle 

└Single step test 

└Single step mode 

└Start test/stop test 

└Performance 

 Cyclic test 

If the loop test switch is set to on, loop test will be executed for all selected test items 

in the test process. 

 Times of cycle 

When the test is repeated, the number of tests currently executed is displayed. 

 Single step test 

Set the step test switch. 

 

 Single step mode
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Set the single step mode, including: All and Error. "All" means to execute a test item 

once triggered; "Error" means to execute a series of test items once triggered, and will not 

stop until the test item fails to be executed. 

 Start test/Stop test 

Start or stop the test. 

 Performance 

Trigger test. 

Internal baseband source configuration 

The Ceyear 1466 (-V) series are vector signal generators with real-time internal 

digital signal generation function and an integrated arbitrary waveform generator. 

The instrument can generate a wide variety of digital modulation signals as defined in 

the corresponding specifications or as customized in real time . The instrument is provided 

with a high-speed optical port to read the waveform file from the recorder with data 

storage function or signal analysis for playback. 

Content 

•  Overview of signal generation mode 

•  Standard or wideband baseband generator 

•  Access Functions in Baseband Domain 

•  Generate Signals According to Digital Standard 

•  Common Functions and Settings in Baseband 

•  Generate Digital Modulation Signals 

•  Use Arbitrary Waveform Generator (ARB)  

•  Generate Sequence (Multi-segment Waveform) File 

•  Generate Multi-carrier Signal 

•  Generate Continuous Wave Multi-tone Signal 

•  Generate Intra-pulse Modulation Signal 

• Generate frequency hopping signal 

Overview of Signal Generation Mode 
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Ceyear 1466 can generate a signal by: 

•  "Generate Digital Modulation Signal According to Digital Standards” 

•  "Generate Real-time Digital Modulation Signal” 

•  "Play Waveform" 

Generate Digital Modulation Signal According to Digital Standards 

The Ceyear 1466 (-V) vector signal generator can be optionally equipped with the 

required digital protocol standard options, and can generate digital standard signals 

according to the corresponding protocol specifications. 

Generate Real-time Digital Modulation Signal 

•  By using an internal baseband signal generator, the Ceyear 1466 generates a 

digital modulation signal with user-defined characteristics in real time.  

•  If the required options are installed, a real-time baseband signal provided by an 

external device through an optical port can be added to the internally generated signal. 

Play Waveform 

The Ceyear 1466 is equipped with an arbitrary waveform generator (ARB) to 

generate test signals and play waveform files. A waveform file can be an arbitrary wave 

file with a specific format, which can be loaded and played by the instrument. 

•  Externally computed waveform files can be loaded into the instrument via LAN, 

USB, or GPIB interfaces. Waveforms can also be created using the Ceyear WinWavSIM 

software. Users can also program custom IQ data by using the integrated development 

tool (Matlab/Visual Studio/VSCode, etc.) and convert it into a waveform file that can be 

played by the instrument with the help of Ceyear IQFileConversionTool. 

• The instrument provides additional complex modulation waveform files with 

different functions. 

– The waveform file generated by radar signal simulation software option can be 

automatically processed and played by ARB. 

For detailed functions, please refer to Ceyear 1466-S55-01/02/03 Radar Scenario 

Signal Simulation Software 

– A multicarrier signal consisting of modulated carriers can be internally configured 

and created. Such multicarrier waveform files can be used to simulate complex 

multicarrier scenarios.  

Please refer to “Generate Multi-carrier Signal”. 

 The instrument supports fast continuous generation OF multi-tone signal. 

Please refer to “Generate Continuous Multi-tone Signal”. 
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Standard or wideband baseband generator 

The Ceyear 1466 can be equipped with a standard or wideband baseband. 

• Standard baseband  Ceyear 1466 (-V) is equipped with the baseband generator 

Ceyear 1466 H31-500.  

• Wideband baseband  Ceyear 1466 (-V) is equipped with the baseband 

generator Ceyear 1466 H31-2000.  

If fully equipped, the Ceyear 1466 with standard baseband may generate signals up 

to 500 MHz in bandwidth and modulates them at 67 GHz. 

A wideband baseband generator extends the internal RF modulation bandwidth to 2 

GHz. With this option, the Ceyear 1466 uses a single device to generate wideband 

vector-modulated signals with carrier frequencies up to 67 GHz. 

Difference between standard and wideband baseband generators 

The Ceyear 1466 can be equipped with a standard or a broadband internal baseband 

generator. Regarding RF performance, both generators have similar characteristics. 

The choice of baseband generator depends only on the application: 

• The standard baseband generator is the best choice for most scenarios such as 

communication and radar receiver testing. 

• The wideband baseband provides an internal modulation bandwidth of 2 GHz 

and is used in scenarios such as next-generation communications, aerospace, and 

wideband radar. 

Access to functions in the baseband module 
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1. In the block diagram, select the "Baseband" module and the context menu in the 

pop-up window. 

The "Baseband" module includes all functions and settings related to baseband 

signals. Functions and settings include complex modulation, radar, communications, 

digital satellite broadcasting and other related fields. 

2. By default, the baseband module is in digital modulation mode and the signal 

generation is turned off. 

To activate the baseband generator, select the "Baseband" module in the block 

diagram and set "Baseband > ON". After the activation is successful, the function module 

lights up and an animation is displayed. 

The short name indicates the currently selected digital standard or modulation type. 

             

Generate Signals According to Digital Standard 

The Ceyear 1466 can generate protocol signals according to major communication 

and wireless standards after the appropriate software option is installed. 

This section lists some of the supported standard digital signals. 

GSM/EDGE  
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This digital standard requires the Ceyear1466 S31 option. 

GSM/EDGE supports full-speed/half-speed regular, synchronous, frequency 

correction, access, and empty types at normal symbol rates, as well as various burst 

types at high symbol rates; supports MSK/FSK, AQPSK, 8PSK, 16QAM, 32QAM at 

normal symbol rates, andQPSK, 16QAM, 32QAM modulation at high symbol rate; 

supports three different types of frame structure configuration: single frame, double frame 

and no frame; supports independent power configuration of each time slot; supports 

channel coding of each time slot; supports wide pulse and narrow pulse filtering at high 

symbol rate; supports up to 64 multi-carrier configurations. 

Bluetooth® enhanced data rate/low power consumption 

This digital standard requires the Ceyear1466 S23 option. 

The Bluetooth option provides the function to generate signals according to the 

Bluetooth specification 5.0+EDR and the latest low power consumption Bluetooth 

specification. 

IEEE 802.11a/b/g/n, IEEE 802.11ac, IEEE 802.11ax 

This digital standard requires the Ceyear 1466 S21 option with IEEE 802.11a/b/g/n 

and IEEE 802.11ac 和 IEEE and IEEE 802.11ax 选项的 Ceyear items. 

802.11a/b/g/n/ac/ax (Wi-Fi1~Wi-Fi6) wireless connection PPDU, MPDU, A-MPDU 

and other signal simulation are equipped with multiple module parameter setting functions 

such as preamble, data field, MAC frame, PE, space mapping, etc. They support physical 

frame block signal simulation composed of multiple PPDUs with different modulation and 

coding methods. 

LTE/LTE-Advanced 3GPP R15 version  

This digital standard requires the Ceyear 1466 S33 option with LTE/LTE-Advanced 

item. 

Uplink: It supports FDD/TDD duplex mode, uplink channels such as PRACH, PUCCH, 

PUSCH with different bandwidths and modulation coding methods, and DMRS uplink 

signal simulation, and has 44 types of FRC signal simulation functions from A1 to A8. 

Downlink: It supports FDD/TDD duplex PBCH, PCFICH, PHICH, PDCCH, PDSCH 

and other downlink channels with different bandwidths and modulation coding methods in 

Auto DCI/Manual scheduling PDSCH mode, as well as CRS, PSS, SSS and other 

downlink signal simulation, and has the aggregation function of up to 5 carriers, 

multi-antenna setting of up to 4 antennas and 8 kinds of TestModel signal simulation 

functions from TM1~E-TM3. 

NB-Iot 

This function requires Ceyear 1466 S35 option with NB-Iot item. 
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Uplink: It supports three deployment modes: Standalone, In_band, and Guard_band, 

and has uplink channel functions such as NPUSCH and NPRACH with different 

bandwidths and modulation coding methods. NPUSCH formats include F1 and F2, and 

signal modes include Single-tone (15kHz/3.75kHz ), SC-FDMA (15kHz). 

Downlink: It supports three deployment modes: Standalone, In_band, and 

Guard_band, and has downlink channels such as NPBCH, NPDCCH, and NPDSCH with 

different bandwidths and modulation coding methods, as well as downlink signal 

simulation functions such as NPSS, NSSS, and NRS. DCI formats include N0, N1, and N2, 

and NPDCCH searching space includes three types: UE specific, type1 common, type2 

common 

eMTC 

This function requires Ceyear 1466 S36 option with eMTC item. 

It realizes the free configuration of various channels and signals of the eMTC type 

described in the 3GPP R15 protocol, supports the simulation of the signal generation 

process of the uplink/downlink and in different FDD/TDD duplex modes so as to satisfy 

the user's simulation requirements for eMTC type communication signals. 

5G NR 

This function requires the Ceyear 1466 S34 option with 5G NR item. 

This option provides the function to generate signals according to 3GPP R16 version. 

It includes a variety of bandwidth and subcarrier spacing settings; can generate more than 

600 TestModels and FRCs, and supports one-key simulation of standard protocol signals 

to quickly establish test scenarios; supports detailed resource configuration of uplink 

PUSCH, PUCCH, PRACH, and downlink PDSCH, CORESET multiple channel 

time-frequency, PDSCH/PUSCH channel coding, multi-antenna, multi-layer transmission 

simulation; supports CSI-RS, SRS, SS/PBCH, PRS, LTE-CRS and other signal 

configurations; supports multiple uplink and downlink DCI formats in CORESET, and 

automatically calling PDSCH configuration by DCI; supports carrier aggregation and 

cross-carrier scheduling; supports multiple filters and user-defined filter configurations. 

OFDM signal generation 

This function requires Ceyear 1466 S37 option with OFDM signal generation item. 

This option provides the generation of OFDM signals according to a predefined 

ODFM modulation scheme. 

DVB-H/T, DVB-S2/S2X 

This digital standard requires the Ceyear 1466 S61 option with DVB item. 

The DVB item provides the function to generate signals according to the Digital Video 

Broadcasting standards DVB-H, DVB-T, DVB-T2 and DVB-S2/S2X. 
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Common Functions and Settings in Baseband 

Signals, modulation types, markers, triggers used in baseband 

This section provides some information about function introduction and basic 

concepts. 

Content 

• Data Sources, Clock and Control Signals and Signal Sources in Baseband 

• Marker Output Signal 

• Baseband Trigger Signal 

• Supported Modulation Types 

• Supported baseband filters 

 Data sources, clocks, markers and triggers in baseband 

 

Data source 

Data sources, clocks, and trigger signals can be generated internally or provided from 

external sources. 

Content 

• Internal Modulation Data 

• Clock signal 

 Internal data source 

The Ceyear 1466 uses the following internal modulation data sources: 

• File stream 

A file stream is a binary list of custom data created externally or internally.  

The Ceyear 1466 provides standard file selection function, and the file stream is created 

in the dedicated "stream file" editor. A separate file is created for each list and stored on 

the instrument's hard disk. The file name is user-defined and the file extension is *.src. 

The maximum length of the data list is 64kbits. External files can be transferred to the 

instrument through the standard “File Management” window, folders can be renamed or 

files can be deleted. 

• Custom sequence and all 0 all 1 

Binary string of 0 ("All 0") or 1 ("All 1") with a maximum length of 64 bits. As a simple data 

pattern such as a string of variable bits, it is used as internal modulation data. 
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• PN sequence 

PRBS data. PRBS generators provide pseudo-random binary sequences of varying 

length and duration, which is called maximal-length sequences. The PRBS sequence is 

generated by means of a ring shift register whose feedback point is determined by a 

polynomial. 

The pseudo-random sequence of the PRBS generator is uniquely defined by register 

number and feedback. The PRBS specification describes how it is generated. According 

to 

 

PRBS description 

PRBS generator Length (bits) Feedback to Interface selection 

Bit 9 2
9
 -1 = 511 Register 4, 0 PN9 

Bit 11 2
11

 -1 = 2047 Register 2, 0 PN11 

Bit 15 2
15

 -1 = 32767 Register 1, 0 PN15 

Bit 16 2
16

 -1 = 65535 Register 5, 3, 2, 0 PN16 

Bit 20 2
20

 -1 = 1048575 Register 3, 0 PN20 

Bit 21 2
21

 -1 = 2097151 Register 2, 0 PN21 

Bit 23 2
23

 -1 = 8388607 Register 5, 0 PN23 

For example, a 9-bit PRBS generator that feeds into registers 4 and 0 (output). The 

generated serial data is converted internally, and for QPSK modulation, 2-bit symbols are 

taken out each time. 

 

9-bit PRBS generator 

 Clock signal 

The Ceyear 1466 internal baseband signal generator needs a clock reference to 

synchronize the output. 

• Internal clock 

The instrument uses its internal clock for reference.  

The internally generated clock signal can be output through the "5GHz Clock Output" 

interface on the rear panel. 
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•The external clock is input through the "5GHz Clock Input" interface on the rear 

panel. 

 Mark output signal 

The Ceyear 1466 can output marker signals synchronously with digital signal 

generation. The marker signal can be used for measurement synchronization with 

external receiving equipment. For example, a time slot clock or a frame clock can be 

selected with a suitable marker setting, and the start of a specific modulation symbol can 

be marked to synchronize the demodulation of the receiver. 

 

 

 

Four marker output signals are provided in each baseband. All marker signals can be 

output on the connectors provided. For dual-channel models, the four markers are 

common. It can be set via interface mapping. 

 Configure marker interface mapping 

When using the marker output function, it is necessary to configure the function of the 

output interface in the interface mapping window. 

The marker output interface 1 and the marker output interface 3 on the rear panel are 

multiplexing interfaces. You need to configure the interface type in the interface mapping 

window. For dual-channel models, each marker can be freely assigned to two channel 

outputs. 

Tips 

file:///C:/Users/wangpeng-yi/AppData/Roaming/Microsoft/Word/0881a4d025d84972.htm%23ID_ef48199c826d9e600a00206a00e416ba-55d9660d826d9e600a00206a0090245c-en-US
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 Marker mode 

A marker mode is a characteristic of the shape and periodicity of a marker, and the 

Ceyear 1466 provides several different modes to define different marker signals. The 

marker settings for each function option are different, and this section only focuses on the 

commonly used marker signals. 

Generally a marker signal can be change from "ON" (high) to "OFF" (low) state and 

vice versa over a period of time. The Ceyear 1466 offers several methods to characterize 

marker signals for you to choose a most suitable method. 

Restart marker mode 

The resulting marker signal is a single "ON" pulse. The rising edge of this pulse 

occurs at the start of signal generation and at each subsequent restart of the signal. This 

marker can be used to monitor the effect of the selected trigger, for example a trigger 

causing signal generation to restart. 

Marker mode pulse 

Periodic markers with consecutive ON and OFF cycles of the same length. The first 

ON cycle starts from the beginning of the first generated sample/symbol. The marker 

frequency is defined by "Average Value". The frequency derivation is as follows: 

<Frequency> = "Symbol/Sampling Rate" / "Divider” 

<Frequency> = "Sampling Frequency" / "Average Value". 

For example: 

"Symbol rate = 1 msym/s", "Average Value = 2” 
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The marker frequency is 500 kHz, corresponding to a marker period of 2 us. Each ON 

and OFF period has a length of 1 us, corresponding to one transaction type period. When 

the delimiter is 4 (6, 8 ...), the length of each ON and OFF period increases to 2 (3, 4, ...) 

symbol periods. 

1 2 3 4 5 6

 

Predefined patterns of marker mode 

For period markers, each period consists of a predefined pattern with a maximum 

length of 64 bits. A "1" ("0") in a PATTERN indicates an ON (OFF) signal segment with a 

duration of one sample/symbol period. 

For example: 

In the following example, the marker signal is represented by the pattern 100100..... 

1 2 3 4 5 6

 

Fixed ON/OFF ratio of marker mode 

It is similar to “Pulse”, but has independent ON and OFF period lengths. The length of 

the period is entered in number of symbol/sample periods. 

For example: 

In the following example, the marker signal is defined by "ON Time" = 1 and "OFF 

Time" = 2. 

1 2 3 4 5 6

ON ONOFF OFF

 

Custom marker mode 

The instrument generates marker signals defined in the selected control list. The 

Ceyear 1466 provides a graphical interface for conveniently defining marker signals. 
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 Baseband trigger signal 

The Ceyear 1466 provides multiple trigger modes, different trigger sources and some 

additional trigger settings to suppress or delay trigger events. This section provides an 

overview of the baseband trigger settings and how they affect signal generation. 

Trigger 

A trigger signal is an internally generated or externally provided signal that starts 

generating a signal at a specific point in time. However, signal generation can also take 

place without triggering. In this case, the signal produces a waveform immediately after 

modulation is enabled. 

Trigger event 

A trigger event is caused by a received trigger signal. Another possibility to raise a 

trigger event is to execute the trigger manually. 

Content 

•Trigger source 

•Trigger mode 

 Trigger source 

The provided trigger sources fall into two categories: internally generated trigger 

signals (trigger keys) or externally provided trigger signals. 

• Internal "trigger key" 

The internal trigger signal is generated by the instrument itself and can be triggered by a 

"trigger key", and for dual-channel models, each baseband can be triggered 

independently or routed from one baseband to another. 

• External 

The signal is generated by an external trigger source. The conditions for generating 

specific events depend on the setting of external trigger events under the "External" menu, 

such as external trigger slope, trigger delay, etc. The default external event setting on 

factory reset is the rising edge of a TTL pulse. 

 Trigger mode 

Trigger events affect signal generation in different ways, depending on the selected 

trigger mode. 

Effect of trigger events on generated signals 

Trigger 

mode 

Signal generation mode 

Cont After a valid trigger event is received, the waveform segment will be played 

repeatedly 
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Single After a valid trigger event is received, the waveform segment will be played 

only once 

Gate Within the effective period of the gate control signal, the waveform segment 

is played continuously 

Repeat 

once 

After a valid trigger event is received, a group of waveform segments will be 

played according to the number of repetitions 

 

 

Trigger 

mode 

Trigger type Signal generation mode 

Cont Automatic In the automatic continuous playback mode, after the 

waveform segment data is downloaded, the software 

will automatically trigger the waveform segment to start 

playing. During playback, the system ignores all trigger 

events 

Trigger In the trigger continuous playback mode, the system will 

not play the current waveform segment before receiving 

a valid trigger event; After receiving a valid trigger 

event, the system will start to play the current waveform 

segment. After the play of current sequence is finished, 

the system will automatically restart playing the current 

waveform segment. During the sequence playback, the 

system ignores all trigger events. 

Real-time In the real-time continuous playback mode, the system 

will not play the current waveform segment before 

receiving a valid trigger event; After receiving a valid 

trigger event, the system will start to play the current 

waveform segment. After the play of current sequence 

is finished, the system will automatically restart playing 

the current waveform segment. During the sequence 

playback, if a valid trigger event is received, the system 

will immediately stop the current playback and replay 

the current waveform segment from the beginning. 

Single Ignore the 

repeated trigger 

In the single playback mode with the current playback in 

progress, the system will automatically ignore any 

trigger event if received, and the system will not receive 

an effective trigger event until the playback of the 

current waveform segment is completed. 

Cache repeated In the single playback mode with the current playback in 
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trigger progress, the system will store any trigger event in 

cache if received. After the current waveform segment 

is played, the system will automatically call out the 

cached trigger event and trigger a waveform segment 

playback. Note that cache triggered signals have no 

delay. 

Real-time 

repeated trigger 

Real-time repeated trigger: In the single playback mode 

with the current playback in progress, the system will 

immediately stop the current playback and restart the 

current waveform segment from the beginning if a 

trigger event is received. 

Gate Active high/low The control object of the gate trigger mode is the 

sampling point of the waveform segment. When the 

gate control signal is invalid, the playing of waveform 

segment will be stopped; When the gate control signal 

is valid, the system will continue to play the waveform 

segment in the memory from the next sampling point 

when it stopped last time. In gate trigger mode. If the 

gate signal is valid at the end of waveform segment 

playing, the entire waveform segment will be played 

again from the beginning of the waveform segment. In 

the gate play trigger mode, the trigger source is 

automatically set to external, that is, the selection of the 

trigger source does not affect the playback of the 

waveform segment. 

 

In the example shown below, the instrument's processing time is ignored. 

• Continuous (automatic) 

In auto trigger mode, the instrument generates a continuous signal. Ignore triggers during 

playback. 
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• Continuous (trigger) 

In the continuous trigger mode, the instrument waits for the trigger signal after starting, 

and ignores the trigger in playback after the signal is generated. 
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Start Trig
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• Continuous (real time) 

In the continuous real-time mode, the instrument waits for the trigger signal after starting, 

and the trigger signal, if generated, arrives and starts playing again. 
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• Single (ignore repeated trigger) 

The instrument starts playing the signal only when a trigger event occurs. The signal is 

played once.  

Every subsequent trigger event will be ignored. 

A
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p

l

Time

Start Trig
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Trig
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p
Stop Play Stop

Trig

 

• Single (cache repeated trig) 

The instrument starts playing the signal only when a trigger event occurs. The signal is 

played once.  

During playback, each subsequent trigger event will be recorded, and the playback will 

continue by the number of triggers after playback is completed. 
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• Single (real-time repeated trigger) 

The instrument starts playing the signal only when a trigger event occurs. The signal is 

played once.  

Each subsequent trigger event may cause a restart. 
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• Gate (active high) 

The instrument starts signal generation only when the external gate signal is high, and 

then generates a continuous signal. Signal generation is stopped when the gate is low. 
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Sto

p
Stop Play Stop

Gate（ High（

 

 Supported modulation types 

The Ceyear 1466 supports a range of predefined digital modulation types. 

The Ceyear 1466 supports ASK (Frequency Shift Keying), FSK (Frequency Shift 

Keying), PSK (Phase Shift Keying) and QAM (Quadrature Amplitude Modulation). The 

digital modulation process is described by mapping and assigning values I and Q (PSK 

and QAM) or frequency shifts (FSK) to each modulation symbol. The resulting modulated 

signal is represented graphically by a constellation chart, with each possible symbol 

represented by a discrete point on the complex plane. The number of bits used by each 

symbol is a modulation parameter. The exact position of symbols on the constellation 

chart is determined by the encoding used and may be affected by additional applied 

rotations. 
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In order to understand and compare the performance of different modulation methods, 

it is necessary to first understand the difference between bit rate and signaling rate. The 

signal bandwidth required by a channel depends on the signal rate other than the bit rate. 

The bit rate is the frequency of the system bit stream. For example, a wireless system 

with an 8-bit sampler samples an audio signal at a rate of 10k. Then the bit rate, that is, 

the basic bit stream rate in the system, is the product of 8-bit multiplied by 10k sampling 

rate per second, that is, 80kbit per second. The signaling rate is equal to the bit rate 

divided by the number of bits transmitted by each signal. If a signal transmits only one bit, 

like BPSK, the signal rate is the same as the bit rate, e.g. 80 kilobits per second. If each 

signal transmits two bits, like QPSK, then the signal rate is half the bit rate, e.g. 40 kilobits 

per second. Signaling rate is also called baud rate. Note that baud rate is different from bit 

rate, and the two are often confused. If more bits are transmitted by each signal, the 

narrower spectrum is required to transmit the same amount of data. This is why the more 

complex the debugging method and the more status points, the less spectrum resources 

are needed to transmit the same information. 

 FSK 

FM and PM are closely related. An increase in frequency of 1 Hz is equivalent to a 

phase advance of 360 degrees per second (2πrad/sec) relative to the original phase. 

FSK (phase shift keying) is used in systems such as cordless and page transmission. 

Some cordless systems include DECT (digital enhanced cordless telephone) and CT2 

(2nd generation cordless telephone). 

In the FSK method, the carrier frequency varies as a function of the modulated signal 

(data) being transmitted. The magnitude remains the same. In binary FSK (BFSK or BFSK

或 2FSK), "1" is represented by one frequency and "0" is represented by another 

frequency. 

 

 
FSK 

Frequency 
relative to time 

MSK 
Q relative to I 

One bit per signal One bit per signal 
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 Minimum shift keying (MSK) 

Because frequency shifts can lead to phase advance or lag, frequency changes can 

be detected by phase sampling during every signal period. The phase change of 

(2N+1)π/2 radians can be easily detected by an I/Q demodulator. Even-numbered signals 

are transmitted by the I channel, and odd-numbered signals are transmitted by the Q 

channel. The orthogonality of the I and Q channels simplifies signal extraction and 

reduces the power consumption in mobile phones. The minimum frequency shift obtains 

the orthogonality of I and Q channels according to the ±π/2 phase shift (90 degrees for 

each signal) generated by each signal. FSK with this frequency offset characteristic is 

called MSK. The frequency offset must be precise to produce a repeatable 90 degree 

phase shift. MSK is used in GSM portable stations. A phase shift of +90 degrees 

represents "1" and a phase shift of -90 degrees represents "0". The peak-to-peak 

frequency variation in MSK is equal to half the bit rate. 

The envelope of the FSK and MSK carrier signal is constant with no amplitude 

variation. This is a desirable characteristic to improve transmitter power efficiency. 

Amplitude variations cause nonlinearities in the transfer function of amplifier, resulting in 

regenerated spectrum where adjacent channel power appears. Therefore, a signal with a 

constant envelope can be amplified with a more efficient amplifier (which may result in 

poor linearity) to reduce power consumption. 

MSK occupies less spectrum than the FSK with large frequency offset. Spectrum 

width is also affected by the signal waveform which causes a frequency shift. If the edges 

of the signal are fast or have a high slew rate, the transmission spectrum will be wide. In 

fact, the signal is filtered by a Gaussian filter, so the spectral lines are narrow. In addition, 

Gaussian filters have no time-domain overshoot, which can increase frequency offset and 

broaden the spectrum. MSK with a Gaussian filter will be changed to GMSK (Gaussian 

MSK). 

 Quadrature amplitude modulation (QAM) 

Another member of the digital modulation family is QAM. QAM is used in microwave 

digital communications, DVB-C (digital video broadcasting over cable) and modem. 

In 16-state QAM, there are four I values and four Q values. Thus each signal has 16 

possible states. It is possible to change from one state to any other state within each 

signal transmission time. Since 2
4
=16, each signal can carry four bits. It includes two I bits 

and two Q bits. The baud rate is one quarter of the bit rate. This form of modulation 

therefore makes more efficient use of the spectrum. It is more efficient than BPSK, QPSK 

or 8PSK. Note that QPSK is equivalent to 4QAM. 
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Another variant is 32QAM. In this way, there are 6 I values and 6 Q values, and a total 

of 36 possible states are combined (6X6=36). This is more than an integer power of 2 (the 

nearest integer power of 2 is 32). Therefore, the four states with the largest transmission 

power consumption on the four corners are omitted. This reduces the maximum peak 

power of the transmitter. Since 2
5
=32, each signal contains five bits, and the baud rate is 

one fifth of the bit rate. 

At present, the actual application upper limit is 256QAM, and the development 

towards 512 or 1024 is currently underway. The 256QAM system employs 16 I values and 

16 Q values to provide 256 possible states. 2
8
=256, where a signal can represent eight 

bits. A 256QAM signal can transmit 8 bits of data, which is very economical in terms of 

spectrum. However, due to the close proximity of signal states, errors can easily occur 

due to noise and disturbances. Such signals require higher power transmission (to 

effectively separate signal states), thereby reducing the power effect compared to simple 

modulation modes. 

Compare 256QAM and BPSK (the latter employs an 8-bit sampler to sample sound 

signals at a rate of 10kHz). BPSK transmits at a speed of 80k signals per second, each 

containing one bit. The 256QAM system transmits eight bits per signal, so the baud rate is 

10k signals per second. The 256QAM system can transmit the same information using 

only one eighth of the bandwidth of BPSK. Its bandwidth efficiency is eight times. However, 

there is an exchange where the system becomes more complex and noise and 

disturbances are more likely to cause errors. For high-order QAM like this, the error rate 

deteriorates faster in noisy environments than in QAM. One measure of this deterioration 

is a higher bit error rate (BER). 

In all digital modulation systems, if the input signal is disturbed or severely attenuated, 

 
Vectogram Constellation chart 

16 QAM 
4 bits per signal 
Baud rate = 1/4 

bit rate 

32 QAM 
Per signal bit 

Baud rate = 1/5 bit rate 
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the receiver may completely lose its lock on the signal. If the receiver is unable to recover 

the clock, it cannot demodulate the signal or extract information. If the situation is slightly 

better, the signal clock may be able to recover, but there is a lot of noise and the 

positioning of the signal itself is also very chaotic. Sometimes the signal may deviate far 

enough from the expected position and run to adjacent positions. The I and Q level 

detectors in the demodulator may not be able to decode correctly due to the signal not 

being in the correct position, resulting in bit error. The efficiency of QPSK is not very high, 

but the states are far apart, and the system can tolerate more noise before bit error occurs. 

QPSK has no intermediate state between the state points at the four corners, so the 

probability of demodulator decoding errors is very low. QPSK requires less transmission 

power than QAM at the same bit error rate. 

 

Customize IQ files 

The user-defined modulation mapping file can be selected as the modulation 

mapping source. The user modulation mapping file must have the extension *.iqm. 

Modulation mapping files can be defined and edited. Its main purpose is to assign logical 

symbol numbers to constellation points and select modulation specific parameters. In 

addition, creating any selected constellation chart is also supported. 

 Supported baseband filters 

In wireless transmission technology, a filter is applied to adjust the baseband signal 

before it is modulated on the RF. The type and shape of the selected baseband filter can 

affect the output signal, especially when generating broadband signals. If the filter is too 

narrow, the signal will be cut off. If the filter is too wide, the signal may be distorted by 

stringing in some unnecessary signals. 

To meet the requirements, Ceyear 1466 offers a variety of predefined baseband 

filters. Predefined filters are designed specifically for the special spectral characteristics of 

different communication standards. However, based on the selected filter form, one or 

more filter parameters are provided to adjust the filter characteristics more accurately. For 

example, selecting steeper edges or changing the conversion bandwidth. 

Generate digital modulation signal 

Ceyear 1466 can generate digital modulation signals with user-defined 

characteristics. Baseband filtering and symbol rate can be set over a wide range. 

Digital modulation settings 

Select the "Baseband>Digital Modulation" option. 
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The "Digital Modulation" dialog box allows direct selection of data source, symbol 

rate, modulation type, and filter. 

The dialog box is divided into multiple property pages. In each case, the current 

settings are displayed in the property page name. 

 Data source configuration 

 Select "Baseband>Digital Modulation—>Data Source Configuration". 

This property page provides settings for digital modulation switches, data sources, 

symbol rates, and other operations. 

 Digital modulation ON/OFF 

Enable/disable digital modulation. Turning on digital modulation will turn off all other 

digital standards. 

Digital modulation is generated in real-time (without pre-calculated signals), so when 

digital modulation is enabled, all parameter changes will directly affect the output signal. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom[:STATe] 

 Data source 

Select the data source. 

The following data sources are available: 

"All 0, All 1" A sequence containing 0 or 1 data is generated internally. 

"PRBS, PRBS type" Select internally generated PRBS data based on IUT-T. Use the 

parameter "PRBS type" to define the length.  

"Custom Sequence" Use the 'Custom Sequence' box to define a bit pattern with a 

maximum length of 64 bits.  

"File Stream" Use binary data from the data list. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:DATA 

 Select file stream 

Use the "Select Stream File" dialog box to select an existing stream file or create a 

new stream file. 

The data list can be generated externally or within a built-in data editor. 

• Select the "Select Stream File>Navigate to Stream File Selection" dialog box and 

select an existing stream file with the suffix "*. src". 
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• Use the "File Management" dialog box to transfer external stream files to the 

instrument. 

• Use the "New" and "Edit" functions to create new stream files internally or edit 

existing stream files. 

Also refer to "How to Create and Assign a Data List” 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:DATA:PRAM 

 Code element rate 

Select the symbol rate. The value range of this parameter depends on the selected 

modulation type and the maximum modulation bandwidth of the current model; The scope 

will be automatically redefined. 

If the selected symbol rate is out of the redefined range, an overrun prompt message 

will be displayed. The symbol rate is automatically set to the maximum value allowed for 

the new modulation. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:SRATe 

 Stream file editor 

Ceyear 1465 provides the following methods to create custom stream files: 

• Use a dedicated "Stream File Editor" and create a file with an extension of *.src. 

• Create a binary format file using the SCPI command.  

 How to create and allocate stream files 

Ceyear 1466 provides the following methods to create a list file: 

1. Access the "Stream File Editor": 

2. Select "Baseband>Digital Modulation>Data Source Configuration>Data Source 

Selection>File Stream" 

3. Select "Select Stream File" 

4. In the open file selection window, navigate to the desired directory, such as 

/home/ceyear/SgData/User/DataSrc. 

5. Select "New" and enter "File Name", then press Enter. 

6. In the open file selection window, select the newly created file and click the "Edit" 

button below to open the stream file editing window. 
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7. Enter the sequence of 0 and 1. 

 

8. Select "Save and Apply" to store the used settings as a data list file. 

└ Search 

└ Hexadecimal/binary 

└ Replacement/insertion mode 

└ Save and apply 

 Search 

Open the input index window for the position. Enter the marker index to automatically 

navigate to the selected marker position. 

 Hexadecimal/binary 

Switch between hexadecimal and binary displays. 

Each 4-bit group is displayed as a hexadecimal value. To improve readability, 

hexadecimal values are displayed in groups of two. 

Hexadecimal functions are automatically assigned to the number keys on the front 

panel. 

 Replacement/insertion mode 

Switch between replacement and insertion modes to enter new values or replace old 

values. 

 Save and apply 

Save the changes to the selected stream file. 

file:///C:/Users/wangpeng-yi/AppData/Roaming/Microsoft/Word/a97a32d04cd74abc.htm%23ID_e6437e75091b454f0a001ae72dc50b9c-3f2846b08235ff740a00206a00277621-en-US
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 Modulation type selection settings 

Access: 

 I 

This property page provides access to modulation type settings, such as modulation 

type, FSK deviation, or modulation depth. This dialog box displays the theoretical 

constellation chart of the selected modulation. 

└ Modulation type 

└Select IQ file 

└ASK modulation depth 

└FSK frequency deviation 

└αAngle 

└Custom γ 

└Custom FSK type 

└Freq offset 

└ Restore default modulation type 

 Modulation type selection 

Select modulation type. The associated symbol mapping will be displayed. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation[:TYPE 

 

 Select IQ file 

This option is valid when selecting a custom IQ file for modulation type. Access the 

"Select Custom IQ Modulation File" dialog box to select the mapping table. This dialog 

box provides standard file management functionality. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:UIQ 

 

 ASK modulation depth 

Set the modulation depth m for ASK modulation. 

file:///C:/Users/wangpeng-yi/AppData/Roaming/Microsoft/Word/dbf9f699cadd415d.htm%23ID_9bfbe5f825ee07360a710a27000d120a-3f2846b08235ff740a00206a00277621-en-US
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m = (maximum amplitude - minimum amplitude)/(maximum  amplitude) + minimum 

amplitude) 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:ASK[:DEPTh 

 

 FSK frequency deviation 

Set the frequency deviation of FSK modulation. The range of values depends on the 

selected 'symbol rate’ (refer to data manual). 

Whenever "MSK" is selected, the deviation corresponds to 1/4 of the symbol rate and 

cannot be changed. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:FSK[:DEViation] 

 

 α angle 

For AQPSK modulation, set the angle alpha between point (0, 0) and the I axis. 

 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:AQPSk[:ANGLe] 

 

 Custom γ 

This option is valid when the gamma value is selected as custom. Select the gamma 

function γ for modulation of 16APSK and 32APSK. 
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The values in parentheses represent the bit rate used according to the DVB-S2 

specification. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:APSK[16]|32:GAMMa:CUSTom[1]|2 

 

 Custom FSK type 

For "Variable FSK", select the FSK modulation type. 

Available options include 4FSK, 8FSK, and 16FSK. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:UFSK:TYPE 

 

 Freq Offset 

For "Custom FSK", set the frequency deviation of the selected custom FSK type. The 

number of symbols depends on the modulation type selected. The value of each symbol is 

represented in binary format. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MODulation:UFSK:DEViation[1]|2--16 

 

 Custom mapping editor 

Access: 

► Select "Baseband>Digital Modulation>Modulation Type Selection>Custom IQ File", 

then press the "Select IQ File" button, select the desired file (such as iq_user_test. iqm), 

and click the "Edit" button. 

 I/Q mapping index 

Modify the I/Q mapping index to n, and 2 ^ n sets of I and Q values will appear in the 

table. All I and Q values default to 0, and the custom mapping map will depict the 

corresponding points according to the table. 
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 Standard I/Q mapping 

The standard I/Q mapping includes the options BPSK, QPSK, 16PSK, 4QAM, 

16QAM, 64QAM, 128QAM. Edit the drop-down box, and the table will automatically 

calculate the I and Q values corresponding to the selected standard I/Q mapping based 

on the options in the drop-down box. The custom mapping map will depict the 

corresponding points according to the table. If the data in the table is not refreshed based 

on the standard I/Q mapping, the standard I/Q mapping displays "----". The values in the 

I/Q Mapping Index edit box is also calculated based on the selected standard I/Q 

mapping. 

 

 Table 
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The I and Q values in the table can be automatically refreshed based on the I/Q 

mapping index and standard I/Q mapping, and the refreshed results are subject to the last 

modification. Users can also directly edit the table according to their needs, and the graph 

in the custom mapping diagram will automatically refresh according to the table. 

 

 Custom mapping diagram 

The horizontal axis in the graph represents the Q value, and the vertical axis 

represents the I value. Whenever the values in the table change, the points in the graph 

are refreshed based on the coordinates in the table. 

 Clear 

Clicking the "Clear" button will clear the table with an I/Q mapping index of 0 and the 

I/Q mapping as "----". 

 Store and apply 

Click the "Store and Apply" button, and the data of the current table will be saved into 

the currently selected file and applied. 

 Stored as 

Click the "Save As" button and a file management window will pop up, allowing you to 

store the current table content in another file. 

 Filter settings 

Access: 

 Select "Baseband>Digital Modulation>Filter Settings>". 
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This property page provides access to filter settings, such as filter type and other filter 

settings (if available). 

└ Filter 

└ Filter parameters 

└ Restore default filtering mode 

 Filter 

Select a baseband filter. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:FILTer 

 

 Filter parameters 

Set the corresponding filter parameters. 

The provided filter parameters ("filter factor α” or "filter factor Bbt") depend on the 

currently selected filter type. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:ALPHa 

 

 Restore default filtering mode 

Restore the default filtering mode of the instrument. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:FILTer:PRESet 

 Trigger mode 

Access: 

► Select "Baseband>Digital Modulation>Trigger Mode". 

This property page contains settings for selecting and configuring triggers (such as 

trigger source, mode, and delay). The current signal generation status is displayed in the 

title of the property page along with information on enabling trigger mode. 

Setting: 

└ Trigger mode 

└ Trigger source 
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└Continuous trigger type/gate trigger type 

└Execution trigger 

└ External/trigger slope 

└(External) Delay 

└External delay type 

└External delay time 

 Trigger mode 

The trigger mode includes three types: continuous, single, and gate. A brief 

description of the functions of each mode is as follows: 

Continuous: Upon receiving a valid trigger event, the currently selected code type is 

repeatedly generated. 

Single: After receiving a valid trigger event, only the currently selected code type is 

generated once. 

Gate: During the effective period of the gate signal, the current code type is 

continuously generated repeatedly. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger:TYPE 

 

 Trigger source 

Trigger sources include: trigger key (Key) and external (Ext). The specific 

descriptions of each trigger source are as follows: 

• Trigger key 

The trigger source comes from the trigger key in the instrument control window. 

• External 

The trigger source is the trigger input at the interface of the instrument rear panel. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger[:SOURce] 

 

 Continuous trigger type/gate trigger type 

When the trigger mode is continuous, the continuous trigger types are Auto, Trigger, 

and Realtime. 
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When the trigger mode is gate, the gate trigger type is high effective and low 

effective. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger:TYPE:CONTinuous 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger:TYPE:GATE:ACTive 

 

 Execution trigger 

When the trigger source is the trigger key, manually execute the trigger. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger:EXECute 

 

 External/trigger slope 

Set to triggering signal to rise edge trigger or fall edge trigger. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger[:SOURce]:EXTernalSLOPe 

 

 (External) Delay 

Confirm whether to turn on or off the external delay. 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger[:SOURce]:EXTernal:STATe 

 

 External delay type 

The name and delay of the parameter represent the unit. 

 External Delay 

Set the delay time for external trigger events. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger[:SOURce]:EXTernal:DELay[:TIME] 

[:SOURce[1]|2]:RADio:CUSTom:TRIGger[:SOURce]:EXTernal:DELay:SAMPle 

 

 Interface mapping 

Access: 
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 Select "Baseband>Digital Modulation>Interface Mapping>". 

For 1466 dual (single) channel devices, the rear panel has 4 marker output ports, of 

which 2 are interfaces for marker output and trigger input multiplexing (only 1 marker 

output and trigger input multiplexing interface for a single channel). This configuration 

window allows users to edit tables according to their needs and configure the functions of 

the 4 interfaces. 

 

1. For the 1466 dual channel, the interface marked 2/4 can only output the 

corresponding marking signal. The corresponding channel can be selected through the 

drop-down box; The output interface of Marker 1 and the trigger signal input interface of 

Channel A are multiplexed. If the interface is Marker 1/Trigger A (interface name) and the 

corresponding channel is selected as Channel A, the interface type can be selected from 

the drop-down box as Marker 1 or Trigger A. If the corresponding channel is selected as 

Channel B, the interface type can only be Marker 1; The output interface of Marker 3 and 

the trigger signal input interface of Channel B are multiplexed. If the interface is Marker 

3/Trigger B (interface name) and the corresponding channel is selected as Channel B, the 

interface type can be selected from the drop-down box as Marker 3 or Trigger B. When 

the corresponding channel is selected as Channel A, the interface type can only be 

Marker 3. 
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2. For the 1466 single channel, the interface marked 2/3/4 can only output the 

corresponding marker signal. The output of marker 1 and the trigger signal input are 

multiplexed and can be selected through the interface type drop-down box. 
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 Marker setting 

Access: 

► Select "Baseband>Digital Modulation>Marker Settings". 

This property page provides access to the settings required to select and configure 

marker output signals, such as marker mode or marker delay settings. 

 

Setting: 
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└ Marker mode 

 Marker type 

Basic marker configuration for up to three marker channels. The content of the dialog 

box varies depending on the selected marker mode. 

Use these settings to define the shape and period of markers. 

The instrument routes the generated marker signal to the selected output connector. 

Please refer to the section "Common functions and settings of baseband" for a detailed 

description of marker types. 

Remote command: 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4[:TYPE] 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4:PATTern 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4:ONTime 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4:OFFTime 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4:DIVider 

[:SOURce[1]|2]:RADio:CUSTom:MARKer[1]|2|3|4:CUSTom 

 

 Custom marker editor 

Ceyear 1466 provides a graphical editing mode to create custom marker files, with 

the following steps: 

1. Select "Baseband>Digital Modulation>Marker Settings". 

2. Set the type of Marker 1 to custom. Click "Select Marker File" on the right side. 

 

3. Navigate to the desired directory, such as /home/ceyear/SgData/user/Marker, and 

select 'New'. 

4. In the "File Name" field, enter the new custom marker file name MyTestMarker and 

click OK. 

 

5. Click “Edit” button. Open the marker file editing dialog box. 

The Marker File Editing dialog box is an intuitive graphical interface used to define 

and manage marker signals. 

 

• Individual files marked with a file name extension of *. mrk. 
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In the "Edit Marker File" dialog box, the available markers are displayed in color 

coding. To define a single marker signal, double-click the position of the marker. Among 

them, the scaling of the x-axis always adapts to the total length of the edited data to 

provide an overview of all defined marker signals. For detailed display, please zoom in on 

the display area around the current marker. 

Setting: 

└Total number of data 

└Current location 

└Zoom in/zoom out 

└Save as 

└Save and apply 

└Delete current marker 

└Delete all markers 

 Total number of data 

The defined range length of the input marker signal (in Symbol). The starting value is 

always 0, displaying the entire defined range.  

 Current position 

Move the marker in the graph to the editing position. If the entered value exceeds the 

selected length within the defined range, the length will be automatically adjusted. 

 Enlargement/reduction 

Zoom the display area of the control list. The name of the button is "Zoom Out" when 

in the zoom in state, and "Zoom In" when in the zoom out state. 

For longer marker lists, displaying only a portion of the marker data can be helpful. In 

this case, please set the "Zoom In Range" to determine the number of symbols to be 

displayed, and then click "Zoom In" to focus the display area around the current "Marker 

Position". 

 Save as 

Store changes in the selected marker file or new file. 

 Save and apply 

Store changes in the selected marker file or new file, and select and apply the 

currently saved marker file. 

 Delete current marker 

Reset the currently selected marker. 
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 Delete all markers 

Reset all markers. 

For details on how to activate marker signal output, please refer to the 

"Configuring marker interface mapping" section". 

Use arbitrary wave function (ARB) 

Arbitrary waveform generator (ARB) Ceyear 1466 important function. ARB allows 

playback and output of any externally calculated modulation signal in the form of 

waveform files. ARB can also generate multi-carrier or sequence signals from waveform 

files. 

About ARB 

This section provides background information about ARB functionality and the impact 

of the provided settings. 

Content 

• Waveform File Source 

• ARB Test Signal 

• Clock Frequency (Waveform Sampling Rate) 

• ARB General Settings 

• Sine Wave Test Waveform Signal 

• Square Wave Test Waveform Signal 

• Trigger settings 

• Interface Mapping 

 Waveform file source 

In ARB mode, Ceyear 1466 employs an ARB waveform file to obtain digital I/Q data 

of the baseband signal. Ceyear 1466 can replay waveform files stored in the instrument, 

as well as generate and replay simple waveforms for testing purposes. 

What is a waveform file? 

Waveform file is a file in the specified file format, which contains the original IQ 

samples. The IQ value is pre-calculated and stored as a waveform file with a predefined 

extension of *. seg/bin. 
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When Ceyear 1466 creates waveforms, the instrument inserts the file header at the 

beginning of each created ARB file for *. seg waveform files. The header size of the 

generated I/Q data file is 16k. 

Waveform file source 

Based on whether Ceyear 1466 creates its own waveform files, two waveform file 

sources can be distinguished: 

• Internally generated waveform 

The ARB generator can calculate and generate waveform segments and multi-carrier 

waveform files. The ARB generator also provides built-in functions to create test 

waveforms (such as sine or rectangular signals) and save them as files or on a hard drive.  

Some digital standards provide the function of "generating waveform files". With this 

function, the calculated signal is stored as a waveform file, which can then be played by 

the ARB generator. 

• Externally generated or created waveforms 

ARB can also handle externally created waveform files, such as: 

– Waveform files generated by Ceyear WinWavSIM software and radar simulation 

software. 

–  Signals calculated using mathematical programs such as MATLAB. 

These software are installed on a PC and can be programmed to load externally 

generated waveform files into the instrument through USB, LAN, or GPIB interfaces. 

 ARB test signal 

The following test signals are available: 

• Sinusoidal test signal: Two sine wave signals, with an optional (but equal) 

number of samples and the same frequency in each period. When the generation is 

triggered, the number of samples per period and the frequency of the test signal 

determine the ARB clock frequency: "clock frequency"="frequency" * "number of samples 

per period".  

Notice: Due to the fact that the final clock rate shall not exceed the maximum ARB clock 

rate, the number of sampling values will be automatically limited according to the selected 

frequency. The first sinusoidal signal is mapped onto the I sample, and the second 

sinusoidal signal is mapped onto the Q sample. The difference between the two signals 

lies in the selectable phase offset. For a -90 degree offset, the result is the unit vector on 

the I/Q plane, which is obtained by rotating counterclockwise and starts from I=0 and Q=-1. 

For a 0 degree offset, the I and Q samples are located on the diagonal of the unit square (I 

(t)=Q (t)). 
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Usually, the I/Q sample is located on a deformed circle, which is limited to the dashed 

square in the figure above. 

• Rectangular test signal: A rectangular signal with optional but equal ON and 

OFF periods and amplitudes. The period is defined by the selected 

frequency:<period>=1/"frequency".  

The signal is mapped onto the I and Q samples. This results in two different points in the 

I/Q plane. "Offset DC" moves by two points along the diagonal I (t)=Q (t). 

 

 Clock frequency (waveform sampling rate) 

Arbitrary waveform generator includes a resampling unit that interpolates input 

samples before digital to analog conversion (DAC) to achieve the clock frequency of the 

target digital IQ signal output. The clock frequency of arbitrary waveform can be obtained 

from the file header of arbitrary waveform, and can also be specified in the user interface 

of arbitrary waveform. 

The following figure describes the process involved in waveform processing and 

resampling in ARB. 
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Process waveform files in ARB 

finput = Waveform sampling rate 

b = Available bandwidth coefficient 

fSysClk_max=Maximum system clock value=maximum sampling rate value 

 

• fSysClk_max  = SystemClock max =   SampleRatemax = 1.25 GHz (Ceyear 1466 

H31-1000) and 2.5  GHz (Ceyear 1466 H31-2000)   

• b  = 0.4 (Ceyear 1466 H31-500/1000/2000)  

 Impact of resampling filters 

The filter in the resampling stage is distortion free for signals with the following 

maximum baseband bandwidth: 

Usable_Bandwidthmax [MHz]  = b* finput. 

Where b is the available bandwidth factor, which depends on the installed option: 

• b = 0.4 (Ceyear 1466 H31-500/1000/2000) 

The waveform file created externally must provide a sufficiently high sampling rate 

finput, to achieve perfect signal reconstruction. For undistorted resampling, the lower limit of 

the required sampling rate finput is calculated as follows: 

finput ≥ Usable_Bandwidth / b 

For example, when the sampling rate finput of the baseband generator is = 1000 MHz, 

themaximum RF_Bandwidth of the modulated signal= 1000*b*finput=2*b*1000 MHz= 800 

MHz. 

Content 

• ARB General Settings 

• Sinusoidal Test Waveform Signal 

• Square Wave Test Waveform Signal 

• Trigger settings 
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• Interface mapping 

 ARB General Settings 

Access: 

► Select "Baseband>Arbitrary Wave". 

This property page provides access to the default ARB settings, selection of 

waveform files, and enabling of ARB generator. 

└Arbitrary wave 

└Reset default values 

└ Load arbitrary wave 

└ Waveform information 

└ Clock frequency 

└ Create sequence 

└ Create multiple carriers 

└Test waveform type 

└Create test waveform 

 Arbitrary wave 

Enable/disable ARB modulation. Turning on the ARB generator will make all other 

digital modulation types in the same RF channel OFF. 

Output the loaded waveform file. The name of the waveform file is displayed in the 

'Load Arbitrary Wave' control. The "Waveform Information" button on the right can be 

used to view the currently loaded waveform information, such as name, size, clock 

frequency, number of sampling points, etc. 

 

ARB modulation cannot be activated.  

ARB modulation cannot be activated in the following situations 

• No waveform file or empty waveform file   

If the waveform file is not loaded, as in the default state, "Select File" will be displayed 

under the "Load Arbitrary Wave" control. A prompt message "Empty Arbitrary Wave File" 

will be provided. 

Notice 
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• Wrong waveform file 

    If the check of the loaded waveform file fails, for example, for a *. seg file, if the data 

length marked in the file header does not match the data file, a prompt message "File 

Open Failed" will be provided. 

 

Remote command: 

[:SOURce[1]|2]:RADio:ARB[:STATe] 

 

 Reset default values 

Invoke default settings. Turn off arbitrary waveform, load arbitrary waveform file and 

clear it. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:WAVeform:RESet 

 

 Load the arbitrary wave 

Select a waveform file by accessing the "File Selection" dialog box of the instrument. 

Wave file is a file with predefined file name extension *.seg/seq/bin. After selecting 

the file, this control displays the file name of the selected waveform. 

Enable the ARB generator ("ARB>State>ON") to trigger the instrument to load and 

process the selected waveform file. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:WAVeform 

 

 Waveform information 

Open a dialog box that contains detailed information about the currently selected 

waveform. The display will vary depending on the type of waveform file selected. 

When the waveform is selected as *.seg/bin, the software provides a preview display 

of the waveform file, including IQ data, power, spectrum, vector graph, etc. When the 

waveform is selected as *.seq, the software provides information on each waveform 

segment in the sequence file. 

 Clock frequency 

Display or set the ARB output clock rate. 
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For waveform files of type *. seg, the value of this parameter is set to the clock rate 

defined in the header of the loaded waveform file. This value can be changed by the user. 

For waveform files of type *. bin, this value needs to be set by the user 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SCLock:RATE 

  

 Create sequence 

Access the dialog box for creating sequences (refer to “Create Sequence (Multiple 

Waveform Segments) Files”). 

 Create multiple carriers 

Access the dialog box for creating multi-carrier waveforms (refer to “Create 

Multi-carrier Signals”). 

 Test waveform type 

Choose the form of the test signal. Provide a choice between sine and rectangle with 

constant I/Q. 

 Create test waveform 

Open a dialog box containing further settings for the selected test signal type 

 Sinusoidal test waveform signal 

Access: 

 Select "Baseband>Arbitrary Wave>Test Waveform Type>Sine Wave", and then press 

the "Create Test Waveform" button. 

 This dialog box provides settings for configuring sine test signals. Generate a sine 

wave on the I path and a sine wave with the same frequency but with phase shift on the Q 

path. 

└Frequency 

└Number of sampling points per period 

└ Path Q phase offset 

└Create output file 

└Create and load output file 

 Frequency 

Enter the frequency of the test signal. 
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Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SINE:FREQuency 

 

 Number of sampling points per period 

Enter the required sample values for sine wave of each period. 

The maximum allowable value is determined by the maximum ARB clock rate (refer 

to data manual) and the selected frequency. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SINE:SAMPles 

 

 Path Q phase offset 

Enter the phase shift of the sine wave signal on the Q channel relative to the sine 

wave signal on the I channel. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SINE:PHASe 

 

 Create output file 

Generate the signal and save it as a waveform file on the hard drive. Use the 

standard "File Selection" dialog box to store this file. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SINE:CREate 

 

 Create and load the output file 

Generate a signal and immediately use it as output. The instrument stores files using 

predefined names. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SINE:CLOad 

 

 Square waveform test waveform signal 

Access: 
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1. Select "Baseband>Arbitrary waveform>Test waveform Type>Square waveform" 

and press the "Create Test waveform" button. 

2. Select “Create Test Signal”. 

This dialog box provides settings for configuring the rectangular test signal. It 

generates a rectangular test signal with a duty cycle of 0.5. The amplitude and offset is 

adjustable. Both paths I and Q use the same signal. 

Refer to “ARB Test Signals” for more information. 

└Frequency 

└Number of sampling points per period 

└Amplitude 

└DC offset 

└Create output file 

└Create and load output file 

 Frequency 

Enter the frequency of the test signal. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:FREQuency 

 

 Number of sampling points per period 

Enter the desired number of sample values required for rectangular signal of per 

period. 

The maximum allowable value is determined by the maximum ARB clock rate (refer 

to data manual) and the selected frequency. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:SAMPle 

 

 Amplitude 

Enter the numeric amplitude of the rectangular wave. The abbreviation FS stands for 

full scale. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:AMPLitude 
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 DC offset 

Input DC offset. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:OFFSet 

 

 Create output file 

Generate the signal and save it as a waveform file on the hard drive. Use the 

standard "File Selection" dialog box to store this file. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:CREate 

 

 Create and load the output file 

Generate a signal and immediately use it as output. The instrument stores files using 

predefined names. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TWAVeform:SQUare:CLOad 

 

 Trigger setting 

Access: 

 Select "Baseband > Arbitrary Waveform > Trigger Settings". 

This property page provides access to the settings needed to select and configure a 

trigger (such as trigger source and mode). Information about the current trigger mode is 

displayed in the title of the property page. 

└ Trigger mode 

└ Trigger source 

└Continuous trigger type/Single trigger type/Gated trigger type 

└Number of repetitions 

└Execution trigger 

└ External/trigger slope 
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└(External) Delay 

└External delay type 

└External delay time 

└waveform segment number 

└Play mode 

 Trigger mode 

Select the trigger mode, "Continuous", "Single", "Gated", "Repeat Once". 

Continuous: After receiving a valid trigger event, the waveform signal will be played 

repeatedly. 

Single: After receiving a valid trigger event, the waveform signal will only be played 

once. 

Gated: During the effective time period of the gate signal, the shape signal will be 

played continuously. 

Repeat once: After receiving a valid trigger event, only one set of waveform signals 

will be played according to the set number of repetitions. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger:TYPE 

 

 Trigger source 

Trigger sources include: trigger key (Key) and external (Ext). The specific 

descriptions of each trigger source are as follows: 

• Trigger key 

The trigger source comes from the trigger key in the instrument control window. 

• External 

The trigger source is the trigger input at the interface of the instrument rear panel. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger[:SOURce] 

 

 Continuous trigger type/Single trigger type/Gated trigger type 

When the trigger mode is continuous, the continuous trigger types are Auto, Trigger, 

and Realtime. 
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When the trigger mode is single, the gate trigger type is ignore repeated trigger, 

buffer repeated trigger, and real-time repeated trigger. 

When the trigger mode is gate, the gate trigger type is high effective and low 

effective. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger:TYPE:CONTinuous 

[:SOURce[1]|2]:RADio:ARB:TRIGger:TYPE:SINGle 

[:SOURce[1]|2]:RADio:ARB:TRIGger:TYPE:GATE[:ACTive] 

 

 Number of repetitions 

This option is valid when the trigger mode is Repeat Once. Set the number of 

repetitions for the output signal. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger:TYPE:REPeat:TIME 

 

 Execution trigger 

When the trigger source is the trigger key, manually execute the trigger. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger:EXECute 

 

 External/trigger slope 

Set to triggering signal to rise edge trigger or fall edge trigger. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger[:SOURce]:EXTernal:SLOPe 

 

 (External) Delay 

Confirm whether to turn on or off the external delay. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger[:SOURce]:EXTernal:DELay:STATe 

 

 External delay type 
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The name and delay of the parameter represent the unit. 

 External delay time 

Set the delay time for external trigger events. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:TRIGger[:SOURce]:EXTernal:DELay 

[:SOURce[1]|2]:RADio:ARB:TRIGger[:SOURce]:EXTernal:DELay:SAMPle 

 Waveform segment number 

When the selected arbitrary wave file is a sequence type (*.seq), the playback control 

property page is valid. Set the sequence number of the waveform segment to play in the 

sequence. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:INDex 

 Play mode 

When the selected arbitrary wave file is a sequence type (*.seq), the playback control 

property page is valid. Sets the sequence playback mode. Including single play, order play, 

sequence play. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:TYPE 

 Interface mapping 

The "Trigger Input", "Marker Output" multiplexed to the rear panel interface provides 

quick access to the relevant connector settings. 

For details on the function, refer to the interface mapping part in the section 

"Generate Digital Modulation Signal". 

 

 The function of the interface mapping in the digital modulation window is the same as 

that in the arbitrary wave window, and they are modified synchronously. 

 

 

How to create, generate and play waveform files 

Tips 
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Certain test cases do not require real-time generation of signals according to digital 

standards. For these test cases, only replay the previously generated waveform. In this 

case, you can generate the required test waveform file in one of the following ways: 

•Internal 

– Use the built-in "Generate Waveform Segment File" function 

– Use the "Create ARB Test Signal" function  

•On the outside 

– Use the Ceyear WinWavSIM software to create a waveform file and load it into the 

ARB 

– Use Ceyear 1466 S5X series radar scenario simulation software 

– Calculate with a custom program such as MATLAB. 

If the Ceyear 1466 is equipped with the required option 1466 配备了所需的选项 S01, 

this waveform file can be loaded to subject to instrument processing. 

Content 

• How to Create and Store ARB Test Signals 

• How to Create a Waveform File with the Built-in Waveform File Generation 

Function 

• How to Load and Play Waveform Files 

• How to Use Ceyear WinWavSIM to Create a Waveform File and Load It into ARB 

• How to Manually Create a Waveform File 

 How to Create and Store ARB Test Signals 

If your test case requires a simple sine or square wave test file, please consider using 

the provided ARB test signal. 

1. Select "Baseband>Arbitrary Waveform” 

2. Select "Test Waveform Type>Sine Waveform" and click the "Create Test 

Waveform" button. 

3. Adjust the “Sine Test Signal” setting as needed. 

4. Click the "Create Output File" button. 

Browse the directory tree (e.g. /home/ceyear/SgData/user/Wav). 

Enter a file name (e.g. SINTESTWAVE). 
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Click "Save" to generate the waveform file. 

Note: Click the "Create and Load Output File" button, Ceyear 1466 will automatically 

save the generated waveform file with the default name, and automatically load it into the 

arbitrary waveform. 

5. Choose “Arbitrary Wave >State >ON”. 

Ceyear 1466 handles waveform files. 

 How to Create a Waveform File with the Built-in Waveform File Generation 

Function 

The communication protocol option of the Ceyear 1466 provides a "Generate 

Waveform File" function. This function can calculate and store the signal as a waveform 

file, which can then be played by the ARB generator. 

Generate LTE/LTE-Advanced waveform files 

1. Select "Baseband>LTE/LTE-A” 

2. Adjust the settings as needed, for example: 

a. Select the "Link Direction > Downlink” 

b. Select the test model and the "TM1_1__10MHz model" in the dialog box 

3. Enable "LTE/LTE-A > On". 

4. Click the "Generate Waveform File" button. 

Browse the directory tree (e.g.home/ceyear/SgData/Plugin/4gLTE/user/LTEWav). 

Enter a file name (e.g.  LTEWAVEFORM_TX0). 

Select "Save” 

Ceyear 1466 stores the generated waveforms in the selected directory 

home/ceyear/SgData/Plugin/4gLTE/user/LTEWav. 

 

 

 

For the multi-antenna setting in LTE/LTE-Advanced, the generated waveform files will be 

downloaded to the corresponding files in "Baseband A" by default if multiple waveform files are 

generated. For the dual-channel model, the generated waveform file is the file in the 

baseband B if the output is set to "Baseband B". 

Notice 
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 How to Load and Play Waveform Files 

Regardless of how the waveform file was generated, you can transfer it to the 

instrument, load it into the ARB and play it. 

Load and play waveform files 

1. Transfer the externally created waveform file to the instrument via programmed 

control or USB storage device. 

2. Select "Baseband > Arbitrary Waveform” 

3. Select “Load Waveform File”. 

Navigate to the directory containing the storage files (e.g. 

/home/ceyear/SgData/user/Wav). 

Click the waveform file to select. 

Click the "Select" button. 

Confirm that the waveform file is loaded in the "ARB" dialog box. 

4. Select “Arbitrary Waveform>State>ON”. 

The Ceyear 1466 plays waveform files. 

 How to Use Ceyear WinWavSIM to Create a Waveform File and Load It into ARB 

Below is an example of how to use the Ceyear WinWavSIM software to generate an 

LTE/LTE-A waveform and load it into the ARB of the Ceyear 1466. 

The workflow consists of three main steps, each described in separate procedure 

instructions: 

• Configure the connection between Ceyear WinWavSIM software and Ceyear 

1466 

• Generate a waveform file with the needed settings 

• Transfer waveform files to and play through the Ceyear 1466. 

 

 

Ceyear WinWavSIM software is a cross-platform desktop program running on PC. In 

Description 
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addition to supporting Ceyear 1466 series signal generators, it also supports other types 

of signal generators such as Ceyear1465/1435/1443/1451. This section only describes 

task-related settings and Ceyear WinWavSIM will not be involved. For more information 

on configuring and using Ceyear WinWavSIM, please refer to the "User's Manual of 

Ceyear WinWavSIM". 

Configure the Ceyear 1466 as a target instrument in the Ceyear WinWavSIM 

software 

In this example, we assume that Ceyear WinWavSIM is installed on the PC. This PC 

is connected to the Ceyear 1466 via LAN. 

1. Connect the target instrument. 

On the main interface of the Ceyear WinWavSIM software, click the "Signal Source" 

block diagram to open the "Signal Source Configuration Window", and set the IP address 

and service port number of the target instrument (Ceyear 1466 series vector signal 

generator) in the "Network Settings" property page.Then click the "Connect" button to 

establish a connection with the target instrument. 

2. Generate and play a waveform file. 

In the main interface of Ceyear WinWavSIM software, click the "Baseband" block 

diagram to pop up the "Signal Simulation" menu, select the "LTE/LTE-A" menu item, and 

open the "LTE/LTE-Advanced" window, where you can configure signal simulation 

parameters. After setting the parameters, turn on the "LTE/LTE-A" switch, and the 

software will automatically generate and download the waveform file. After the download 

is completed, the software will automatically set the target instrument to start playing. 
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 How to Manually Create a Waveform File 

This section provides examples on how to create waveforms externally. Waveform 

files are created manually. 

 Rationale 

Digital modulation is the main way to realize complex signals, which has the 

advantages of large information capacity, high data confidentiality, high compatibility with 

digital equipment, and high communication quality. The implementation of complex 
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digitally modulated signals is I/Q modulation. Any instantaneous signal can be regarded 

as a vector, and there are two forms of expression: amplitude and phase in-phase 

component (I) and quadrature component (Q). In a digital modulation system, the signal 

vector is often expressed in the form of I/Q via I/Q modulator to modulate the amplitude 

and phase of the I and Q signals, and infinite phase cycles can be obtained by multiple 

modulations. 

 

The realization of IQ modulation, through the control of the I/Q signal voltage, 

completes the control of the amplitude and phase of the vector modulation signal, and the 

form of the I/Q signal determines the modulation form of the signal. 

 Custom *.bin waveform file 

*.bin waveform files are arbitrary waveform data files in binary format, with the 

suffix .bin. It is recommended that users choose this format first. Read and download 

speeds are faster. 

The format requirements for bin binary files generated by users are as follows: 

1) Data content requirements: binary files store I data and Q data, with I/Q data 

stored alternately (DA value). 

2) Data type requirements: the data types of I and Q data in binary files support 

integer type (2 bytes), with each I and Q data taking up 2 bytes (16 bits), i.e. each 

sampling point takes up 4 x 4 bytes. 

3) Data range requirements: ±(2^15-1) -32767~32767 

4) Arranged in small-end byte order. 

Users can generate binary arbitrary waveform files with the suffix .bin by their own 

system software according to actual needs and at a clock frequency of 250MHz. The 

following uses matlab software as an example to generate the .bin arbitrary waveform file 

of intrapulse LFM. 

%% Generate the LFM signal, 

clc; 

clear; 

Fda = 250.0e6; sampling rate of %%DA 

Fdev = 50.0e3; %% LFM offset 

Pulse_wid = 5.0e-3; %% pulse width 

Pulse_pri = 10.0e-3; %% pulse period 

DacBit = 16; %%DAC digits; 
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iMax = 2^(DacBit-1) -1; %% data range ±(2^15-1) 

PIM2 = 2.0*pi;  

Wid_Num = Pulse_wid * Fda;   

PRI_Num = Pulse_pri* Fda;    

iDletaFreq = Fdev/Wid_Num; 

iNum = 1:Wid_Num; 

iFreq =PIM2*(-Fdev/2.0 + iDletaFreq*iNum); 

idelta = cumsum(iFreq/Fda); 

iData = floor(iMax*cos(idelta)); 

qData = floor(iMax*sin(idelta)); 

iData = [iData,zeros(1,PRI_Num-Wid_Num)]; 

qData = [qData,zeros(1,PRI_Num-Wid_Num)]; 

IQdataBuff(1:2:2*PRI_Num)=iData; 

IQdataBuff(2:2:2*PRI_Num)=qData; 

fid = fopen('LFM.bin','w'); %% generate the binary arbitrary wave file of .bin 

fwrite(fid,IQdataBuff,'int16'); 

fclose(fid); 

If you run this program, you can get a LFM arbitrary waveform file named LFM and 

typed .bin. Copy the file to the instrument, load the file through the arbitrary waveform 

function of Ceyear 1466, and set the clock frequency to 250MHz to realize the generation 

of LFM signal. 

 Custom *.seg waveform files 

Seg format waveform file  

It is a waveform file customized by Ceyear with file header information. The size of file 

header is 16k bytes, including a fixed file header of 256 bytes (the manufacturer logo and 

basic information of the waveform segment, compatible with Ceyear1465/1435/1443 

products), and a file header extension area of 16k-256 bytes. After the file header is IQ 

data, the data format is 16-bit signed data stored alternately by IQ, and the data range is 

-32767~32767. 

The storage structure of the Seg file is shown in the figure below: 

1) The file header is 256 bytes. Compatible with the Seg file format of the original 

Ceyera 1465/1435/1443 products. Every 8 bytes (INT64) is classified as a storage unit. 
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Among them, the first byte (INT64) is the manufacturer logo, CEYEAR. The second 

byte (INT64) is the clockfrequency of the current arbitrary waveform file, stored in integer, 

and with the storage precision of mHz. For example, if the clock frequency of the 

generated arbitrary waveform file is 122.88MHz, the stored value is 122880000000. The 

third byte (INT64) is symbol length, the fourth byte (INT64) is the number of oversampling 

points, and the fifth byte (INT64) is the number of sampling points, all of which are integer 

values with a storage precision of 1. For user-defined arbitrary waveform files, the number 

of oversampling points is fixed and set to 1, with symbol length = number of sampling 

points. The sixth byte (INT64) is the period (playing time), that is, the playing time of the 

currently generated arbitrary waveform file according to the aforementioned sampling rate. 

It is stored as an integer at a storage precision of ns. For example, if the period is 1ms, the 

stored value is 1000000. When the partner generates the arbitrary waveform file, it needs 

to fill in the above table header data according to the generated arbitrary waveform file 

data. The eighth byte (INT64) is the file version number, corresponding to the version 

defined by the current Seg file format. Subsequent bytes are reserved. The ninth byte 

(INT64) is the initial offset of the IQ data. This value is a fixed value under the current file 

version. The default value is 16k (16*1024), and the unit is byte. The tenth byte (INT64) is 

the peak value of the generated IQ data, and the eleventh byte (INT64) is the mean value 

of the generated IQ data. 

The calculation method of the peak value is as follows: View the I and Q data to find 

the maximum value, MAX(I
2
+Q

2
). 

The calculation method of the average value is as follows: View the I and Q data, sum 

and divide by the number of sampling points, SUM (I
2
+Q

2
)/Length. 

IQ data is calculated from normalized data (floating point (single precision) (-1.0~1.0)). 

After calculation, it is multiplied by 10
9
, converted into INT64 and stored in the current 

location. 

2) After the file header (16k bytes), it is the definition of IQ data. 

Data content requirements: binary files store I data and Q data, with I/Q data stored 

alternately (DA value). 

Data type requirements: the data types of I and Q data in binary files support integer 

type (2 bytes), with each I and Q data taking up 2 bytes (16 bits), i.e. each sampling point 

takes up 4 x 4 bytes. 

Data range requirements: ±(2^15-1) -32767~32767 

Arranged in small end byte order. 

 How to define tag control information 

1) The file header starts from 256 bytes, which is Marker control information. 

A total of 4 Marker control information are included. The control information of each 
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Marker includes the Marker file header and Marker control data. Among them, the Marker 

file header is of a fixed size, equivalent to four 4 个 INT64, including the Marker type, the 

number of Marker sampling points, and the length of Marker control data (including the 

total length of the file header and control data, unit: byte). Marker control data is defined 

after the Marker file header. 4 markers are stored consecutively. After the file header and 

control data of Marker1 are stored, the file header and control data of Marker2, Marker3, 

and Marker4 will be stored successively. 

2) Definition of marker file header, fixed size, four 4 个 INT64, 32 bytes. 

Marker type: 0: Periodic Marker; 1: Custom Marker 

Marker sampling points: It is valid only when the Marker type is custom, otherwise the 

value is set to 0. 

Marker occupied data length: This value is the total length of the current Marker file 

header + Marker control data, unit: byte. 

3) Definition of marker control data: 

Marker control data records the high and low level changes of the Marker point. 

Starting from sampling point 0, only the Marker points with level changes are recorded. 

Each control data is sized at 64bit, 63bit~1bit is the marker point index, and 0bit indicates 

the state. 

The total number of Marker points should be less than or equal to the number of 

arbitrary waveform sampling points (the number of sampling points in the finally 

interpolated arbitrary waveform file). The marker is automatically played in a loop when 

the instrument is playing. When the number of Marker points is greater than the number of 

arbitrary waveform sampling points, the instrument will automatically cut off. When the 

Marker type is periodic, it is only necessary to define a periodic marker point change, and 

additionally record the state of the last Marker point within the period. 

Periodic Marker example: 

Example 1: Example of an equal-interval periodic Marker (Pulse): 

Index

Index 0+state 1 

Index 9+state 0 

Index 19+state 0 

Marker control data is as follows: 
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0

bit0bit63………………………………………………………………bit1

1

9 0

19 0

 

 

Example 2: Example of Marker (On/OFF Ratio) with unequal interval period: 

Index

Index 0+state 1 

Index 19+state 0 

Index 29+state 0 

Marker control data is as follows: 

0

bit0bit63………………………………………………………………bit1

1

19 0

29 0

 

Example 3:: Example of Marker (Pattern) with custom interval period: 

Index

Index 0+state 1 

Index 19+state 0 

Index 24+state 1 

Index 29+state 0 

Index 34+state 0 

Marker control data is as follows: 
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0

bit0bit63………………………………………………………………bit1

1

19 0

24 1

29 0

34 0

 

 

Example 4: Example of Marker (Pattern) with custom interval period: 

Index

Index 0+state 0 

Index 19+state 1 

Index 24+state 0 

Index 29+state 1 

Index 34+state 0 

Index 39+state 0 

Marker control data is as follows: 

0

bit0bit63………………………………………………………………bit1

0

19 1

24 0

29 1

34 0

39 0

 

 

When the Marker type is custom, you need to define the change of the Marker points, 

and you also need to set the custom Marker sampling points in the Marker file header. 
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Example 5: Example of custom type Marker: 

Index  

Index 0+state 0 

Index 19+state 1 

Index 24+state 0 

Index 29+state 1 

Index 34+state 0 

Index 39+state 0 

Index 58+state 1 

Index 66+state 1 

Index 88+state 0 

Index 91+state 1 

Index 94+state 0 

Index 97+state 1 

Marker control data is as follows: 
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0

bit0bit63………………………………………………………………bit1

0

19 1

24 0

29 1

34 0

39 1

58 0

66 1

88 0

91 1

94 0

97 1

 

The total number of custom Marker points is 101, and it is also necessary to set the 

number of Marker sampling points to 101 in the corresponding Marker file header. 

For custom markers, the number of marker points is determined by the user. When 

the number of arbitrary waveform sampling points is greater than that of Marker points, 

the default output will be low level. When the number of arbitrary waveform sampling 

points is less than the number of Marker points, the Marker will automatically truncate 

during playback. 

Note that after filling the Marker control data, you need to set the total length of the 

current Marker in the corresponding Marker header (Marker file header + Marker control 

data length). 

Generate a sequence (multi-waveform segment) file 

Modern chip technology implements multiple communication standards within a 

single chip and presents special verification and testing requirements. To meet the 

requirements of these test systems and to enable fast alternation between different 

waveforms with different test signals, the Ceyear 1466 provides the function to generate 

(sequence) multi-waveform segment files. 

This section introduces the concept of sequence files, along with explanations of the 

provided settings and some typical configuration examples. 

Content 
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• Required Options 

• About Sequence Files 

• Create Sequence 

 

Required Options 

The generated sequence file needs to include the corresponding software option 

(Ceyear 1466 S07). 

About Sequence Files 

A sequence file is a composite signal that contains multiple independent waveform 

segments. Each waveform segment is an independent waveform that can be output by 

using its own markers and clock settings. 

The figure below shows the principle of constructing multi-segment waveforms 

(sequences). 

 

Content 

• Sequence Playback Processing 

• Sequence Playback Control 

• Sequence Related Files 

 Sequence Playback Processing 

The processing of sequence files is triggered by the "Create" or "Create and Load" 

functions. In order to process sequence waveforms, the instrument loads multiple 

waveform segment files into memory. Therefore, it is possible to alternate between 

different waveform segments without delay due to loading. You can define the output 

order of segments and the segments to be output at any given time. 

After the sequence file is loaded, information about clock rate, number of sampling 

points, and creation date can be displayed for multiple waveform segments in the 

sequence. You can click the "Waveform Information" button to obtain information about 

waveform segments. 

 Sequence play control 

file:///C:/Users/wangpeng-yi/AppData/Roaming/Microsoft/Word/bfc465e3753c4e98.htm
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If a high switching speed is required, external triggers or predefined "playlists" can be 

applied to continuously scroll through the test signals. Ceyear 1466 provides the 

possibility of controlling the playback of different waveform segments, determining 

whether a waveform segment should be played once or repeated several times, and 

adjusting the transition between waveform segments. 

For correct and fast processing and seamless conversion between multiple waveform 

segments, multiple waveform segments need to have the same clock frequency. If 

multiple waveform segments have different clock frequencies, they must be adapted to 

the same clock rate through resampling. 

 Sequence related documents 

To provide flexible configuration, the construction of multi-waveform segment files 

involves different stages; Create and store a sequence file that involves the following files: 

• Configuration file: It is a dedicated file that contains detailed information on 

different waveform segment definitions, sorting, clock rate settings, and file names. The 

file extension is *.seqcfg.  

You can save the current configuration or load the last configuration file to continue editing 

based on it. 

• Output file: It is an output sequence file created. Ceyear 1466 stores it in the 

default directory with a file extension of *.seq. 

• Sorted List: It is a file created in the "Play Control>Play Mode: Sequence 

Play>Play Sequence" dialog box. The sorted list file has the extension *.seqctl and is 

automatically assigned to the sequence file, but is independent of the sequence file. By 

default, these two files have the same name and are located in the same file directory. You 

can create multiple sorted list files for each sequence file.  

The sorted list file only contains information about the waveform index, and the 

corresponding waveform file name can be retrieved from the assigned sequence file. That 

is to say, the same sorted list file can be reused for different sequence files with the same 

number of waveform segments.  

Changing and recalculating the sequence file will result in re-checking whether the 

assigned sorted list file is still valid. A message will be displayed informing you of the 

necessary corrections in the Sorted List. 

Create sequence 

Access: 

1. Select “Baseband>Arbitrary Waveform>Create Sequence”. 
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The Create Sequence dialog box allows you to combine multiple waveform segments 

into a sequence, adjust the clock, level and marker settings for the combined waveform, 

and select an output file. 

2. Select “Baseband>Arbitrary Waveform>Create Sequence”. “Create and Load 

Sequence File” to store and load the current sequence file. 

3. Select "Baseband >Arbitrary Waveform”. 

“Load Arbitrary Waveform” to confirm that the current sequence file has been loaded 

(the file name is defined as "output file"). 

Content 

• Sequence Storage and Output Settings 

• Sequence List Edit 

• Clock/Marker Settings 

 Sequence Storage and Output Settings 

Access: 

1. Select “Baseband>Arbitrary Waveform>Create Sequence>General”. 

2. Perform one of the following operations: 

• Select “New Sequence” to start a new sequence list editing 

• Select “Load List” to load an existing configuration file 

• Select “Save List” to save the current sequence list as a configuration file 

3. Select “Save File” and enter a file name to define the configuration file name. 

Setting: 

└  Create Sequence 

└ Select Sequence 

└ Save Sequence 

└ Create Sequence File 

└ Create and Load Sequence File 

 Create Sequence 

Clear the original sequence editing list and start a new sequence editing. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:RESet 
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 Select Sequence 

Select the previously stored sequence configuration file from the “File Selection” 

dialog box. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:SELect 

  

 Save Sequence 

Save the configuration of the current sequence in a configuration file, including the 

settings for the waveform segment in the sequence, clock mode, marker mode, and 

output file name. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:STORe 

 

 Create Sequence File 

Generate a sequence file with the specified file name at the specified location through 

the "File Selection" dialog box. Depending on the configuration of the sequence, the 

calculation may take some time. Use the 'Cancel' function to interrupt calculations. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CREate 

 

 Create and Load Sequence File 

Generate a sequence file with the specified file name at the specified location through 

the "File Selection" dialog box and immediately use it as output. Depending on the 

configuration of the sequence, the calculation may take some time. Use the 'Cancel' 

function to interrupt calculations. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CLOad 

 

 Sequence List Edit 

 

Setting: 
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└ Add Waveform Segments 

└ Delete Current Waveform Segment 

└ Delete All Waveform Segments 

└ Shift Up/Down 

 Add Waveform Segments 

Open the “File Selection” dialog box for navigating and selecting waveform segment 

files to be added to the end of the existing list. Only waveform segment files in *.seg 

format can be loaded. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:APPend 

 Delete Current Waveform Segment 

Delete the waveform segment of the currently selected row from the table. The 

waveform segment file in the instrument will not be deleted. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:DELete 

 Delete All Waveform Segments 

Delete all waveform segments from the table. The waveform segment file in the 

instrument will not be deleted. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CONFigure:RESet 

 Shift Up/Down 

Sort and rearrange waveform segments by shifting them up/down. 

 Clock/marker setting 

 

Setting: 

└ Clock Type 

└ Clock Frequency 

└ Waveform Segment Marker 

└ Sequence Start Marker 
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└ Waveform Segment Start Marker 

 Clock Type 

The method of determining the clock frequency for each of the multiple waveform 

segments in the generated sequence. 

“Unchanged” Each waveform segment is output at the clock rate defined in the 

waveform segment file. 

“Maximum” All waveform segments are output at the highest available clock rate. 

Note: The calculation time will increase as each segment has been 

resampled. 

“Custom” All waveform segments are output at the clock rate defined by the 

parameter “Clock Frequency”. 

 

The calculation time will increase as each segment has been resampled. 

 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:CLOCk 

 

 Clock frequency 

Define the sampling rate used for multi-waveform segment output, which is valid 

when the clock type is selected in "Custom" mode. 

Remote command:  

[:SOURce[1]|2]:RADio:ARB:SEQuence:CLOCk:RATE 

 

 Waveform Segment Marker 

Define how to process the original marker information for each waveform segment. 

“Ignore” Do not consider the marker information carried in a single waveform segment 

file. 

“Play” The output sequence file contains the marker information configured in each 

waveform segment file. 

Remote command: 

Notice 
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[:SOURce[1]|2]:RADio:ARB:SEQuence:MARKer:MODE 

 

 Sequence Start Marker 

Enable/disable the generation of additional restart markers in the output sequence 

file. 

“Ignore” No additional markers will be generated. 

"Markers 1, 2, 

3/4” 

Use markers 1/2/34 to generate a restart marker signal at the beginning 

of the first segment of the entire sequence. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:MARKer:STARt 

 

 Waveform Segment Start Marker 

Enable/disable the generation of additional restart markers in the output waveform 

segment file. 

“Ignore” No additional markers will be generated. 

"Markers 1, 2, 3, 

4” 

Generate a restart marker signal at the beginning of each waveform 

segment. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:SEQuence:MARKer:ESEGment 

 

Generate Multi-carrier Signal 

To simulate complex multi-carrier scenarios with different modulation formats, Ceyear 

1466 provides the possibility of generating multi-carrier waveforms. These waveforms can 

be composed of up to 512 carriers, each of which can choose a different signal 

modulation mode. 

Multi-carrier waveform is a practical solution for generating complex broadband 

signals, and the multi-carrier generation function of Ceyear 1466 makes it easy to 

construct complex signal scenarios. With the support of broadband and large modulation 

bandwidth, the use of multi-carrier generation function can meet the needs of a single 

instrument to generate complex signal scenarios.  

Content 

• Required Options 



Operation Signal Generator 

Configuration of Internal Baseband Source (All) 

 

• About Multi-carrier Waveforms 

• Multi-carrier Settings 

• How to Use Multi-carrier Function 

Required Options 

The multi-carrier waveform file needs to include the corresponding software option 

(Ceyear 1466 S08). 

About Multi-carrier Waveforms 

Multi-carrier waveform is the broadband test signal required for receiver testing. The 

multi-carrier waveform generation function can be used to create complex multi-carrier 

scenarios that are composed of signals from different digital standards and required for 

these tests. 

Since multi-carrier waveforms are processed by an arbitrary waveform generator, a 

combined waveform file must be created before it can be loaded into an arbitrary 

waveform for playback. Ceyear 1466 stores the multi-carrier waveform files created in a 

user-defined path, using the same file extension of *.seg. as regular waveform files. The 

instrument stores additional information in the header of the combined waveform file. After 

the created waveform is loaded, information about clock rate, number of sampling points, 

and creation date will be displayed. 

General Principles for Composing Multi-carrier Signals 

The following are the general principles for composing multi-carrier signals: 

• In default mode, there are up to 512 equally spaced carriers centered around the 

RF point.  

The carrier spacing can be adjusted within the available bandwidth. The total modulation 

bandwidth of the composed multi-carrier signal shall not exceed the available modulation 

bandwidth of the instrument (refer to datasheet). 

• Each carrier can be configured with parameters such as gain, phase, and 

modulation waveform. 

• Peak-to-average ratio optimization can be applied. 

• After all the multi-carrier processing steps are completed, the instrument will 

calculate the peak and RMS power of the total signal. The values are then written to the 

waveform file header. 

Content 

• Define Carrier Frequency 
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• Optimize Peak-to-average ratio 

 Define carrier wave frequency 

There are two methods to define the carrier frequency of each carrier in a 

multi-carrier signal: 

• Enable custom intervals to specify the carrier frequency of each carrier 

individually. 

Use equal interval assignment function. Make the carriers to be equally spaced and 

centered around the RF point. The carrier frequency is automatically calculated based on 

the number of selected carriers and the  carrier spacing. 

 Optimize Peak-to-average ratio 

Ceyear 1466 will optimize the peak-to-average ratio based on the following 

configured parameters: 

• Peak-to-average ratio optimization mode: Determine whether the phase can be 

set or internally calculated to meet the requirements of peak-to-average ratio. 

• Clipping: Reduce the peak power of the generated multi-carrier signal 

according to the input parameter "Target Peak-to-Average Ratio” 

The peak power after clipping is the sum of the RMS power of the unclipped 

multi-carrier signal and the parameter "Target Peak-to-Average Ratio”.   

Due to the fact that clipping also reduces RMS power, the peak-to-average ratio of the 

clipped signal will be slightly higher than the "Target Peak-to-Average Ratio”. 

• Target peak-to-average ratio: Determine the target peak-to-average ratio. It 

does not work when the target peak-to-average ratio is higher than the peak-to-average 

ratio of the unclipped multi-carrier signal. 

Multi-carrier Settings 

Access: 

 Select “Baseband>Arbitrary Waveform>Create Multi-carrier”. 

The multi-carrier configuration dialog box is divided into multiple property pages. 

Among them, the "General" attribute page allows to configure some common parameters 

required for multi-carrier generation, the "Multi-carrier List" property page allows to 

configure the parameters of each carrier, and the "Carrier Graph" property page allows to 

view the relative distribution of each carrier signal. 

Content 

• Common settings 
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• Multi-carrier List 

• Carrier Table Auto Fill 

• Carrier Pattern 

• How to Use Multi-carrier Function 

 Common settings 

This attribute page allows to configure some common parameters required for 

multi-carrier generation. 

Setting: 

└ Create New Multi-carrier 

└ Load Multi-carrier 

└ Save Multi-carrier 

└Create output file 

└Create and load output file 

└Output file name 

└ Spacing Mode 

└ Number of Carriers 

└Carrier spacing 

└ Peak-to-Average Ratio Mode 

└ Target Peak-to-Average Ratio 

└ Signal Period Mode 

└ Signal Period 

└Power reference 

 Create Multi-carrier 

Clear the original multi-carrier editing list and start a new multi-carrier editing. t 

 Load Multi-carrier 

Select the previously stored multi-carrier configuration file (*.mcarcfg) from the “File 

Selection” dialog box. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CONFigure:LOAD 
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 Save Multi-carrier 

Save the current multi-carrier configuration in the configuration file, including the 

number of carriers in the multi-carrier, carrier spacing, signal period mode, carrier 

configuration, etc. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CONFigure:STORe 

 

 Create output file 

Generate a multi-carrier file with the specified file name at the specified location 

through the "File Selection" dialog box. Depending on the configuration of the multi-carrier, 

the calculation may take some time. Use the 'Cancel' function to interrupt calculations. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:WAVeform:CREate 

 

 Create and load the output file 

Generate a multi-carrier file with the specified file name at the specified location 

through the "File Selection" dialog box and immediately use it as output. Depending on 

the configuration of the multi-carrier, the calculation may take some time. Use the 'Cancel' 

function to interrupt calculations. 

Remote command:  

[:SOURce[1]|2]:RADio:ARB:MCARrier:WAVeform:CLOad 

 

 Output file name 

Define the name of the output multi-carrier file through the "File Selection" dialog box. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:WAVeform:CREate 

 

 Spacing Mode 

Selects how the carriers are distributed within the available bandwidth. 

"Equal 

Spacing” 

Set the carrier spacing as equal spacing, which means the carriers are 

equally spaced and centered around the RF point. The carrier frequency is 
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automatically calculated based on the number of selected carriers and the  

carrier spacing. 

"Custom 

Spacing" 

The frequency offset of each carrier can be specified separately. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier:MODE 

 

 Number of Carriers 

Set the number of carriers for multi-carrier waveforms. By default, the multi-carrier 

table has a default carrier. Up to 512 carriers can be configured and activated. 

When the number of carriers increases, a new row will be added at the end of the 

table. The carrier frequency offset of the new row is related to the carrier spacing mode, 

and other parameters are set to the default configuration. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier:COUNt 

 

 Carrier spacing 

Set the frequency spacing between adjacent carriers, which only takes effect when 

the spacing mode is equal spacing. 

The maximum carrier spacing is limited to: 

“Maximum carrier spacing"=baseband bandwidth/("number of carriers"-1). 

The baseband bandwidth depends on the installed options (refer to datasheet). 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier:SPACing 

 

 Peak-to-Average Ratio Mode 

Set the mode for peak-to-average ratio optimization through carrier phase 

combination. The following modes are available: 

“OFF” Calculations are performed using the phase set by the user in the 

multi-carrier list, with no optimization process. 

"Minimize” Minimize the peak-to-average ratio by internally calculating the phase 

combination of multi-carrier. The phase settings shown in the multi-carrier 



Operation Signal Generator 

Configuration of Internal Baseband Source 

187 
 

list are not valid. 

"Maximize” Maximize the peak-to-average ratio by internally calculating the phase 

combination of multi-carrier. The phase settings shown in the multi-carrier 

list are not valid. 

 Target Peak-to-Average Ratio 

Set the value of the target peak-to-average ratio, which only takes effect when the 

clipping ON/OFF state is set to ON. 

This value does not work when the target peak-to-average ratio is higher than the 

peak-to-average ratio of the unclipped multi-carrier signal. 

 Signal Period Mode 

Define the period mode for generating multi-carrier signals. 

The following modes are available: 

“Maximum 

carrier period” 

Use the maximum I/Q signal period in the carrier table as the period 

for generating the final multi-carrier signal. Shorter I/Q signals will be 

repeated up to that period length. 

“Minimum carrier 

period” 

Use the minimum I/Q signal period in the carrier table as the period for 

generating the final multi-carrier signal. Longer I/Q signals will only 

use the beginning portion of that period length. 

“Custom” The signal period is manually set. Shorter I/Q signals will be repeated 

up to that period length, while longer I/Q signals will only use the 

beginning portion of that period length. 

“Least common 

multiple” 

The output file period is the least common multiple of the I/Q signal 

periods in all carrier tables. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:PERiod:MODE 

 

 Signal Period 

It takes effect when the signal period mode is set to “Custom”. Set the signal period 

so that shorter I/Q signals will be repeated up to that period length, while longer I/Q 

signals will only use the beginning portion of that period length. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:PERiod 

 

 Power reference 
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Set the level reference mode between individual carriers in the synthesized 

multi-carrier signal. If signals with different peak-to-average ratios are synthesized into 

multi-carrier signals, there will be significant differences in the multi-carrier signals 

generated by the two modes. 

 

“Rms” Each carrier is adjusted according to its RMS power and the "Gain" 

configured in the multi-carrier list. 

For example: 

A multi-carrier signal consists of two waveform files. 

First carrier "Gain"=0 dB 

Second carrier "Gain"=-3 dB 

In the resulting multi-carrier signal, the RMS power of the second carrier 

signal is 3 dB lower than that of the first carrier signal.  

“Peak” Each carrier is adjusted according to its peak power and the "Gain" 

configured in the multi-carrier list. 

For example: 

A multi-carrier signal consists of two waveform files. 

First carrier "Gain"=0 dB 

Second carrier "Gain"=-3 dB 

In the resulting multi-carrier signal, the peak power of the second carrier 

signal is 3 dB lower than that of the first carrier signal. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:POWer:REFerence 

 

 Multi-carrier List Settings 

Use the "Multi-carrier List" property page to configure the parameters of each carrier. 

Setting: 

└ Number of Carriers 

└State 

└ Frequency Offset [MHz] 

└Gain [dB] 

└ Phase [deg] 

└ Delay [ns] 
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└File name 

└Information 

└Mark 

 Number of Carriers 

Define the number of carriers for multi-carrier. 

This parameter is the same as the parameter in the "General Settings". After setting, 

the multi-carrier list will be automatically filled with the number of carriers set, and each 

carrier will be set as a single tone to act as the modulation signal by default. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier:COUNt 

 

 Status 

Turn on/off carrier. 

Remote command:  

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:STATe 

 

 Frequency Offset [MHz] 

Set carrier frequency offset. 

Notice: The carrier frequency offset can only be set in the "Custom Spacing" mode. 

For "Equal Spacing" mode, the carrier frequency offset is determined automatically. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:FREQuency 

 

 Gain[dB] 

Set the gain of the carrier. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:POWer 

 

 Phase [deg] 

Set the start phase of the carrier. 
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Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:PHASe 

 

 Delay [ns] 

Set the delay time of the carrier. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:DELay 

 

 Document title 

Select the modulation waveform file for the subcarrier through the "File Selection" 

dialog box. The default subcarrier file is a single tone signal file. Only files in *.seg format 

that are defined by Ceyear are supported. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:WAVeform 

 

 Information 

Indicates parameters such as clock rate, number of I/Q data sampling points, and 

signal period for the selected waveform file. 

 

 Labeling 

Indicates the occurrence of a conflict by means of an exclamation mark. When the 

bandwidth occupied by the subcarrier modulation waveform overlaps, a conflict markee 

will be given. It should be noted that the bandwidth overlap of the subcarriers is estimated 

according to the modulation waveform sampling rate, which may be inconsistent with the 

actual situation. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier[1]|2--512:CONFlict? 

 

 Carrier Table Auto Fill 

Access: 

Select “Baseband>Arbitrary Waveform>Multi-carrier List>Carrier Table Auto Fill”. 
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 The 'Carrier Table Auto Fill' dialog box allows configuration of selectable subcarriers. 

Provide convenient and fast settings in bulk. 

Setting: 

└ Number of Carriers 

└Start Index/End Index 

└Gain Start Value 

└Gain Step Value 

└Phase Start Value 

└Phase Step Value 

└Delay Start Value 

└Delay Step Value 

└Select Waveform File 

└Configuration application 

 Number of Carriers 

Define the number of carriers for multi-carrier. 

This parameter is the same as the parameter in the "General Settings". After setting, 

the multi-carrier list will be automatically filled with the number of carriers set, and each 

carrier will be set as a single tone to act as the modulation signal by default. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:CARRier:COUNt 

 

 Start Index/End Index 

Define the start/end index of the carrier to which the auto fill setting is to be applied. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:START 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:STOP 

 

 Gain Start Value 

Set the gain start value for automatically filling subcarriers within the start and end 

indexes. 

Remote command: 
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[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:POWer:START 

 

 Gain Step Value 

Set the gain step value of carrier. 

The carrier gain obtained in the carrier table is equal to: 

Gain = "Gain Start Value" + n*"Gain Step". 

Where n is a value between 0 and ("End Index" - "Start Index"). 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:POWer:STEP 

 

 Phase Start Value 

Set the phase start value for automatically filling subcarriers within the start and end 

indexes. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:PHASe:STARt 

 

 Phase Step Value 

Set the phase step value of carrier. 

The phase obtained in the carrier table is equal to: 

Phase = "Start Phase" + n*"Phase Step” 

Where n is a value between 0 and ("End Index" - "Start Index"). 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:PHASe:STEP 

 

 Delay Start Value 

Set the delay start value for automatically filling subcarriers within the start and end 

indexes. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:DELay:STARt 

 



Operation Signal Generator 

Configuration of Internal Baseband Source 

193 
 

 Delay Step Value 

Set the delay step value of carrier. 

The delay obtained in the carrier table is equal to: 

Delay="Delay Start"+n*“Delay Step”, 

Where n is a value between 0 and ("End Index" - "Start Index"). 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:DELay:STEP 

 

 Select Waveform File 

Select a subcarrier file through the “File Selection” dialog box. Configure this file to all 

carriers from the start index to the end index. The default subcarrier file is a single tone 

signal file. Only files in *.seg format that are defined by Ceyear are supported. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:WAVeform 

 

 Configuration application 

Set the auto fill configuration to the carrier table. 

Remote command: 

[:SOURce[1]|2]:RADio:ARB:MCARrier:EDIT:CARRier:EXECute 

 

 Carrier Pattern 

The carrier pattern is a display of the frequency domain distribution of each carrier 

signal in the current multi-carrier list. 

The height of the bar corresponds to the gain of each carrier. The width of bar 

represents the relative bandwidth of the carrier signal, which is estimated according to the 

clock frequency of the modulation waveform and may differ from the actual bandwidth of 

the waveform. 

How to Use Multi-carrier Function 

This section provides step-by-step instructions on how to configure and use 

multi-carrier settings. 
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Create a multi-carrier waveform file to generate multi-carrier signals for 

standard transmitter testing. 

Perform the following routine steps: 

1. Define and generate a carrier file. Carrier files with different symbol rates and 

modulation formats can be generated through the custom waveform segment function of 

1466; Users program customized carrier files of special formats (subject to the format 

requirements of arbitrary waveform file in 1466) 

2. Configure the carrier table, and click "Create Multi-Carrier" button to open the 

“Create Multi-Carrier” window. Select "Custom Spacing". The number of carriers is set to 

4. The signal period mode is set to the longest carrier period. 

3. Select the "Multi-Carrier List" property page to open the Multi-Carrier List Edit 

window. Select four carrier files, namely QPSK format digital modulation signal (4MSps 

symbol rate), 5G NR signal (FR1, FDD_10MHz), single tone signal, and WIFI6 signal 

(IEEE 802.11ax, HE_SU_20MHz). Set the relative frequency offset values of four carriers. 

Set the ON/OFF state of the four carriers to ON. 

4. Open the carrier pattern property page to view the spectrum distribution of multiple 

carriers. 

5. On the General attributes page, click the "Create and Load Output File" button, and 

the instrument will automatically generate a multi-carrier file and play it. 

Generate Continuous Wave Multi-tone Signal 

Required Options 

It needs to include the corresponding software option (Ceyear 1466 S02) 

About Continuous Wave Multi-tone Signal 

Ceyear 1466 can calculate and generate multi-carrier continuous wave signal 

construction for up to 65535 unmodulated carriers. Carrier offsets and power levels of the 

carriers can be defined by the user. Each carrier can be configured separately. Initial 

phase settings are provided to optimize the peak factor. 

Continuous wave multi-tone signals are not generated in real-time, but are calculated 

and downloaded in arbitrary waveform mode. 

The continuous wave multi-tone signals are commonly applied in receiver testing by 

using broadband test signals. 

Multi-tone Settings 
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Content 

• Basic settings 

• Multi-tone Table Edit 

• Trigger mode 

 

 Base Config 

Access: 

 Select the "Baseband>Multi-tone Modulation". 

Setting: 

└Multitone modulation ON/OFF 

└Number of Tones 

└Frequency spacing 

└Initial phase position (Fixed/Random) 

└Initial Phase 

└Phase Relationship between Tones 

└ Peak-to-Average Ratio Mode 

└Expected Peak-to-Average Ratio 

 Multitone modulation ON/OFF 

Turn on/off multi-tone modulation. 

Turning on this option will make all other digital modulation modes in the RF channel 

where it is located to be turned off. 

Multi-tone signals are calculated as arbitrary waveforms and automatically 

downloaded to the arbitrary waveform generator for playback. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB[:STATe] 

 

 Number of Tones 

Set the number of tones that make up the multi-tone signal. 

Notice: There is a relationship between the bandwidth occupied by multi-tone signals, 

frequency intervals and the number of tones. The bandwidth occupied by a multi-tone 
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signal is calculated as follows: occupied bandwidth=("number of tones" -1)*"frequency 

interval”. 

The bandwidth occupied by multi-tone signals shall not exceed the modulation bandwidth 

of the instrument. 

By default, the multi-tone table lists two preset tones: "State=ON", "Power Gain=0 

dB", and "Phase=0°". 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:NTONes 

 

 Spacing of frequency 

Set the spacing between tones of a multi-tone signal. The tones are arranged 

symmetrically around the RF point. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:FSPacing 

 

 Initial phase position (Fixed/Random) 

Set the initial phase type for each tone. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:PHASe:INITialize 

 

 Initial phase 

Effective when the initial phase type is fixed. At this point, set the initial phase value of 

each tone to this value. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:PHASe 

 

 Phase relationship between tones 

The phase relationship between multitone signal tones is set, including random and 

fixed modes. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:PHASe:INITialize:SEED 
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 Peak-to-average ratio optimization mode 

Set the peak-to-average ratio optimization mode. Automatically configure according 

to the selected mode when generating multi-tone signals. 

There are several modes available:  

“OFF” There is no peak-to-average ratio optimization, the multi-tone "phase" can be 

set, and the phase set by the user is used for waveform generation. 

“Quick” The peak-to-average ratio optimization is fast, the multi-tone "phase" cannot 

be set and the optimization speed is independent of the number of tones. If all 

tones are in the ON state and the power is exactly the same, a minimum 

peak-to-average ratio of less than 3dB can be obtained. If the above 

conditions are not met, the peak-to-average ratio will deteriorate. 

“Target” Multi-tone "phase" cannot be set, the desired peak-to-average ratio can be 

optimized according to the configuration optimization of tone, and the 

optimization time depends on the number of tones. The required 

peak-to-average ratio can be set through "target peak-to-average ratio". 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:CFACtor:MODE 

 

 Target Peak-to-Average Ratio 

When the peak-to-average ratio optimization mode is set to "target", the required 

peak-to-average ratio shall be set. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:CFACtor 

 

 Multiple-tone list editing 

Access: 

 Select the "Baseband>Multi-tone Modulation>Multi-tone Table Edit". 

Setting: 

└ Auto Edit 

└ Multi-tone Table 

 Auto Edit 
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Supports automatic configuration of tones within the selected range. 

└ Auto Edit Start Index/End Index 

└ Multi-tone Status 

└ Power Gain Start Value 

└ Power Gain Step Value 

└ Phase Start Value 

└ Phase Step Value 

└ Confirm Edit 

Auto Edit Start Index/End Index 

Define the start/end index of tones to which the auto edit configuration is to be 

applied. 

Multi-tone Status 

Set the status of the tones within the index range. 

Power Gain Start Value 

Set the start gain value o the tones within the index range. 

Power Gain Step Value 

Set the gain step value of the tones within the index range. 

The gain value of each tone is calculated as "power gain start value"+n * "power gain 

step". 

Phase Start Value 

If the “Peak-to-Average Ratio Optimization Mode” is OFF, set the start phase of the 

tones within the index range. 

Phase Step Value 

If the “Peak-to-Average Ratio Optimization Mode” is OFF, set the start phase step 

value of the tones within the index range. 

The phase of each tone is calculated as "phase start value"+n * "phase step value". 

Confirm Edit 

Automatically set the tones within the selected range in the multi-tone list using the 

parameters in “Auto Edit”. 

 Multi-tone Table 

Provide a table for setting tone parameters and storage/call of parameters. 
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└ Tone Parameter Table 

└Save as 

└ Load Multi-tone File 

└ Apply and Load 

Tone Parameter Table 

The tone parameters in the multi-tone table will not be calculated immediately after 

being modified. You must click "Apply and Load" before they can be calculated and 

generated. Whenever the multi-tone table is modified without calculation and generation, 

the "Apply and Load" button will display a reminder in the form of animation. 

Notice: The phase (deg) setting is only effective when the peak-to-average ratio 

optimization mode is turned off. 

“SN” Display tone number, non editable 

“Frequency Offset 

(MHz)” 

The frequency offset of a tone relative to the carrier wave. 

Automatic calculation, non editable 

“Power Gain (dB)” Set the power of the tone. 

You can use “Auto Edit” to fill in this parameter. 

“Phase (deg)” Set the start phase of the tone. 

You can use “Auto Edit” to fill in this parameter. 

“Status” To set the tone ON/OFF status. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:TABLe:ROW 

 

Save as 

Store the parameters in the tone parameter table as a configuration file, which can be 

easily called when the same parameter configuration is needed, simplifying the parameter 

setting process. 

Remote command: 

[:SOURce[1]|2]:RADio:MTONe:ARB:SETup:STORe 

 

Load Multi-tone File 

Load the tone parameters from the configuration file into the configuration table to 

simplify the parameter setting process. 

Remote command: 
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[:SOURce[1]|2]:RADio:MTONe:ARB:SETup 

 

Apply and Load 

It is used to recalculate and generate a multi-tone signal using the latest parameters 

after the tone parameter table is modified, and load it into any waveform generator for 

playback. 

 Trigger mode 

Access: 

► Select "Baseband>Multi-tone Modulation>Trigger Mode". 

This property page provides access to the settings needed to select and configure a 

trigger (such as trigger source and mode). Information about the current trigger mode is 

displayed in the title of the property page. The triggering settings for continuous wave 

multi-tone signals are the same as those for arbitrary wave function, and the menu is 

consistent. Please refer to the instructions for triggering settings for arbitrary wave 

function (ARB). Notice: The trigger function menu for arbitrary wave function and 

continuous wave multi-tone is linked. 

How to Generate Continuous Wave Multi-tone Signal 

This section provides step-by-step instructions on how to configure and use 

continuous wave multi-tone settings. 

Generate continuous wave multi-tone signals to generate broadband test 

signals for the transmitter. 

Perform the following routine steps: 

• Open the "Basic Settings" attribute page, configure the number of tones to 51, 

frequency interval to 5kHz, and peak-to-average ratio optimization mode to be fast as follows: 
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• Open the "Multi-tone Table Edit" attribute page to configure the parameters for each 

tone. The default parameters are used here, as follows: 

 

• Open the "Trigger Mode" attribute page and use the default trigger settings. 

• Open the multi-tone modulation switch in the "Basic Configuration" attribute page to 

generate multi-tone modulation waveforms and automatically download them to any waveform 

generator for playback.  
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Generate Intra-pulse Modulation Signal 

Required Options 

It needs to include the corresponding software option (Ceyear 1466 S03) 

About Intra-pulse Modulation Signal 

Ceyear 1466 can generate various types of intra-pulse modulation signals, including 

intra-pulse frequency modulation, intra-pulse phase modulation, and other different forms 

of modulation signals. There are a total of 13 modulation styles available, covering 

common intra-pulse modulation styles. According to the selected modulation style, 

different modulation configuration parameters are provided, which are combined with the 

configuration of pulse width and pulse period to facilitate user settings. The common 

application fields of intra-pulse modulation signals are radar testing and the construction 

of complex electromagnetic signal environments. 

Select the "Baseband>Intra-pulse Modulation" option. 

Setting: 

└ Intra-pulse Modulation ON/OFF 

└ Internal Modulation Type 

└Pulse width 

└Cycle 
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└ Modulation Bandwidth 

└ FM Direction 

└ Buck Code 

└ PM Code Type 

└ Sequence Length 

└ Number of Symbols 

└Freq offset 

 Intrapulse modulation ON/OFF 

Turn on/off intra-pulse modulation. 

Turning on this option will make all other digital modulation modes in the RF channel 

where it is located to be turned off. At the same time, the pulse modulation of the RF 

channel will be turned on. 

Remote command: 

SOURce[1]|2]:PWM:STATe 

 

 Intra-pulse modulation type 

Select a specific intra-pulse modulation style, as shown in the figure. The intra-pulse 

modulation styles include linear frequency modulation, triangular frequency modulation, 

cosine quartic frequency modulation, raised cosine frequency modulation, Barker code, 

phase modulation code, and FSK modulation. When different modulation types are 

selected, the parameters that need to be configured will also vary. 
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Remote command: 

SOURce[1]|2]:PWM:TYPE 

 Pulse width 

Set the generated pulse width, where the pulse width set here is the same 

configuration item as the pulse width set in pulse modulation; When the pulse width on the 

pulse modulation interface is modified, the pulse width here will also change accordingly, 

and vice versa. 

Remote command: 

SOURce[1]|2]:PULM:INTernal:PWIDth 

 Period 

Set the generated pulse period, where the period set here is the same configuration 

item as the period set in pulse modulation; When the period on the pulse modulation 

interface is modified, the period here will also change accordingly, and vice versa. 

Remote command: 

SOURce[1]|2]:PULM:INTernal:PERiod 

 Modulation bandwidth 

Modulation bandwidth is used to set the bandwidth of the intra-pulse modulation 

signal. This configuration item is valid when the intra-pulse modulation type is linear 

frequency modulation, triangular frequency modulation, cosine quartic frequency 
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modulation, and raised cosine frequency modulation. The maximum modulation 

bandwidth of the signal depends on the modulation bandwidth option (H31) installed in the 

instrument 

 

Remote command: 

SOURce[1]|2]:PWM:BWIDth 

 

 Frequency modulation direction 

The frequency modulation direction is used to set the frequency change direction of 

the intra-pulse modulation signal. This configuration item is valid when the intra-pulse 

modulation type is linear frequency modulation, triangular frequency modulation, cosine 

quartic frequency modulation, and rising cosine frequency modulation. When the 

intra-pulse modulation type is linear frequency modulation, the parameters for the 

frequency modulation direction can be configured as "increase" and "decrease". When the 

frequency modulation direction is selected as "increase", the intra-pulse modulation 

frequency is from low to high, with a shape like "/". When the frequency modulation 

direction is selected as "decrease", the intra-pulse modulation frequency is from high to 

low, with a shape like "\". When the intra-pulse modulation type is triangular frequency 

modulation, the configurable parameters for the frequency modulation direction are "upper 

triangle" and "lower triangle". When the frequency modulation direction is selected as 

upper triangle, the variation style of the intra-pulse modulation frequency is "Λ". When the 

frequency modulation direction is selected as lower triangle, the variation style of the 

intra-pulse modulation frequency is "∨". When the intra-pulse modulation type is selected 

as cosine quartic frequency modulation or rising cosine frequency modulation, the 

frequency modulation direction can be configured with parameters of "up" and "down". 
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Remote command: 

SOURce[1]|2]:PWM:DIRection 

 Barker code 

The Barker code is used to select the number of symbols in Barker code of 

intra-pulse modulation. This configuration item is valid when the intra-pulse modulation 

type is Barker code. The number of symbols in Barker code includes six types: 2, 3, 4, 5, 7, 

and 11. 

 

Remote command: 

SOURce[1]|2]:PWM:BARKer:TYPE 

 Phase modulation code type 

The phase modulation code type is used to select different phase modulation codes. 

This configuration item is valid when the intra-pulse modulation type is phase modulation 

code. As shown in the figure, there are 7 types of phase modulation codes, including P1 

polyphase code, P2 polyphase code, P3 polyphase code, P4 polyphase code, Frank code, 

BPSK, and QPSK. 
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Remote command: 

SOURce[1]|2]:PWM:PPCM:TYPE 

 Sequence length 

Number of symbols used to configure intra-pulse modulation to phase modulation. 

Due to the fact that the number of symbols is equal to the square in some phase 

modulation codes, setting the symbols directly cannot guarantee that the number set is 

square. Therefore, a sequence length configuration item has been added. In this case, the 

sequence length is the square root of the number of symbols, which means that the 

number of symbols=sequence length * sequence length. In some phase modulation, the 

number of symbols equals the sequence length. 
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Remote command: 

SOURce[1]|2]:PWM:LENGth 

 Number of symbols 

The number of symbols represents the number of symbols in the intra-pulse 

modulation. This configuration item is visible when the intra pulse modulation type is 

phase modulation code or FSK, and this parameter is a display parameter that cannot be 

edited. The number of symbols is related to the sequence length value. 

Remote command: 

SOURce[1]|2]:PWM:SYMBols? 

 Freq Offset 

Frequency offset is used to set the frequency offset value of intra-pulse modulation. 

This configuration item is valid when the intra-pulse modulation type is FSK. The 

maximum value of frequency offset depends on the selected modulation bandwidth option 

(H31) 



Operation Signal Generator 

Configuration of Internal Baseband Source 

209 
 

 

Remote command: 

SOURce[1]|2]:PWM:FSK:DEViation 

Generate frequency hopping signal 

Required Options 

It needs to include the corresponding software option (Ceyear 1466 S09) 

About frequency hopping signals 

Ceyear 1466 can be edited to achieve the editing of frequency hopping signals. It has 

the functions of frequency hopping frequency set, frequency hopping points, hop-rate, and 

user-defined frequency hopping sequence code editing. 

It can achieve hopping function at any frequency point within the modulation 

bandwidth range. 

For different modulation bandwidth options (H31-500/2000), the range of frequency 

hopping frequency sets may vary. 

Frequency hopping settings 

Content 

• Basic settings 

• Frequency Hopping Table Editing 
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 Base Config 

Access: 

 Select "Baseband>Frequency Hopping". 

Setting: 

└Frequency hopping ON/OFF 

└Modulation ON/OFF 

└Data source selection 

└Code element rate 

└Frequency Hopping Signal Duty Cycle 

└Modulation Type Selection 

└Hop-rate 

└Frequency Hopping Encoding Method 

 Frequency Hopping ON/OFF 

Set frequency hopping signal output. When ON, the instrument will play the 

frequency points in the hopping frequency set list according to the hopping encoding 

settings. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:STATe 

 Modulation on/off 

Whether modulation is turned on at the frequency hopping point. It is OFF by default. 

When turned on, digital modulation is added to each frequency hopping point. The digital 

modulation type is set by the modulation type selection configuration item. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:MODulation[:STATe] 

 Data source selection 

Select the data source for the frequency hopping signal. Valid when the modulation 

switch is ON. The data source for each frequency hopping point is continuously 

modulated in repetitive cycle. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:DATA[:SOURce] 

 Code element rate 
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Set the data output symbol rate for each frequency hopping point. Valid when the 

modulation switch is ON. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:SRATe 

 Frequency Hopping Signal Duty Cycle 

Set the dwell time for each frequency hopping point. 100.00% by default, and the 

signal is continuously output within the hop-rate time range. 

Signal dwell time=1/hop-rate * duty cycle (s). 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:DUTY 

 Modulation type selection 

When the modulation switch is ON, set the modulation type for each frequency 

hopping point. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:MODulation:TYPE 

 Hop-rate 

Set the hop-rate of the frequency hopping signal. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:RATE 

 Frequency Hopping Encoding Method 

Set the hopping method for frequency hopping frequency concentration points. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:ENCoding[:TYPE] 

 Frequency hopping table editing 

Edit the frequency hopping table to edit the frequency hopping frequency set, 

including inserting, deleting, importing, etc. 

 

 Table editing 

The frequencies in the frequency set can be directly modified. The frequency hopping 

points can be edited directly by clicking on each row in the frequency set. The input 
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frequency hopping points will be automatically sorted. 

If the edited frequency range exceeds the maximum modulation bandwidth of the 

current instrument, clicking Apply and Load will result in a error prompt. 

 Index 

Quickly locate the frequency point. 

 Inserting frequency point 

Insert a new frequency point in the current row of the frequency set table.

 Append 

Insert a new frequency point at the end of the frequency set table. 

Remote command: 

[:SOURce[1]|2]:RADio:FHOPping:TABLe:APPend 

 Delete 

This includes deleting the current point and deleting all points. 

[:SOURce[1]|2]:RADio:FHOPping:TABLe:DELete 

[:SOURce[1]|2]:RADio:FHOPping:TABLe:CLEar 

 Auto fill 

pop up the AutoFill Configuration window to automatically fill the relevant 

configuration parameters for the frequency hopping frequency set. 

 Loading frequency hopping file 

Click to load the edited frequency hopping file. 

 Save as 

Save the currently saved frequency hopping file as a separate file. 

 Apply and Load 

After modifying the frequency set table, click this button to take effect. 

Fading, adding noise 

Standard test case scenarios typically require signals that are not "pure", but 

damaged or interfered with. To meet these requirements, Ceyear 1466 is equipped with a 

fading simulator and noise generator, providing functions based on digital I/Q signal 

fading and noise addition. 

This section introduces the following functions: 
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Content 

• Fading Simulation 

• Adding Noise to Signal 

Fading Simulation 

Required Options 

The fading simulation function needs to include corresponding software options 

(Ceyear 1466 S05). 

About fading simulation 

During the transmission of wireless communication signals in the air, there will be a 

phenomenon of fading. For example, obstacles such as buildings, mountain slopes, or 

trees may absorb or reflect signals, which can have a significant impact on the amplitude 

and phase. Due to the effects of emission, diffraction, and local scattering, multiple signal 

transmission paths may be formed between the transmitter and receiver, which is known 

as multipath transmission. The fading simulator can quickly and low-cost build real-world 

testing scenarios, and can repeatedly detect the actual performance of receivers before 

expensive on-site testing. This function allows you to overlay real-time fading on the 

output signal of the baseband module, and can configure up to 20 fading paths. 

Access: 

 In the main interface signal flow graph, click "Fading". The Fading Configuration 

dialog box will open, displaying the provided basic settings, path settings, path graphics, 

etc. 

 

Overview of functions provided by fading simulator 

 

Flexible configuration, supporting different testing scenarios 

You can configure different testing schemes based on the provided 20 fading paths. 

Predefined fading schemes 

The fading simulator is equipped with various presets based on testing specifications 

of major mobile radio standards. For more complex testing, all parameters of the fading 

configuration can be defined by the user as needed. 

Graphic representation 
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The path map displays the currently defined fading path and supports configuring the 

required fading channels. 

Simulating various fading effects 

Various fading effects occur during the transmission of signals from the transmitter to 

the receiver. In a fading simulator, these effects can be simulated individually or in 

combination. 

Using a fading configuration, up to 20 fading paths with different delays can be 

defined. 

Simulating slow fading effects 

Support "lognormal" fading simulation, suitable for simulating slow horizontal 

changes that may occur due to shadow effects (such as tunnels, building blocks, or hills). 

Definition of commonly used terms 

 

Wireless channel modeling 

The theoretical model of wireless transmission channel is shown in the following 

figure. The transmitted signal undergoes random fading of the channel, 

superimposes noise and interference, and reaches the receiver. At this point, the 

received signal can be represented as 

( ) ( ) ( ) ( )y t s t h t n t                           (0.1) 

Among them, ( ), ( )s t y t respectively represents the waveform of the transmitted 

signal and the received signal; ( )h t  indicates time-varying fading of the channel, 

including factors such as transmission loss, shadow fading, and multipath fading; 
( )n t  represents equivalent channel noise and interference. 

Fading

H

Input

Noise

Output

 

Common channel fading includes the following: 

 Pure Doppler 
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Among them, 
( )p 

represents the Probability Density Function (PDF), 

 Rician 
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Among them, A is the amplitude of the line of sight transmission component and 

0
( )I 

 is the zero order corrected Bessel function. 

 Lognormal 
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Among them, 
,m 

correspond to the standard deviation and regional mean of 

shadow fading, with a standard deviation range of 0-12dB. 

 Rayleigh+Lognormal (Suzuki) 

( ) ( ) ( )t t t     

Among them, ( )t represents a lognormal process and is independent of the 

Rayleigh process ( )t , therefore 
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Dynamic Channel Model 

In dynamic scenarios, when the communication receiver and transmitter are in a 

mobile state, considering the changing transmission environment, channel parameters 

such as delay, maximum Doppler frequency shift, and path loss should be random. 

Besides, the continuous changes in channel scenarios also result in regular continuous 

changes in delay, maximum Doppler frequency shift, and path loss. In this case, the 

following equation can be generalized as a time-varying channel, and the theoretical 

model of channel impulse response at time t  can be represented as 
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Among them, t represents time; 
( ), ( ), ( )

l l l
a t t t 

 represents time-varying path loss, 

multipath fading, and multipath delay parameters. 

相对延迟时间

路
径

功
率

t1
t2

t3
t4

 

Fading Type 

• Static Fading 

A signal that is not fading, that is, a signal with constant amplitude and no Doppler 

frequency shift;  

• Pure Doppler 

A fading curve that simulates a direct transmission path where Doppler frequency shift 

occurs due to receiver movement. 

• Rayleigh 

A fading curve used to simulate radio jumps caused by scattering from obstacles in the 

signal path, such as buildings. The resulting received amplitude varies over time. The 

probability density function of the received amplitude is characterized by a Rayleigh 

distribution. 



Operation Signal Generator 

Fade and Add Noise 

217 
 

 

           Rayleigh fading waveform                             Rayleigh 

fading probability density 

 

 Rician 

A fading curve that simulates Rayleigh radio frequency hopping and strong direct beam 

signals. The fading spectrum of unmodulated signals involves the superposition of 

classical Doppler spectrum (Rayleigh) and discrete spectral lines (pure Doppler). The 

power ratio of two components (Rayleigh and Pure Doppler) is configurable 

 

 

 

Rician fading waveform                            Rician fading probability 

density 

 Lognormal 

Lognormal is slow fading and is suitable for simulating slow horizontal changes that 

may occur due to shadow effects such as tunnels, building blocks, or hills. 
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          Lognormal fading waveform                       Lognormal fading 

probability density 

Base Config 

 

Setting: 

└Fading ON/OFF 

└Fading Standard 

└Fading Mode 

 Fading ON/OFF 

Enable fading simulator. If activated, the fading simulation of the input signal will be 

enabled. 

 Fading Standard 

Select predefined fading settings based on the testing scenarios defined in common 

mobile radio standards. 

 Fading Mode 

Select fading mode configuration. 

According to the selected configuration, different configuration items will be provided 

in the "Fading Configuration" dialog box. 

Each change in the configuration interrupts the fading simulation process and restarts 

the calculation. 

"Static 20 fading paths are divided into 4 path groups. Each group consists of 5 
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Fading" paths. The group delay and path delay configurations differ in terms of 

resolution for path specific delays,  

"Generation 

and 

Extinction 

Scenario" 

Used to replicate the dynamic transmission channel defined in 3GPP 

25.104-XXX annex B4 in the "Generation and Extinction Scenario" 

configuration, supporting two transmission paths. Each path jumps from a 

certain delay value to another delay value, thereby achieving the process 

of "extinction from one delay and generation at another delay". 

"Dynamic 

Scenario" 

Used to replicate the "3GPP/LTE moving transmission" channel defined 

in 3GPP TS25.104 annex B3 or 3GPP TS36.141 annex B4, supporting 

two transmission paths, one reference path, and one movement path, 

can be configured with path loss values and time-varying delay values 

that comply with sine waveform changes. 

"High speed 

rail scenario" 

Used to replicate the high-speed railway channels defined in 3GPP 

25.141 annex D.4A 和 3GPP and 3GPP 36.141 annex B.3. 

Path setting 

 

Cross referencing between parameters 

Please consider the following interdependence: 

• Delay parameter 

“Delay generated”  =  “group delay”  + “path delay” 

• Parameters that affect Doppler frequency shift calculation:  

The formula for calculating the Doppler frequency shift fD obtained is: 

fD = (ν/c)*fRF, where: 

– ν  is the speed of the mobile receiver 

– fRF is the frequency of the RF output signal 

– C=2.998*10
8
m/s, which is the speed of light 

 

For "Pure Doppler and Gaussian Doppler", the formula for calculating the actual Doppler 

frequency shift fA is: 

fA = fD*cosφt, where 

– cos φ t is the frequency ratio ", φ is the angle of incidence 

– fD is the Doppler frequency shift generated 
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Setting: 

└State 

└ Fading type 

└ Relative Loss 

└ Group Delay 

└ Path Selay 

└ Actual delay 

└ Phase Shift 

└ Doppler Shift 

└ Movement speed 

└ Doppler Frequency 

└ Actual Doppler Frequency 

└ Frequency Ratio 

└ Power ratio 

└ Lognormal 

└ Decorrelation Length 

└ Standard deviation 

 Status 

Activate the current selection path. 

After activation, turn on the fading switch and the fading parameter set in the table will 

be used. 

 Fading Type 

Determine the fading type of the current configuration path. The path configuration 

table parameters may vary depending on the selected fading type. 

Static Simulate a static transmission path and configure path loss and path 

delay. 

Pure Doppler In the scenario where there is only a direct path between the analog 

transmitter and receiver, the actual Doppler frequency shift is 

determined by the "velocity" and "frequency ratio" parameters. 

Rayleigh Simulate an environment where there are a large number of scatterers 
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between the transmitter and receiver, and wireless signals reach the 

mobile receiver through multiple scattering paths 

Rician Consisting of Rayleigh fading and pure Doppler fading, the "power 

ratio" parameter can be configured to control the relative power of the 

two. 

Pure phase shift Simulate a transmission path with constant phase offset, path loss, 

and path delay. 

Gaussian 1 The shape of the Doppler power spectral density is the sum of two 

Gaussian spectra, used to simulate the fading path with relative delay 

of each scattering branch in the path at 0.5 2   s s . The 

theoretical Doppler power spectral density shape is: 

     1
, , - 0.8 , 0.05 , 0.4 , 0.1   

d d d d
S f   G A  f f  f   G A  f f  f

 

Among them, 1
A

 is 10dB smaller than A ,  *G
 is the Gaussian 

function, and d
f

 is the Doppler frequency. 

Gaussian 2 The shape of the Doppler power spectral density is the sum of two 

Gaussian spectra, used to simulate the fading path with relative delay 

of each scattering branch in the path at 2  s . The theoretical 

Doppler power spectral density shape is: 

     1
, , 0.7 , 0.1 , 0.4 , 0.15    

d d d d
S f   G A  f f  f   G A  f f  f

 

Among them, 1
A

 is 15dB smaller than A  

Gaussian DAB The shape of the Doppler power spectral density is composed of a 

Gaussian spectrum, which is used for special DAB configurations. The 

theoretical Doppler power spectral density shape is: 

   , , 0.7 , 0.1  
d d

S f   G A  f f  f  
 

Gaussian 

Doppler 

The shape of the Doppler power spectral density is the sum of the 

Gaussian spectrum and the pure Doppler component, and the 

theoretical shape of the Doppler power spectral density is: 

    '
, , , 0.08 ( )  

d d
S f   G A  f  f  f f

 

Among them, 
'

d
f is the actual Doppler frequency. 

Gaussian (0.08 

fd) 

The shape of the Doppler power spectral density is a Gaussian 

spectrum with a standard deviation of 
0.08*

d
f

. The theoretical 

Doppler power spectral density shape is: 

   , , , 0.08
d

S t f   G A f  f  
 

Gaussian (0.1 

fd) 

The shape of the Doppler power spectral density is a Gaussian 

spectrum with a standard deviation of 0.1*
d

f . The theoretical 

Doppler power spectral density shape is: 

   , , , 0.1
d

S t f   G A f  f  
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 Relative loss 

Enter the relative loss value for the set path. 

 Group delay 

Set the group delay. 

In the path group, all paths are delayed together by this value. 

The calculation formula for the actual path delay is: 

"Actual delay"="Group delay+Path delay” 

The group delay of the first group defaults to 0us and cannot be edited. After the 

group delay is set for other groups, the group delay for the 5 paths in that group will be 

changed uniformly. 

 Path delay 

Set the delay for each path. 

The calculation formula for the actual path delay is: 

"Actual delay"="Group delay+Path delay” 

 Actual delay 

Display value, cannot be modified. 

 Phase offset 

Set the phase offset of the path. Editable in pure Doppler and pure phase shift modes. 

Not editable in other modes. 

 Doppler offset 

Set the Doppler offset for each path. Convenient for testing and observation. 

 Movement speed 

Change the Doppler frequency of the current path by setting the movement speed. 

The movement speed and Doppler frequency are mutually transformed. 

Fd=f*v/c. 

The Doppler frequency range is 0-4k. Default: 2.78Hz Under 1GHz carrier, the 

movement speed range is (0.000-4317.12km/h), with the default value of 3.000km/h. 
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 Doppler frequency 

This value depends on the set movement speed and RF frequency.  

 Actual Doppler frequency 

Display control, non editable. In pure Doppler, Rice, and Gaussian Doppler modes, 

the actual Doppler frequency=Doppler frequency * frequency ratio. In other cases, it is 

equal to the Doppler frequency. 

 Frequency ratio 

Set the ratio of the actual Doppler shift fA to the generated Doppler shift fd. 

The actual Doppler frequency shift is a function of the simulated incident angle of the 

discrete component, and the calculation formula is: 

fA = fD*cosφt, where 

cosφ t is the "frequency ratio", f D= (v/c)*fRF is the Doppler frequency shift generated. 

A negative value indicates that the receiver is moving away from the transmitter, while 

a positive value indicates that the receiver is approaching the transmitter. 

 Power ratio 

It is valid and can be edited in Rice and Gaussian Doppler modes. In other cases, this 

value cannot be edited. 

 Lognormal 

Switch logarithmic normal fading (slow fading). 

Simulate slow changes in reception amplitude of mobile receiver. For example, when 

driving through a depression. Lognormal fading has a multiplication effect on path loss. 

The multiplication factor is time-varying and the logarithm follows a normal distribution. 

 Decorrelation length 

Enter the lognormal decorrelation length. 

 Standard deviation 

Enter the standard deviation of logarithmic normal fading in dB. 
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Path graph 

View a graphical table of configured paths. Provide a quick overview of the paths 

when configuring them in delayed mode. The signal delay is plotted on the x-axis. The 

minimum value is 0 seconds. The maximum value is equal to the maximum delay, 

determined by the sum of group delay and path delay. The relative path power is plotted on 

the y-axis, with 0 dB corresponding to the maximum power on the path (path loss=0 dB). 

Each path is represented by a bar. The color of the bar indicates the fading contour of 

the path. The color of each path is displayed next to the graph. The path loss can be read 

from the height of the bar. The minimum value is 0 dB, and the maximum value is -55 dB. 

Adding noise to signal 

This section introduces the concept of AWGN generator (additive white Gaussian 

noise). This section also introduces the settings for generating noise and CW Interferer 

sources. 

Content 

• Required Options 

• About AWGN Generator 

• AWGN Settings 

Required Options 

The additive Gaussian white noise (AWGN) simulation function needs to include the 

corresponding software option (Ceyear 1466 S04). 

About AWGN generator 

As long as the required options are installed, Ceyear 1466 can superimpose noise on 

the generated signal. The built-in noise generator can generate an AWGN signal with 

adjustable bandwidth and power (additive Gaussian white noise), superimpose it onto the 

digital baseband signal, and then modulate it onto the carrier. 

Generation of AWGN signals 

For the Gaussian noise signal, the uniform noise signal is generated by the feedback 

shift register, followed by the probability transformation to produce the Gaussian white 
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noise signal with ideal statistical characteristics. The characteristics are as follows: 

• The I and Q noise signals are independent of each other; 

• The period of noise signal is relatively long, and the specific period is related to the 

noise bandwidth; 

• Flexible configuration of noise power and noise bandwidth is achieved through 

low-pass filters. 

AWGN mode 

The AWGN generator can generate the following different mode signals: 

• "Add Noise": generate noise signal, superimpose the noise signal on the useful 

signal, and then modulate it on the carrier wave. 

• "Pure Noise": generate noise signal and modulate it to the carrier; 

• "CW Interferer": generate sinusoidal signals with frequency modulation bias and 

power, superimpose useful signals, and then modulate them onto the carrier wave. 

Signal and noise parameters 

The figure below illustrates the relationship between signal and noise parameters in 

terms of system bandwidth and noise bandwidth. 

 

Graphical representation of the relationship between system bandwidth and 

noise bandwidth (minimum noise/system bandwidth=2) 

System bandwidth: This value is a measured value that refers to the bandwidth used 

to transmit RF modulated signals. It is usually defaulted to the bandwidth occupied by the 

system and is usually slightly larger than the signal bandwidth. 

Noise bandwidth: The bandwidth of a noise signal, which must be greater than the 

system bandwidth. Computing method is as follows: 

Noise bandwidth=system bandwidth x minimum noise/system bandwidth ratio 
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In theory, the noise bandwidth can be infinitely wide, but in reality, it is limited by the 

modulation bandwidth of the instrument, and the calculated noise bandwidth does not 

exceed the instrument modulation bandwidth specified in the manual. 

In common test cases, signal and noise power are not directly defined, but are 

defined through the target signal-to-noise ratio (SNR) or carrier to noise ratio. 

Carrier power is a measure of signals without noise distribution. 

In order to accurately measure the noise power within the system bandwidth, it is 

recommended to use the channel power measurement function in the signal analyzer to 

measure the noise power. 

In the "Add Noise" mode, the output signal is superimposed with a noise signal. 

Therefore, the power level of the RF output corresponds to the sum of carrier+noise 

power. 

Logically, the calculated noise bandwidth does not exceed the total available 

bandwidth of the instrument specified in the data manual. 

AWGN settings 

Access: 

1. Select Main Interface>Noise. 

This dialog box contains noise level configuration and CW interference parameter 

settings. 

Content 

• Base Config 

• AddNoise 

• CW Interferer 

• Pure Noise 

Base Config 

Setting: 

└Noise switch 

└Mode selection 

 Noise ON/OFF 

Activate/deactivate the generation of AWGN signals. The interference source is Add 

Noise or CW Interferer, depending on the selected mode. 
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Remote command: 

[:SOURce[1]|2]:AWGN[:STATe] 

 Mode selection 

Three working modes are provided: Add Noise, Pure Noise, and CW Interferer. 

“Add Noise” An Add Noise signal with configurable broadband is added to the 

baseband signal. 

"Pure Noise" Broadband Pure Noise signals can be modulated to the carrier. The 

connection to the baseband is interrupted. 

“CW 

Interferer” 

A sine with a defined frequency offset is added to the baseband signal. 

Remote command: 

[:SOURce[1]|2]:AWGN:MODE 

 Add Noise 

 

Setting: 

└Carrier signal bandwidth 

└Noise bandwidth 

└Noise power calculation method 

└Bit rate 

└Signal to noise ratio  

└Eb/No 

 Carrier signal bandwidth 

Signal transmission occupancy bandwidth. The minimum value is 1kHz, and the 

maximum value is the maximum sampling clock of the instrument * 0.4 * 2. In digital 

modulation and dual/multi tone mode, this configuration item is in a non editable state, 

and the software automatically calculates the system bandwidth under the current 

configuration. The specific calculation formula is: 

In digital modulation mode: system bandwidth=symbol rate * (1+ α); where α is the 

current filtering factor. 

In dual tone mode: system bandwidth=dual tone frequency interval; 

In multi tone mode: system bandwidth=number of tones * multi tone frequency 

interval; 
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In arbitrary wave mode, this configuration item is not displayed. 

Remote command: 

[:SOURce[1]|2]:AWGN:CARRier:BWIDth? 

 Noise bandwidth 

Set the bandwidth value of the generated noise. This value is displayed and 

automatically calculated by the software. Users need to determine this value by 

configuring system bandwidth and noise/system bandwidth ratio. 

Remote command: 

[:SOURce[1]|2]:AWGN:BWIDth 

 Noise power calculation method 

The software provides C/N mode and Eb/No mode to calculate and display noise 

power. When the C/N mode is selected, the signal-to-noise ratio configuration item is valid, 

and when the Eb/No mode is selected, the Eb/No configuration item is valid. In arbitrary 

wave and multi/dual tone modes, this configuration item only provides the C/N mode noise 

power calculation method. 

Remote command: 

[:SOURce[1]|2]:AWGN:POWer:MODE 

 Bit rate 

This value is displayed and automatically calculated by the software. Bit rate=symbol 

rate * modulation bits; This value is automatically calculated in real-time baseband mode, 

and is null in arbitrary wave and multi/dual tone mode. This item is displayed to calculate 

the signal-to-noise ratio from the Eb/No mode. 

Remote command: 

[:SOURce[1]|2]:AWGN:BRATe?  

 

 Signal-noise ratio 

The ratio of noise power to signal power. 范围-50dB~40dB。 In C/N mode, this value 

is editable. In Eb/No mode, this value is not editable. After this value is set, the software 

automatically calculates the Eb/No value and displays it. The calculation formula is: 

Eb/No=signal-to-noise ratio/(bit rate/system bandwidth). 

Remote command: 

[:SOURce[1]|2]:AWGN:CNRatio

 Eb/No 
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In Eb/No mode, this value is editable. After this value is set, the software 

automatically calculates the signal-to-noise ratio, with the formula: signal-to-noise 

ratio=(Eb/No) * (bit rate/system bandwidth). This value is invalid and null in arbitrary wave 

and multi/dual tone modes. 

Remote command: 

[:SOURce[1]|2]:AWGN:ENRatio 

 CW Interferer 

 Target continuous wave frequency offset: 

Set the relative frequency of the interference continuous wave relative to the 

modulation carrier. Range - baseband bandwidth/2~+baseband bandwidth/2. 

Remote command: 

[:SOURce[1]|2]:AWGN:FREQuency:OFFSet 

 Pure Noise 

 Noise bandwidth 

Set bandwidth of pure noise. Range: The minimum value is 1kHz, and the maximum 

value is the maximum sampling clock of the instrument * 0.4 * 2. 

Remote command: 

[:SOURce[1]|2]:AWGN:BWIDth 

IQ vector modulation 

Ceyear 1466 provides I/Q modulation through external analog I/Q signals, external 

digital signals, and internally generated digital signals. 

For an explanation of the signal adjustment function and the settings for applying 

nonlinear effects, please refer to "I/Q Input Adjustment". 

Content 

• About I/Q Modulator 

•Vector modulation 

• I/Q Modulator Settings 

• I/Q Input Adjustment 

•I/Q output adjustment 
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About I/Q modulator

Ceyear 1466 provides I/Q modulation through internally generated digital signals, 

external digital signals (optical ports), and external analog I/Q signals. 

The analog I/Q input signal is directly connected to the analog I/Q modulation circuit, 

without passing through the baseband module of Ceyear 1466. 

Vector modulation 

In digital communication, modulation is often described by parameters I and Q. This 

is the Cartesian description of a polar diagram. In polar coordinates, the I axis is rotated 

90 degrees along the 0 degree phase reference direction, while the Q axis is rotated 90 

degrees. The projection of a signal on the I axis is its I component, and the projection on 

the Q axis is its Q component. 

 

By controlling the voltage of the I/Q signal, the amplitude and phase of the vector 

modulation signal are controlled. The form of the I/Q signal determines the modulation 

form of the signal. The two I/Q signals are of equal amplitude, without phase offset and 

time delay, and without DC bias. 
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Digital communication can be easily achieved using I/Q modulators. Most digital 

modulation maps data to a series of discrete points on the I/Q plane. This is the star map. 

When a signal moves from one point to another, amplitude and phase modulation occur 

simultaneously. It is difficult and complicated to be achieved with modulator and phase 

modulator. However, conventional phase modulators cannot be used, as in practice, it is 

possible for the signal to rotate around the origin and continue in the same direction, 

requiring infinite directional ability. Meanwhile, amplitude modulation and phase 

modulation can be conveniently achieved using an I/Q modulator. 

I/Q modulator settings 

Access: 

1. To configure the input signal source of the I/Q modulator, select "I/Q 

Modulation>I/Q Input Adjustment" and enable the I/Q input adjustment function. 

2. To configure the basic functions of the I/Q modulator, select "I/Q Modulation>I/Q 

Settings>". 

3. To configure baseband I/Q signal output, select "I/Q Modulation>I/Q Output or I/Q 

Output Adjustment". 

Setting: 

└ I/Q modulation 

└ Data source selection 

└ I/Q exchange switch 
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└Gain adjustment 

I/Q modulation 

Activate/deactivate I/Q modulation. 

Notice: The logical relationship between the I/Q modulation switch and other digital 

modulations. If any digital modulation option of the instrument baseband function is turned 

on, the I/Q modulator will always be automatically activated when activating signal 

generation ("baseband>state>ON"). I/Q modulation can be manually turned off while the 

baseband is still output, for example, if the baseband signal is directly routed to the I/Q 

output. 

Remote command: 

[:SOURce[1]|2]:DM:STATe 

Data source selection 

Select the input signal of the I/Q modulator. 

“Internal” Select the internal baseband signal. 

“External” Select external analog I/Q signal. 

Remote command: 

[:SOURce[1]|2]:DM:SOURce 

I/Q exchange switch 

Select normal or switched I/Q control for the generated signal. 

The filtered IQ signal is modulated to the desired RF in different ways in the I/Q 

modulator: 

Remote command: 

[:SOURce[1]|2]:DM:IQEXchange:STATe 

Gain adjustment 

Optimize the modulation of the I/Q modulator for measurement requirements. The 

dynamic range provided is 12 dB in 3dB steps. Optimization is a trade-off between signal 

distortion and signal-to-noise ratio (SNR). The default setting is automatic, and the 

software automatically matches the gain based on the signal. 

Remote command: 

[:SOURce[1]|2]:DM:ATTenuation 
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I/Q input adjustment 

In Ceyear 1466, for the baseband output I/Q signal of the instrument, additional 

adjustments can be made to the signal (such as I/Q bias, orthogonal offset), which can be 

added to the generated I/Q signal to achieve system error correction of the I/Q modulator. 

Adjustments are made based on carrier leakage, I/Q imbalance, and orthogonal offset to 

achieve optimal vector output. The analog input connector I/Q is located on the rear panel 

of Ceyear 1466. 

Content 

• About I/Q Adjustment 

• Analog and Digital Damage Settings 

• Optimization of Carrier Leakage and Sideband Suppression 

About I/Q adjustment 

I/Q signal adjustment is the arithmetic modification of I/Q data that is clearly defined. 

Each data sample is modified in the same way. 

Add adjustment to the data stream for the following purposes: 

• In receiver test, simulate the distortion source in the real signal processing chain  

• Compensate for distortion in the I/Q demodulator in the receiver 

Content 

• Gain Imbalance 

• I and Q Offset 

• Orthogonal Offset 

 Gain imbalance 

The I/Q gain is the total I/Q amplitude multiplied by a common factor. This effect is 

equivalent to two identical I and Q gain factors. The impact of increasing gain factor in the 
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I/Q constellation chart is shown in the figure. 

Effect of increasing amplitude in I/Q constellation chart 

 

I gain multiplies the I amplitude by a factor, keeping the Q amplitude constant. Q gain 

has the opposite effect. Different I and Q gain factors can lead to I/Q imbalance, which is 

caused by the different gains of the amplifier in the I and Q channels of the I/Q modulator. 

The impact of positive and negative gain imbalance is shown in the figure "Negative gain 

imbalance (left) and positive gain imbalance (right) in I/Q constellation chart". 

 

Negative gain imbalance (left) and positive gain imbalance (right) in I/Q 

constellation chart 

 I and Q offsets 

I offset adds a constant value to all I amplitudes, keeping the Q amplitude constant. Q 

offset has the opposite effect. The combination of I and Q values can cause I/Q 

misalignment, which is caused by carrier leakage in the I/Q modulator. The impact of 

positive I and Q offsets in the I/Q constellation chart is shown in the figure. 
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I offset (left) and Q offset (right) in I/Q constellation 

 

 

 Orthogonal offset 

Change the phase angle between the I and Q vectors from the ideal 90° while 

maintaining the amplitude. Orthogonal offset results in a phase angle greater than 90°. 

The influence of orthogonal offset in the I/Q constellation chart is shown in the figure. 

Orthogonal offset in I/Q constellation chart 

Input adjustment settings 

You can add adjustment settings for each internally generated I/Q signal  

Setting: 

└I/Q input adjustment 

└ I/Q offset 

└ Gain balance 

└ Orthogonal offset 

 I/Q input adjustment 

Activate the input adjustment function of the I/Q signal. 

If activated, the settings for I/Q offset, gain balance, and orthogonal offset will take 

effect. 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment[:STATe 
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 I/ offset 

Set the carrier offset (in percentage) of the amplitude of the I or Q signal component 

(scaled by peak envelope power (PEP)). An ideal I/Q modulator can completely suppress 

carrier offset (offset=0%). 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment:IOFFset 

[:SOURce[1]|2]:DM:IQADjustment:QOFFset 

 

 Gain balance 

Set the imbalance between the I and Q vectors. 

In dB (default) or %, with a 1dB offset of approximately 12%, as follows: 

Imbalance [dB]=20log (| Gain Q |/| Gain I |) 

A positive value indicates that the Q vector amplifies by a corresponding percentage 

compared to the I vector. A negative value has the opposite effect. 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment:GAIN 

 Orthogonal offset 

Set orthogonal offset. 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment:QSKew 

I/Q output adjustment 

Access 

The analog output connector I/Q is located on the rear panel of Ceyear 1466.  

When the I/Q output is turned on, the IQ modulation module will identify 
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Setting: 

└I/Q output/output adjustment 

└ I (Q) common mode voltage 

└ I/Q offset 

└ Gain balance

└Orthogonal offset 

I/Q output/output adjustment 

Enable/disable analog I/Q output and I/Q output adjustment. 

Remote command: 

[:SOURce[1]|2]:DM:OUTPut[:STATe]  

[:SOURce[1]|2]:DM:IQADjustment:OUTPut[:STATe]  

 I (Q) common mode voltage 

Set the output common mode voltage of the I and Q signal components. 

If enabled, the DC voltage is superimposed on the I or Q signal. 

Remote command: 

[:SOURce[1]|2]:DM:OUTPut:ICOFfset 

[:SOURce[1]|2]:DM:OUTPut:QCOFfset  

 

 I/ offset 

Set the I/Q offset of the output signal. 

Remote command: 
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[:SOURce[1]|2]:DM:IQADjustment:OUTPut:IOFFset 

[:SOURce[1]|2]:DM:IQADjustment:OUTPut:QOFFset 

 Gain balance 

Set the gain balance of the output signal. 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment:OUTPut:GAIN 

 Orthogonality offset 

Set the orthogonal offset of the output signal. 

Remote command: 

[:SOURce[1]|2]:DM:IQADjustment:OUTPut:SKEW

 

Configure RF signal 

The Ceyear 1466 series signal generator generates RF signals with excellent 

spectral purity in the frequency range of 6kHz to 110 GHz, and has a large output power 

dynamic range. 

Signal mode and characteristics

• Excellent spectral purity, SSB-132 dBc/Hz (typical value, 10 GHz carrier 10kHz 

frequency offset), and spurious<-80 dBc (10 GHz carrier). Excellent broadband bottom 

noise, SSB-161 dBc/Hz (typical value, 20GHz carrier 30MHz frequency offset); Large 

output power dynamic range, with a maximum dynamic range of -150dBm~+25dBm 

(settable) 

• Support AM, FM Φ M and pulse modulation, with a minimum pulse width of 20ns 

for pulse modulation 

• Support step sweep, list sweep, power sweep, and analog sweep 

Content 

• Access to Functions in RF Domain 

• Activation of RF Signal Output 

• Configuration of RF Frequency and Level 

• Reference 
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• Sweep settings  

• Analog Modulation 

• Power Advanced Settings 

Access to Functions in RF Domain 

The signal flow diagram on the main interface of the software provides a configuration 

entry for accessing RF parameters. Click the block diagram in the flow diagram to open 

the corresponding parameter configuration window. For example, click the  

block diagram to open the frequency configuration window; Click the  block 

diagram to open the sweep configuration window; Click the  block diagram to 

open the simulation modulation configuration window; By analogy, all configuration 

windows related to RF parameters can be accessed through signal flow diagrams. 

 

Activation of RF Signal Output 

The RF output is OFF by default, and you can set the RF output to ON by one of the 

following methods. 
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1. Click the "RF" ON/OFF icon  in the upper right corner of the main interface 

to switch the RF output ON/OFF status, which is  when the RF output is ON. 

2. Click the [RF Output] button  on the front panel to switch the RF output 

ON/OFF status. 

 

If you want to observe whether the signal has output correctly, please first set the 

frequency and power parameters of the output signal. 

 

RF on/off 

RF output ON/OFF. 

Remote command: 

OUTPut[1]|2[:STATe] 

Configure RF frequency and power 

The simplest RF signal is a continuous wave (CW) signal with constant frequency 

and power. You can set the frequency and power of RF signals in various methods as 

shown below. 

 

At the top of the software main interface, directly click the frequency or power input 

box to activate the input. You can use the virtual keyboard or the number keys on the front 

panel to input the target value. 

Press the [Frequency] or [Power] keys on the front panel, and then input the target 

value using the number keys on the front panel. 

In the frequency configuration window and power configuration window, set the 

frequency and power values of the RF signal. Refer to “RF Frequency Setting” and “RF 

Power Setting”. 

 

Tips 
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Content 

• RF Frequency Setting 

• RF Power Setting 

RF frequency setting 

Access: 

 Select “Frequency>Frequency Setting”. 

 In the "Frequency Configuration" dialog box, you can configure: 

• RF frequency, including frequency offset or frequency multiplier, etc 

• Changing the progressive value of frequency through the knob. 

• Frequency Step 

Setting: 

└Continuous wave 

└Frequency offset 

└Frequency reference ON/OFF 

└Frequency reference 

└Frequency multiplier 

└Frequency step switch 

└Frequency step 

 Continuous wave 

Set RF frequency. Set the output frequency of the signal generator in continuous 

wave mode. 

The parameter values can be set and adjusted by touch screen, mouse/keyboard or 

knob, numeric keys and step keys on the front panel. 

This frequency is output on the RF A/RF B connector. 

Remote command: 

[:SOURce[1]|2]:FREQuency[:CW|FIXed] 

 Set frequency offset 

Set carrier frequency offset. When the frequency offset is not set to zero, the offset 

indicator "Offset" will be displayed above the screen, and the displayed value becomes 
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the frequency after adding the offset. At this time, the displayed frequency value = RF 

output frequency value * multiplier factor + frequency offset, but the real frequency output 

is still the frequency before multiplying the multiplier factor and adding the frequency offset. 

When the frequency offset is set to zero, the indicator will disappear. 

The "frequency" value displayed in the frequency display area is the result frequency. 

The frequency of Ceyear 1466 RF output remains unchanged. 

Remote command: 

[:SOURce[1]|2]:FREQuency:OFFSet 

 Frequency reference ON/OFF 

Set the frequency reference to ON/OFF state. When the frequency reference is 

turned on and the continuous wave frequency of the signal generator is changed, the 

frequency value displayed in the frequency display area is based on the frequency 

reference. When the switch is not turned on, the frequency value displayed in the 

frequency display area is the actual continuous wave frequency of the signal generator. 

Remote command: 

[:SOURce[1]|2]:FREQuency:REFerence:STATe 

 Frequency reference 

Set the frequency reference function, which can be used normally when the 

frequency reference switch is turned on. The frequency reference indicator is displayed in 

the upper area of the screen, and any continuous wave output signal set at this time will 

subtract the frequency reference value. For example, if the current continuous wave 

output frequency is 1GHz and the frequency reference is set to 1GHz, the displayed 

continuous wave output frequency will be based on the frequency reference 0Hz. 

Therefore, 0 Hz will be displayed in the frequency display area, and the actual output 

frequency of the signal generator is 1GHz. If the continuous wave frequency is set to 

1MHZ, 1MHZ will be displayed in the frequency display area, and the actual output 

frequency is 1.001GHz. 

Remote command: 

[:SOURce[1]|2]:FREQuency:REFerence 

 Frequency multiplier 

Set the multiplication factor for RF frequency. 

This value indicates the multiplication factor of the downstream tool. When the 

frequency multiplier is set to a value greater than 1, the multiplier indicator will be 
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displayed above the screen. At this time, the displayed frequency value = RF output 

frequency value * multiplier factor, but the real frequency output is still the frequency 

before multiplying the multiplier factor. When the frequency multiplier is set to 1, the 

indicator will disappear. 

Remote command: 

[:SOURce[1]|2]:FREQuency:MULTiplier 

 Frequency step ON/OFF 

Set whether the frequency step switch is turned on. After turning on, when setting the 

continuous wave, the marker cannot be adjusted to step by bit arbitrarily, but shall be 

increased or decreased by the step value. 

Remote command: 

[:SOURce[1]|2]:FREQuency:STEP:STATe 

 Frequency Step 

Define and activate user-defined step width to change the RF frequency according to 

the step value using knobs or up and down arrow keys. 

If disabled, the step width varies in steps of one unit at the marker position. 

Remote command: 

[:SOURce[1]|2]:FREQuency:STEP[:INCRement] 

RF power setting 

Access: 

Select “Power”>“Power Settings”. 

In the "RF Level" dialog box, you can configure no offset level, level limit, and step 

width to change the level using the knob. 

Setting: 

└Power 

└Power offset 

└Power reference ON/OFF 

└Power reference 

└Power step switch 

└Power step 
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└Power limit 

└Maximum output power 

 Power 

Set the power level of RF signal 

This value has no offset and corresponds to the output power of the RF A/RF B 

connector. 

Remote command: 

[:SOURce[1]|2]:POWe[:LEVel][:IMMediate][:AMPLitude] 

 Power offset 

The command is used to set the actual output power offset value of the signal 

generator. When the value is not zero, "Offset" will be displayed in the power display area, 

and the displayed power value is the actual output power plus the power offset. The power 

offset value will change the displayed power value instead of the actual output power of 

the signal generator. 

Remote command: 

[:SOURce[1]|2]:POWe[:LEVel][:IMMediate]:OFFSet 

 Power reference ON/OFF 

Set the power reference to ON/OFF state. When the power reference is set to ON 

state, the power reference value is not zero, and the power level of the signal generator is 

changed, the power value displayed in the power display area is based on the power 

reference. When the power reference is set to OFF state, the power value displayed in the 

power display area is the actual continuous wave output power of the signal generator. 

Remote command: 

[:SOURce[1]|2]:POWe:REFerence:STATe 

 Power reference 

When the power reference is set to ON state, the power reference value may be set. 

When the power reference is set to ON state, the indicator will be displayed in the power 

display area, and the displayed power value = actual output power - power reference 

value. 

For example, when the current continuous wave output power is 1dBm, if the power 

reference is set to 1dBm, the displayed continuous wave output power will be based on 
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the power reference. Therefore, 0dBm will be displayed in the power display area, and the 

actual output frequency of the signal generator is still 1dBm. 

Remote command: 

[:SOURce[1]|2]:POWe:REFerence 

 Power step ON/OFF 

Set whether the power step switch is turned on. After turning on, when setting the 

power, the marker cannot be arbitrarily adjusted to step by bit, but shall be increased or 

decreased by the step value. 

Remote command: 

[:SOURce[1]|2]:POWe:STEP:STATe 

 Power step 

Define and activate user-defined step width to change the RF power according to the 

step value using knobs or up and down arrow keys. 

If disabled, the step width varies in steps of one unit at the marker position. 

Remote command: 

[:SOURce[1]|2]:POWe:STEP 

 Power limit 

Set the upper limit of RF output frequency 

You can use this value to protect your DUT from damage caused by high input power. 

If the input RF level is higher than this value, the instrument will limit the output power to 

this specified value. 

Remote command: 

[:SOURce[1]|2]:POWe:USER:ENABle 

 Maximum output power 

The power limit is valid when ON. It refers to the maximum output power 

Remote command: 

[:SOURce[1]|2]:POWe:USER:MAX 

Reference 
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Ceyear 1466 is equipped with an internal reference oscillator that can generate a 

reference frequency of 10 MHz. It serves as an internal reference source for the 

synthesizer. Alternatively, you can apply an external reference signal. If equipped with the 

required items, Ceyear 1466 can handle external reference frequencies and 1GHz 

reference frequencies in the range of 1 MHz to 100 MHz. 

Regardless of the reference source used (internal or external), Ceyear 1466 always 

provides a configured reference frequency at the output end. For example, you can use it 

to synchronize multiple interconnected instruments. 

Content 

• Required Options 

• Reference Frequency Setting 

• Coherent Extension 

Required Options 

The Ceyear1466 basic unit is equipped with the following items: 

• 100 MHz/1 GHz reference input and output (Ceyear 1466-H07) 

For more information, please refer to the data manual. 

Reference frequency setting 

Access: 

Select “System”>“Basic Settings”>“Reference Settings”. 

On the “Reference Settings" property page, you can select internal and external 

reference frequencies and adjust reference accuracy. 

└Reference selection 

└Reference manual settings 

└External reference frequency 

└Internal reference accuracy adjustment 

└Reset of factory default values 

└Frequency selection of reference input and output 

└Reference input/output selection 

└Configuration application 

 Reference selection 
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This item is set to manual or automatic for reference. 

In the auto mode, the instrument selects the frequency reference automatically if 

there is any external frequency reference or internal one, with the former being the priority. 

The default setting is [Auto] 

Remote command: 

[:SOURce]:ROSCillator:SOURce:AUTO 

 Reference manual settings 

Select a reference frequency source. 

“Internal” Using an internal reference oscillator, users can make customized 

adjustments to reference accuracy. 

“External” Use external reference signals. 

Note: Select reference and then select external, the rear panel is not connected to 

the reference signal, and Ceyear1466 will issue a reference ring lock loss warning 

message. 

Remote command: 

[:SOURce]:ROSCillator:SOURce  

 External reference frequency 

Valid when the reference is selected as manual. The external reference frequency set. 

The default external reference frequency is 10MHz. When it is other frequencies within the 

range of 1MHz to 100MHz, manual settings need to be made here. 

Remote command: 

[:SOURce]:ROSCillator:FREQuency:EXTernal 

 Internal reference accuracy adjustment 

Adjust internal reference of the signal generator by setting internal calibration 

parameter, so as to make the frequency output more accurate. It should be noted that 

within 2h after starting the signal generator, the instrument should be preheated. Please 

do not change the reference value easily. 

Remote command: 

[:SOURce]:ROSCillator:REFerence 

 Reset of factory default value 
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Restore the default value of internal reference accuracy. 

Remote command: 

[:SOURce]:ROSCillator:DEFaults 

 Reference input and output frequency selection 

H07 item is required. Valid when selecting external for reference input/output. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:FREQuency 

 Reference input/output selection 

H07 item is required. Set the 100MHz/1GHz reference input/output to internal or 

external. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:SOURce 

 Configuration application 

H07 item is required. After the 100MHz/1GHz reference input and output settings are 

changed, click this button to take effect. 

Remote command: 

[:SOURce]:ROSCillator:REFerence:APPLy 

Coherent extension 

The "coherent extension" function is used to achieve phase coherence between 

multiple Ceyear 1466 vector signal generators or internal multi-channel vector signals for 

a common LO connection. This function allows the allocation of LO signals so that 

multiple RF signals can be derived from the same LO signal. This is necessary to 

minimize phase fluctuations between these RF signals. 

 Phase coherence 

The phase coherence of RF signals represents a constant incremental phase defined 

between two or more RF carrier signals with the same frequency or frequency multiples. 
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If two signal generators are coupled through their 10 MHz reference voltage source, 

they produce the same frequency, but only from a long-term perspective. By carefully 

studying the instantaneous differential phase ("incremental phase") of these two RF 

signals, the following are possible reasons for instability: 

• Phase noise of two frequency synthesizers 

•  Weak coupling at 10 MHz and long synthetic chains up to RF domain 

• The temperature difference that causes changes in the effective electrical length 

of certain synthesizer components 

The most critical factor for stable triangular phase is the thermal RF phase 

fluctuations between multiple RF frequency synthesizers. By using a universal frequency 

synthesizer, these fluctuations can be minimized, which means that all RF carriers have a 

common LO (LO) signal. The LO signal is used internally to upconvert the baseband 

signal to RF. Only when the LO signals of all carriers are the same can a stable phase 

relationship between RF signals be achieved. 

 

 

Connect 

• The internal LO signal is divided into two sections: 4GHz~20GHz and 

50MHz~4GHz, which are respectively output from the "LO output" and "RF coherent 

output" interfaces on the rear panel. 

• The external 4GHz~20GHz and 50MHz~4GHz LO signals are input from the "LO 

input" and "RF coherent input" interfaces on the rear panel, respectively. 

Possibility of a common LO connection 

You can perform a common LO connection as follows: 

• Single channel common LO 

The single channel Ceyear 1466 vector signal generator can use external LO or internal 

LO, and can output or not output LO to other instruments.  

The dual channel Ceyear 1466 vector signal generator can only couple channel A LO to 
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channel B for internal coherence, and can only accept external LO from channel A, while 

outputting LO from channel B to external. The LO output by channel B can be either the 

LO of channel B, coupled from channel A, or input from external sources by channel A. 

The reference frequency setting in path B does not work, so it is disabled for editing. 

Phase coherence setting 

Access: 

 Select "System>Basic Settings>Phase Coherence". 

For specific configuration commands, please refer to Operation Signal 

Generator>System Configuration>Basic Settings>Multi Instrument Coherent Connection. 

Sweep settings 

Sweep mode description 

The frequency generation methods "step", "list", and "slope" allow you to generate RF 

signals with periodic changes in frequency or amplitude. 

• Step mode 

The instrument generates an RF signal that changes its frequency value in discrete steps 

between the start and stop values. These values vary depending on specific shapes such 

as ramp or triangular shapes. The spacing is linear or logarithmic. The main application 

area is to determine the frequency response of DUTs. 

 

Schematic diagram of signals generated in step mode 
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• List mode 

The instrument generates different output signals based on a previously saved list of 

frequency, amplitude, and step width values. In sweep mode, the frequency or power 

values will change, while in list mode, you can change both parameters simultaneously. 

The frequency and level values do not need to be in ascending or descending order, but 

can vary arbitrarily. You can use the global dwell time, and the list sweep mode is 

particularly useful in high-speed measurements with rapid changes in frequency and 

power settings.  

The schematic diagram of the signal generated in list sweep mode (global dwell time) 

"represents the frequency and power value pairs, in which case the dwell time settings for 

all steps are the same (global dwell time). 

The schematic diagram (global dwell time) of the signal generated in list sweep 

mode 

 

 represents the theoretical behavior. In actual signal generation, when there is a 

change in frequency or power, there is usually a calculation time for the instrument. 

 

Interaction and features between list and sweep modes 

Notice 



Operation Signal Generator 

Configuration of RF signal (All) 

 

• Activating the list mode will automatically disable all continuous wave RF outputs, 

and vice versa. 

• In sweep mode, the frequency setting of the title is disabled. 

• If the sweep is run at a specific frequency or power, input the continuous wave 

frequency in the frequency configuration window, and the sweep immediately  

Sweep signal shape 

Ceyear 1466 supports the following sweep shapes: 

• Ramp 

The sweep sequence is similar to ramp. A single sweep runs from start to stop with 

frequency or level values. Each subsequent sweep restarts from the start value. 

 

Sweep signal ramp 

1 = Starting value 

2 = Stop loss value 

3=step 

• Triangle 

The sweep sequence is similar to a triangle. A single sweep runs from start to stop value 

frequency and returns. Each subsequent sweep starts from the start value. 
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Sweep signal triangle 

1 = Starting value 

2 = Stop loss value 

3=step 

The current frequency or level, level or low-frequency sweep of the RF is determined 

by its shape (such as ramp wave or triangle), spacing (linear or logarithmic), and step 

length. 

About dwell time 

Dwell time is the length of time that elapses from the beginning to the end of a step or 

list sweep mode. 

Dwell time and establishment time 

1="dwell time" (according to parameter settings) 

2=establishment time 

3=dwell time (valid) 

The time required for signal stability in the instrument will reduce the set dwell time: 

t dwell(valid) = t dwell – tfrequency switching time  

 

 If the dwell time in step or list sweep mode is too short or the external trigger signal 

comes too fast, the signal generation is delayed. 

 

Sweep mode settings 

Notice 
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Access: 

 Select 'Sweep>Sweep Configuration Window>Sweep Mode>'. 

 Frequency generation mode 

Set the frequency output mode of the instrument. Including OFF (continuous wave), 

step sweep, list sweep, and slope sweep. 

Program control commands: 

[:SOURce[1]|2]:FREQuency:MODE 

 Start sweep trigger 

Set the start sweep trigger method, including automatic, external, and trigger keys. 

Automatic: Turn on the sweep switch, and the system will automatically trigger the 

sweep output. 

External: Turn on the sweep switch, the instrument will not perform sweep, and the 

external trigger signal input will initiate sweep. The trigger signal source comes from the 

trigger input connector on the rear panel. 

Trigger key: If the instrument fails to perform sweep after the sweep switch is turned 

on, click the "Trigger" key to start sweep. 

Program control commands: 

[:SOURce[1]|2]:SWEep[:FREQuency]:STARt:TRIGger:SOURce 

 Trigger 

Valid when the start sweep trigger is the trigger key. Click to execute the start sweep 

trigger. 

Program control commands: 

[:SOURce[1]|2]:SWEep[:FREQuency]:STARt:TRIGger 

 Sweep mode 

Set the sweep mode to continuous or single. 

Continuous: Initiate continuous sweep. 

Single: Initiate a single sweep. 

Program control commands: 

[:SOURce[1]|2]:SWEep[:FREQuency]:MODE 
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 Restart single sweep 

Valid when sweep mode is set to single. Click to initiate a single sweep. 

Program control commands: 

[:SOURce[1]|2]:SWEep[:FREQuency]:SINGle:RESet 

 Sweep ON/OFF 

After a single sweep is completed, the frequency stays at the last or first frequency 

point. When the sweep is set to ON state, the frequency stays at the first frequency point. 

The sweep is set to OFF state by default. 

Program control commands: 

[:SOURce[1]|2]:SWEep:RETRace 

[:SOURce[1]|2]:LIST:RETRace 

 

Step sweep 

Access: 

► Select Sweep>Sweep Configuration Window>Step Sweep. 

└ State (RF sweep) 

└ State (RF Level Sweep) 

└ State (Low Frequency Sweep) 

└ Current Frequency 

└ Current level 

└ Mode 

└ Track 

└ Shape 

└ Spacing 

└ Dwell time 

└ Trigger slope 

└ Run single sweep 

└ Display connector 

└ Reset sweep 
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 Step sweep ON/OFF 

Activate RF step sweep signal generation. 

 

Enabling step sweep mode will disable other sweep modes, and vice versa. 

 

Remote command: 

[:SOURce[1]|2]:FREQuency:MODE 

 Current frequency 

In the "Step Sweep" mode, the current frequency is displayed.  

 Step Trig 

Select step sweep trigger mode 

“Auto” Directly generate continuous and repeated sweep signals after activating 

step sweep. 

The sweep point is controlled by the dwell time and automatically executed. 

“Trigger 

key” 

Generate sweep signals point by point and trigger by trigger key. Click the 

trigger key to execute a sweep point. 

“External” Generate sweep signals point by point, with an external pulse signal to 

execute a sweep point. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:TRIGger:SOURce 

 Trigger 

This button is effective when the trigger key is selected for the step trigger mode. 

Click to trigger the playback of the next frequency point. Continuously click to trigger the 

playback of each step point in sequence. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:TRIGger 

 Sweep shape 

Description 
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Select the waveform shape of the sweep signal. 

“Ramp” The sweep frequency runs from start to stop. The subsequent sweep starts 

from the start value, meaning that the shape of the sweep sequence is 

similar to ramp. 

“Triangle” Sweep from start to stop values and return, meaning that the shape of the 

sweep is similar to a triangle. Each subsequent sweep starts from the start 

frequency. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:SHAPe 

 Start frequency/Stop frequency 

Define the frequency sweep range by setting the start and stop values. 

Remote command: 

[:SOURce[1]|2]:FREQuency:STARt 

[:SOURce[1]|2]:FREQuency:STOP 

 Center frequency 

In the "Step Sweep" mode, set the RF center frequency. 

Remote command: 

[:SOURce[1]|2]:FREQuency:CENTer 

 Frequency span 

In the "Step Sweep" mode, set the span of the frequency sweep range. 

Remote command: 

[:SOURce[1]|2]:FREQuency:SPAN 

 Step mode 

In the "Step Sweep" mode, select the mode used to calculate the frequency interval 

and increase or decrease the current frequency of each step through this mode. 

Enter the step length using the step value. 

 

“Linear” Take the input frequency value as an absolute value (in frequency). 

“Logarithm” Take the input value as a logarithmic value, that is, as a constant fraction of 
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the current frequency, in %. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:SPACing 

 Step value 

In the "Step Sweep" mode, set the step width for each frequency sweep step. This 

value is added to the current frequency at each sweep step. 

Based on the current step value, you can enter absolute or logarithmic step width. 

“Linear step” Step width is a constant value in Hz. 

"Step length 

logarithm" 

The step width is determined logarithmically in% as a constant 

fraction of the current frequency. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:SETP:LOGarithmic 

[:SOURce[1]|2]:SWEep[:FREQuency]:SETP[:LINear] 

 Dwell time 

Define the duration of each step frequency point. 

Remote command: 

[:SOURce[1]|2]:SWEep[:FREQuency]:DWELl 

List Sweep 

List sweep is used to generate RF signals based on a predefined set of frequency 

and amplitude values, with separate step times. You can define values in any order and in 

different steps within the entire configurable value range of the instrument. 

Configuration and operation of list sweep signals 

Configure the parameters of the RF signal in the sweep list and store them in a file. 

Create and process lists 

You can create a list file in the following ways: 

• Internally 

Use a built-in table editor that includes frequency, power, and dwell time.  

Define values manually (line by line) or automatically based on the value range and step 

length. 



Operation Signal Generator 
Configuration of RF signal 

259 
 

Save as a file with a user-defined file name and a predefined file extension of *. lst. 

can load saved files. 

• The list can also be exported. For example, exchanging configurations between 

instruments or using external programs to modify file contents and reloading them again. 

• Externally 

Create a list file as a CSV file using Microsoft Excel, Notepad, or similar tools, and save it 

with a predefined extension. Transfer the file to the instrument and load it into the 

instrument. 

Dwell time mode 

You can choose whether to use different or fixed values for all dwell times in list 

mode: 

• "List” 

In this mode, the values from the data table are used. 

• "Global” 

In this mode, the list is processed at fixed time intervals, and you can use the global dwell 

time setting. 

 General settings 

Access: 

► Select “Sweep”—>”List Sweep”>. 

 You can configure the trigger and dwell time modes for list processing and activate 

signal generation. 

Setting: 

└State 

└ Current Index 

└ Mode 

└ Dwell Time Mode 

└ Global Stay Time 

└ Operating mode 

└ Learning List Mode Data 

└ Trigger slope 

└ Display connector 

└ Reset 
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└ Execute Single 

 

 List sweep ON/OFF 

Activate list mode and play the currently selected list. 

 

Enabling the list sweep mode will disable other sweep modes, and vice versa. 

 

Remote command:  

[:SOURce[1]|2]:FREQuency:MODE 

 Current playback index 

Display the index of currently swept lists in the Sweep mode. 

[:SOURce[1]|2]:LIST:PLAY[:INDex]? 

 Select the List Sweep file 

Select the edited *.lst list file through the Select File dialog box. 

Remote command: 

[:SOURce[1]|2]:LIST[:WAVeform] 

 Edit the list sweep file 

This button is valid after selecting a list file. Click to open the Edit List Data dialog box 

 Reset the list file 

Reset the list sweep file to empty. 

Remote command: 

[:SOURce[1]|2]:LIST[:WAVeform]:RESet 

 List Count 

Display control, non editable. Display the number of list points in the list when the list 

sweep file is selected. 

[:SOURce[1]|2]:LIST:FREQuency:POINts? 

[:SOURce[1]|2]:LIST:POWer:POINts? 

 

 Global dwell time 

Description 
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Set the dwell time mode of each list point in the list sweep mode. 

“Global” Use the same dwell time for all list points.  

“List” Use the dwell in the list. 

Remote command: 

[:SOURce[1]|2]:LIST:DWELl:TYPE 

 Dwell time 

Set the global dwell time to be valide in the global mode. 

Remote command: 

[:SOURce[1]|2]:LIST:DEWLl:ALL 

 List Trigger 

Set the trigger source to List Sweep. The trigger source has three modes: Auto, Ext 

and Trigger Key. 

“Auto” the trigger signal is always true, when a sweep is completed, the system 

automatically trigger the next sweep 

“External” The trigger signal is from the trigger input connector on the rear panel. 

“Trigger 

key” 

The trigger signal is from the trigger key in the interface 

Remote command: 

[:SOURce[1]|2]:LIST:TRIGger:SOURce 

 Trigger 

This button is valid when selecting the trigger key in the list trigger mode. Click to 

trigger the playing of a list point. Click continuously to trigger the playing of each list point 

in turn. 

Remote command: 

[:SOURce[1]|2]:LIST:TRIGger 

 Sweep start index 

This item is valid when the list sweep is ON. You can set to change the start index of 

the current sweep. The change will take effect immediately. 

Remote command: 

[:SOURce[1]|2]:LIST:INDex:STARt 

 Sweep stop index 
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This item is valid when the list sweep is ON. You can set to change the stop index of 

the current sweep. The change will take effect immediately. 

Remote command: 

[:SOURce[1]|2]:LIST:INDex:STOP 

 List file editing settings 

Access: 

Select [Sweep] -- >[List Sweep] -- >[Edit List Files...]. 

Setting: 

└Frequency/Power/Dwell Time 

└Index 

└ Add/Append/Delete 

└ Save and Apply 

└Save as 

 

 Frequency/Power/Dwell Time 

Data list edition. Edit the frequency, power and dwell time of each frequency point in 

the list. 

If the list sweep switch is on, after editing the current list, you need to click "Save and 

Apply" below to make it take effect. 

Remote command: 

[:SOURce[1]|2]:LIST:DWELl 

 Index 

Locate the list points in the current list by setting the index.  

 Add 

Insert a new line in the currently selected line of the list being edited. The data of the 

new line is the same as that of the current index line. Notice. The currently selected line in 

the list is marked identified by a white (yellow, getting focus status) box. After editing the 

current list, you need to click "Save and Apply" below to make it take effect. 

 Append 
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Appends a new line to the end of the list being edited. The data in the new line is the 

default setting data. After editing the current list, you need to click "Save and Apply" below 

to make it take effect. 

 Delete 

Delete a line in the list being edited. Including deleting the current line and deleting all 

lines. After editing the current list, you need to click "Save and Apply" below to make it 

take effect. 

 Store and apply 

After editing the current list, click this button to make the edition to take effect. 

 Save as 

Click to open the Save File dialog box to save the list being edited as a file. 

Remote command: 

[:SOURce[1]|2]:LIST[:WAVeform]:STORe 

 Auto filling-in of list 

List file editing supports automatic list filling-in. 

 Filling start index 

Set the start index of auto filling-in. 

 Number of filling-in 

Set the number of filling-in Fill in order from the start index. 

 

 Column selection 

Set the column to be filled in. Including frequency, power, and dwell time. 

[:SOURce[1]|2]:LIST:FREQuency 

[:SOURce[1]|2]:LIST:POWer 

[:SOURce[1]|2]:LIST:DWELl 

 

 Start Value/Stop Value/Step Value 

Set the data logic of auto filling-in. Set the start value, stop value and step value for 

frequency, power, and dwell time respectively. 

 Confirming filling-in 

Click to automatically fill them in list. 
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Power sweep 

Access: 

Select “Power”>“Power Sweep” 

└Power sweep ON/OFF 

└ Spacing 

└Step 

└Set characteristics 

└Level range 

 Power sweep ON/OFF 

Turn on or off power sweep of the current frequency point. 

During power sweep, the frequency point is unchanged, and the power is swept 

according to the set start, stop and step values. 

 

 

Power sweep is not in the output power range of the whole device, but in the AlC power 

range. The minimum power of ALC is -20dBm, and the maximum power varies according 

to the current model and whether the high power option is selected. For a model equipped 

with a programmed control step attenuator, the mechanical attenuator is fixed during the 

sweep. After the setting, start the power sweep. While ensuring the set maximum sweep 

power, the instrument calculates the appropriate gear of the attenuator and starts the 

sweep. If the set power sweep range is greater than the ALC power range, some power 

point outputs may be incorrect. The software will give a prompt. 

 

The power sweep is mutually exclusive with step sweep, list sweep and slope sweep. 

Remote command: 

[:SOURce[1]|2]:POWer:SWEep[:STATe] 

 Start power/Stop power 

Define the power sweep range by setting the start value and the stop value. 

Remote command: 

Notice 
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[:SOURce[1]|2]:POWer:STARt 

[:SOURce[1]|2]:POWer:STOP 

 Step value 

Indicate the interval distribution of power step size (step mode is linear), that is, the 

interval size is equal. 

Use the parameter "Step Value Length" to set the step size. 

Remote command: 

[:SOURce[1]|2]:POWer:STEP[:LINear] 

[:SOURce[1]|2]:POWer:STEP:LOGarithmic 

 

 Dwell time 

Dwell time of each step point. 

Remote command: 

[:SOURce[1]|2]:POWer:DWELl 

Analog modulation 

Analog modulation refers to the control of some parameters (such as amplitude, 

phase, and frequency) of carrier waveform with analog signals, so that these parameters 

change with the changes of analog signals. According to the analog signal, these 

parameters are modified to obtain the modulated RF signal. 

Ceyear 1466 supports AM (amplitude modulation), FM (frequency modulation) and 

ΦM (phase modulation and PULM). 

It generates low-frequency modulation signals in the form of sine wave, triangular 

wave, trapezoidal wave or square wave (pulse), which can be output for downstream 

instruments. 

The monitoring and synchronous output function allows you to synchronize the low 

frequency output signal with the pulse modulation signal. 

The instrument provides the following internal modulation signal sources: 

•Function generator 

•Internal modulation source 

•High performance pulse generator 
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Interaction and characteristics 

Some modulations are mutually exclusive and cannot be performed at the same time. 

Active amplitude analog modulation will automatically turn off IQ modulation; 

Frequency modulation and phase modulation are mutually exclusive. 

 

Content 

• Required Options 

• Modulation signals 

• Activate analog modulation 

• Modulation settings 

• How to generate modulation signals 

Modulation signal 

The signal sources of the modulation signal are internal modulation sources, function 

generators, or external signals. 

 Internal signal sources 

• Each modulation format provides two independent internal modulation sources. 

Sine wave and square wave with frequency range of 0.01 Hz to 10 MHz and optional 

shapes. Where, the frequency range of amplitude modulation internal signal source is 

0.01Hz to 100kHz. 

• Function generator 

 

Another low-frequency generator, used as the second modulation source. It has an 

extended frequency range of 0.01 Hz to 10 MHz and an optional signal shapes. 

 External input 

For the input of external amplitude, frequency, or phase modulation signals, you can 

input the signal on the external input connector on the front panel. 

 

Tips 

Notice 
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In case of External 1 and External 2 input signals, the maximum voltage of the AC 

signal is 1 VPP; The pulse signal has a low level of 0v and a high level of 3.3v. 

 

 The signal is distribute to the low-frequency output interface 

You can assign signals from internal signal source, function generator, External 1 and 

External 2 to the low-frequency output interface (LF) for output. Use the Low Frequency 

Output attribute page to configure the distribution. 

FM Config 

The following settings are specific to FM. The parameters of Path 1 and Path 2 can 

be set independently. 

└ Frequency modulation (Path 1/Path 2) 

└ FM frequency offset (Path 1/Path 2) 

└ Modulation source selection (Path 1/Path 2) 

└ FM waveform (Path 1/Path 2) 

└ Modulation rate (Path 1/Path 2) 

└ Sweep frequency sine start/stop frequency (Path 1/Path 2) 

└ Sweep frequency sine sweep time (Path 1/Path 2) 

└ Double-sine frequency 1/ frequency 2+ (Path 1/Path 2) 

└ Double-sine frequency 2 amplitude percent (Path 1/Path 2) 

 Frequency Modulation (Path 1/Path 2) 

Set the output status of Path 1/Path 2 FM signal 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:STATe 

 FM frequency offset (Path 1/Path 2) 

Set the FM frequency offset of path 1 or path 2. It should be noted that different 

frequency bands should correspond to different frequency offset ranges when setting 

frequency offset. 

Remote command: 
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[:SOURce[1]|2]:FM[1]|2[:DEViation] 

 Modulation source selection (Path 1/Path 2) 

Configure the modulation source of Path 1 and Path 2. 

Including the internal modulation sources of each path, function generators, External 

1 and External 2. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:SOURce 

 FM waveform (Path 1/Path 2) 

Set the output waveforms of FM signals, which is valid only when internal modulation 

source is selected as the modulation source. Including sine, square wave, triangle wave, 

ramp wave, noise, sweep sine and dual sine 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:SHAPe 

[:SOURce[1]|2]:FM[1]|2:INTernal:SHAPe:NOISe 

[:SOURce[1]|2]:FM[1]|2:INTernal:SHAPe:RAMP  

 

 Modulation rate (Path 1/Path 2) 

Set the internal modulation rate of FM. When noise, sweep sine, or dual sine is 

selected as the FM waveform, this item will be invalid. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency 

 Sweep sine start/stop frequencies (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set sweep sine 

start/stop frequencies. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:SHAPe SWEPtsine 

 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency:ALTernate  
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 Sweep sine sweep time (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set the sweep time 

of sweep sine. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:SWEep:TIME 

 Double-sine frequency 1/ frequency 2 (Path 1/Path 2) 

Valid when dual sine is selected as the modulation waveform. Set double-sine 

frequency 1/ frequency 2. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:SHAPe DUALsine 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency:ALTernate  

 

 Set the amplitude percent of double-sine frequency 2 (Path 1/Path 2) 

Valid when dual sine is selected as the modulation waveform. Set the double-sine 

amplitude ratio. 

Remote command: 

[:SOURce[1]|2]:FM[1]|2:INTernal:FREQuency:ALTernate:AMPLitude:PERCent 

PM Config 

The following settings are specific to ΦM. The parameters of Path 1 and Path 2 can 

be set independently. 

└ Phase modulation (Path 1/Path 2) 

└ PM phase offset (Path 1/Path 2) 

└ Modulation source selection (Path 1/Path 2) 

└ PM waveform (Path 1/Path 2) 

└ Modulation rate (Path 1/Path 2) 

└ PM bandwidth (Path 1/Path 2) 

└ Sweep frequency sine start/stop frequency (Path 1/Path 2) 

└ Sweep frequency sine sweep time (Path 1/Path 2) 
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└ Double-sine frequency 1/ frequency 2+ (Path 1/Path 2) 

└ Double-sine frequency 2 amplitude percent (Path 1/Path 2) 

 Phase modulation (Path 1/Path 2) 

Set the PM signal output status of Path 1/Path 2. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:STATe 

 PM phase offset (Path 1/Path 2) 

Set the phase offset of PM Path 1/Path. It should be noted that different frequency 

bands should correspond to different phase offset ranges when setting phase offset. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2[:DEViation] 

 Modulation source selection (Path 1/Path 2) 

Configure the modulation source of Path 1 and Path 2. 

Including the internal modulation sources of each path, function generators, External 

1 and External 2. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:SOURce 

 PM waveform (Path 1/Path 2) 

Set the output waveforms of PM signals, which is valid only when internal modulation 

source is selected as the modulation source. Including sine, square wave, triangle wave, 

ramp wave, noise, sweep sine and dual sine 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:SHAPe 

[:SOURce[1]|2]:PM[1]|2:INTernal:SHAPe:NOISe 

[:SOURce[1]|2]:PM[1]|2:INTernal:SHAPe:RAMP  

 

 Modulation rate (Path 1/Path 2) 

Set the internal modulation rate of PM. When noise, sweep sine, or dual sine is 

selected as the PM waveform, this item will be invalid. 



Operation Signal Generator 
Configuration of RF signal 

271 
 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency 

 PM bandwidth (Path 1/Path 2) 

Set different PM bandwidth. Different bandwidths correspond to different hardware 

paths. Different PM bandwidths correspond to different PM offsets. 

Remote command: 

[:SOURce[1]|2]:PM:BANDwidth|BWIDth 

 Sweep sine start/stop frequencies (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set sweep sine 

start/stop frequencies. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:SHAPe SWEPtsine 

 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency:ALTernate 

 

 Sweep sine sweep time (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set the sweep time 

of sweep sine. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:SWEep:TIME 

 

 Double-sine frequency 1/ frequency 2 (Path 1/Path 2) 

Valid when dual sine is selected as the modulation waveform. Set double-sine 

frequency 1/ frequency 2. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:SHAPe SWEPtsine 

 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency:ALTernate 
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 Set the amplitude percent of double-sine frequency 2 (Path 1/Path 2) 

Valid when dual sine is selected as the modulation waveform. Set the double-sine 

amplitude ratio. 

Remote command: 

[:SOURce[1]|2]:PM[1]|2:INTernal:FREQuency:ALTernate:AMPLitude:PERCent 

AM Config 

Provide settings of amplitude modulation. The following settings are specific to AM. 

The parameters of Path 1 and Path 2 can be set independently. 

└ Amplitude modulation (Path 1/Path 2) 

└ AM type (Path 1/Path 2) 

└ Modulation depth (Path 1/Path 2) 

└ Depth AM (Path 1/Path 2) 

└ Modulation source selection (Path 1/Path 2) 

└ AM waveform (Path 1/Path 2) 

└ Amplitude modulation (Path 1/Path 2) 

└ Modulation rate (Path 1/Path 2) 

└ Sweep frequency sine start/stop frequency (Path 1/Path 2) 

└ Sweep frequency sine sweep time (Path 1/Path 2) 

└ Double-sine frequency 1/ frequency 2+ (Path 1/Path 2) 

└ Double-sine frequency 2 amplitude percent (Path 1/Path 2) 

 Amplitude Modulation (Path1/Path2) 

Set the AM signal output status of Path 1/Path 2. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:STATe 

 

 AM type (Path 1/Path 2) 
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Set the AM type to be exponential or linear. When the user selects exponential AM, 

the AM depth will be in dB. When the user selects linear AM, the AM depth will be 

expressed as a percent. Path 1 and path 2 have the same amplitude modulation type. 

Remote command: 

[:SOURce[1]|2]:AM:TYPE 

 Modulation depth (Path 1/Path 2) 

When the AM type is exponential or linear, set the AM depth of the AM signal. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2[:DEPTh][:LINear] 

[:SOURce[1]|2]:AM[1]|2[:DEPTh]:EXPonential  

 

 Depth AM (Path 1/Path 2) 

This command is used to set the AM mode. When the DEEP mode is selected, the 

AM depth of the signal generator has a larger dynamic range than the modulation depth 

when the ALC loop is closed, and the AM index is better than the index in the data manual. 

Path 1 and path 2 have the same depth AM type. 

Remote command: 

[:SOURce[1]|2]:AM:MODE 

 Modulation source selection (Path 1/Path 2) 

Configure the modulation source of Path 1 and Path 2. 

Including the internal modulation sources of each path, function generators, External 

1 and External 2. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:SOURce 

 AM waveform (Path 1/Path 2) 

Set the output waveforms of AM signals, which is valid only when internal modulation 

source is selected as the modulation source. Including sine, square wave, triangle wave, 

ramp wave, noise, sweep sine and dual sine 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:SHAPe 

[:SOURce[1]|2]:AM[1]|2:INTernal:SHAPe:NOISe 
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[:SOURce[1]|2]:AM[1]|2:INTernal:SHAPe:RAMP  

 

 Modulation rate (Path 1/Path 2) 

Set the internal modulation rate of AM. When noise, sweep sine, or dual sine is 

selected as the PM waveform, this item will be invalid. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency 

 Sweep sine start/stop frequencies (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set sweep sine 

start/stop frequencies. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:SHAPe SWEPtsine 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency:ALTernate 

 

 Sweep sine sweep time (Path 1/Path 2) 

Valid when sweep sine is selected as the modulation waveform. Set the sweep time 

of sweep sine. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:SWEep:TIME 

 Double-sine frequency 1/ frequency 2 (Path 1/Path 2) 

Valid when dual sine is selected as the modulation waveform. Set double-sine 

frequency 1/ frequency 2. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:SHAPe DUALsine 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency:ALTernate 

 

 Set the amplitude percent of double-sine frequency 2 (Path 1/Path 2) 
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Valid when dual sine is selected as the modulation waveform. Set the double-sine 

amplitude ratio. 

Remote command: 

[:SOURce[1]|2]:AM[1]|2:INTernal:FREQuency:ALTernate:AMPLitude:PERCent 

Pulse modulation configuration 

Provide settings of pulse modulation. The following settings are specific to Pulse 

Modulation. 

Setting: 

└Pulse modulation 

└Pulse source 

└Pulse width 

└Cycle 

└Delay 

└Repetition frequency 

└External selection 

└Impedance (Ext 1, Ext 2) 

└Select pulse train/stagger file 

└Edit file 

└Jitter mode 

└Jitter percent 

└Sliding step 

└Sliding points 

└Sliding mode 

 Pulse modulation 

Set whether the pulse modulation signal of the signal generator is output. 

Remote command: 

[:SOURce[1]|2]:PULM:STATe 

 Pulse source 
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Set the pulse source modes of pulse modulation, including: external, scalar, auto, 

square, doublet, pulse train, external gated, externally triggered, stagger, jitter and sliding. 

the scalar mode, where the internal pulse generator generates the square wave of 

27.8kHz (18 microsecond pulse width, 36 microsecond period), and it is not allowed to 

change the associated pulse parameters. This kind of pulse is used for AC detection of 

scalar network analyzers. 

AUTO mode, without the need for external connection pulse signal. At the same time, 

activate the automatic trigger mode of internal pulse, which is not synchronized with other 

trigger signals. The parameters of the pulse signals can be set by the user through the 

configuration window. 

External gate trigger, obtain the logical sum of the internal pulse generator and the 

external pulse signals. 

Double Pulse, the logic of pulse signal is shown in the figure below. 

Remote command: 

[:SOURce[1]|2]:PULM:SOURce 

 Pulse width 

Set the pulse width of the pulse signal. If the pulse width value set is greater than or 

equal to the current pulse period, the pulse width will be automatically adjusted to a value 

smaller than the current pulse period. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:PWIDth 

 Period 

Set the pulse signal period. If the set period is less than or equal to the current pulse 

width, the pulse width will be automatically adjusted to be less than the pulse period. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:PERiod 

 Delay 

Set the pulse delay The actual maximum value that can be set depends on the pulse 

Period currently set by the user. In addition, it should be noted that the setting of pulse 

delay can only work when the pulse source is selected as Auto, Square, D-pulse and Trig 

modes, and the pulse delay has an inherent delay of 100ns when the trigger mode is 

selected. 
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Remote command: 

[:SOURce[1]|2]:PULM:INTernal:DELay 

 Repetition frequency 

Set the pulse modulation repetition frequency. The repetition frequency is the 

reciprocal of the period. If the repetition frequency value is changed, the period will 

change automatically. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:FREQuency 

 External selection 

This item is valid when the pulse source is set to external control and external trigger. 

Set the external input as Ext 1 and Ext 2. Corresponding to the external input interfaces 

on the front panel of the instrument 

Remote command: 

[:SOURce[1]|2]:PULM:SOURce:EXTernal 

 Impedance (Ext 1, Ext 2) 

This item is valid when the pulse source is set to external control and external trigger. 

Set the external input as Ext 1 and Ext 2. Corresponding to the external input interfaces 

on the front panel of the instrument 

Remote command: 

[:SOURce[1]|2]:PULM:SOURce:EXTernal[1]|2:IMPedance 

 Select pulse train/stagger file 

Effective when the pulse source is set to pulse train and the repetition frequency is 

staggered. Select the edited pulse train and the stagger file of repetition frequency. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:PTRain:SELect 

[:SOURce[1]|2]:PULM:INTernal:STAGger:SELect 

 

 Edit file 

Effective when selecting pulse train and stagger file. Click to edit a file 
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Remote command: 

[:SOURce[1]|2]:PULM:INTernal:PTRain:DATA 

[:SOURce[1]|2]:PULM:INTernal:STAGger:DATA 

 

 Jitter mode 

Effective when the pulse source is set to jitter. Set the jitter mode to random or 

Gaussian. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:JITTered:MODe 

 

 Jitter percent 

Effective when the pulse source is set to jitter. Set the jitter percent. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:JITTered:PERCent 

 Sliding step 

Effective when the pulse source is set to sliding. Set the step value of sliding. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:SLIDing:STEP 

 Sliding points 

Effective when the pulse source is set to sliding. Set the sliding points. 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:SLIDing:POINts 

 Sliding mode 

Effective when the pulse source is set to sliding. Set the sliding modes: Forward, 

Reverse, or Triangular 

Remote command: 

[:SOURce[1]|2]:PULM:INTernal:SLIDing:MODe 
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Data source and LF output settings 

Access: 

 Select “Function Generator”. 

In the analog modulation configuration window, in the “Data Source” attribute page, 

you can configure the external input attribute settings of the output signal of the function 

generator. 

 

Content 

•Function generator settings 

• External settings 

• LF output settings 

 Function generator settings 

└Frequency 

└Cycle 

└Waveform selection 

└Sweep sine start/stop frequencies 

└ Pulse width 

└ Pulse duty ratio  

└ Triangular rise 

└ Keystone rise/fall 

└ Keystone height 

Each Ceyear 1466 series signal generator is equipped with two function generators. 

Where, Function Generator 1 is connected to RF Channel A for use, and Function 

Generator 2 is connected to RF Channel B for use.  

 Frequency 

Set the output signal frequency of the function generator. this item will be invalid if 

noise, sweep sine, dual sine, or DC is selected as the waveform. 

Remote command: 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency  

 Period 
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Display control, non editable. The period is the reciprocal of the frequency, so as to 

faciliate the users to view the information. 

 Waveform selection 

Set the output waveform of the function generator 

Remote command: 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SHAPe 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SHAPe:NOISe 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SHAPe:RAMP 

 

 Sweep sine start/stop frequencies 

Valid when sweep sine is selected as the output waveform. Set sweep sine start/stop 

frequencies. 

Remote command: 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SHAPe SWEPtsine 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency:ALTernate  

 Sweep some sweep time 

Valid when sweep sine is selected as the output waveform. Set the sweep time of 

sweep sine. 

Remote command: 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SWEep:TIME 

 Double-sine frequency 1/ frequency 2 

Valid when dual sine is selected as the output waveform. Set double-sine frequency 

1/ frequency 2. 

Remote command: 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:SHAPe DUALsine 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency 

[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency:ALTernate  

 

[: SOURce<hw>]: FM:Mode 

 Amplitude percent of double-sine frequency 2 

Valid when dual sine is selected as the output waveform. Set the double-sine 

amplitude ratio. 

Remote command: 
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[:SOURce[1]|2]:LFOutput[:FUNCtion]:FREQuency:ALTernate:AMPLitude:PERCent 

 External setting 

└Input coupling type (Ext 1/ Ext 2) 

└Impedance 

 Input coupling type (Ext 1/ Ext 2) 

Select the coupling mode of external signal (AC or DC). Ext 1 and Ext 2 correspond 

to the BNC interface on the front panel of the instrument . 

Notice: this interface is also the entrance of coupling mode for setting external 

modulation signals of AM, FM and φ m. 

Remote command: 

[:SOURce]:EXTernal[1]|2[:SOURce]:COUPling 

 Impedance 

Set the impedance of the external power supply signal. 

Remote command: 

[:SOURce]:EXTernal[1]|2[:SOURce]:IMPedance 

 LF output settings 

Access: 

 Select “LF output”. 

In the "LF Output" attribute page, you can configure signals at the low frequency 

output end to determine the output voltage or add DC offset. 

Setting: 

└LF output 

└ Modulation source selection 

└Re-read 

└DC offset 

 LF output (impedance of 50Ω) 

Activate the output of low frequency signal. 

Remote command: 

[:SOURce[1]|2]:LFOutput:STATe 
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 Modulation source selection 

Determine the type of low frequency signal to be output. 

“Function 

generator” 

The output signal of the LF output port is the output of the function 

generator. When the LF output is ON, the signal is output. 

“Ext 1” The output signal of that LF output port is the signal introduce by Ext 

1. The output does not affect Ext 1 signal as the data source of AM, 

FM and PM. 

“Ext 2” The output signal of that LF output port is the signal introduce by Ext 

1. The output does not affect Ext 1 signal as the data source of AM, 

FM and PM. 

“AM Modulation 

Source” 

The output signal of the LF output port is the AM modulation source. 

When the LF output switch is turned on and the amplitude modulation 

switch of path 1 or path 2 is turned on, there is an output. If the AM 

switches of path 1 and path 2 are both turned on, the LF signal output 

is the superposition of the two signals. 

“FM-Frequency 

modulation 

source” 

The output signal of the LF output port is the FM/PM modulation 

source. When the LF output switch is turned on and the FM/PM 

switches of path 1 or path 2 are turned on, there is an output. If FM/PM 

switches of path 1 and path 2 are both turned on, the LF signal output 

is the superposition of the two signals. 

Remote command:  

[:SOURce[1]|2]:LFOutput:SOURce 

 Amplitude (Peak-Peak value) 

Set the voltage (peak-peak) of the selected LF output source. 

Remote command: 

[:SOURce[1]|2]:LFOutput:AMPLitude 

 DC offset 

Add a DC offset to the LF output signal. 

Remote command: 

[:SOURce[1]|2]:LFOutput:OFFSet 

Advanced power configuration 

In order to optimally adjust the RF output signal according to the specific 

requirements in the application, Ceyear 1466 provides more detailed power setting 
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functions: 

• Ceyear 1466 is equipped with a step attenuator, which enables you to change 

the amplitude of RF signal within a wide range. It is characterized by excellent VSWR 

(voltage standing wave ratio) in the whole level and frequency range, and provides the 

highest level of accuracy and noise suppression. 

 

•Automatic Level Control (ALC) 

Automatic level control can ensure the RF signal with stable power and have accurate 

power precision at different temperatures and for a long time. 

 

•User Power Calibration Compensation  

Different from simple power offset, user power calibration compensation function can 

realize accurate power compensation for user's trial frequency and cable loss, and ensure 

accurate input signal on user's DUT. 

 

• USB Power Meter 

Ceyear provides a series of USB average and peak power meters, which can be 

connected with Ceyear 1466. You can directly configure the measurement parameters of 

the power meter in Ceyear 1466 and monitor its reading, including user power calibration. 

Content 

• Attenuation control 

• Loop system 

• Calibration compensation cable 

• Using a power meter 

Attenuation control 

 

About attenuators 

Step attenuators are mechanical devices that provide fast and low insertion loss level 

setting. The sound of setting the attenuator position will be generated when initially setting 

the attenuator, which does not indicate any error of the signal generator. 

According to your application requirements, you can choose different attenuator 

types. 

 Set the attenuator 
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Access: 

 Select “Power” > “Attenuation Control”. 

 In the "Attenuation Control" dialog box, you can select the operation mode of the step 

attenuator equipped with the instrument. 

Setting: 

└Attenuation coupling 

└ ALC power 

└ Attenuation 

Attenuation coupling 

Define the working mode of the step attenuator. 

Set the control state of the internal programmable step attenuator: automatic or 

manual mode. In automatic mode, the signal generator will automatically set the value of 

the power attenuator according to the current output power. In manual mode, the power 

attenuation of the current attenuator will not change with the power output level. 

Remote command: 

[:SOURce[1]|2]:POWer:ATTenuation:AUTO 

Att 

Set the power attenuation value of the mechanical attenuator of the signal generator. 

The command setting value can only work when the attenuator is kept in the manual state. 

Different attenuation types are installed according to the H01 option, and the attenuation 

range is different. The minimum attenuation step value is 10dB, that is, the user can only 

set the attenuation value as 10dB, 20dB and 30dB, with 10dB as the step value. After 

setting the attenuation value, the output power of the signal generator is the current ALC 

power minus the attenuation value currently set. 

Remote command: 

[:SOURce[1]|2]:POWer:ATTenuation 

ALC power 

Set the ALC level value when the attenuator is set to manual. 

Remote command: 

[:SOURce[1]|2]:POWer:ALC:LEVel 

ALC Setup 
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Ceyear 1466 is equipped with automatic level control (ALC) unit to obtain the best RF 

level accuracy. 

About ALC 

ALC is an adaptive control system to stabilize the RF output level. The ALC loop 

continuously monitors and adjusts the output level to maintain a stable state at different 

temperatures and for a long time. 

By default, ALC is active (ALC closed loop). For narrow pulse modulation or low 

symbol rate modulation, it is not active. 

 

 

 Loop control 

Access: 

 Select [PWR] -> [LopCtrl]. 

 Setting: 

└ALC loop status 

└Search mode 

└Search output 

└Output blanking 

└Execute search 

 ALC loop state 

It is used to open or close the ALC loop. The main function of ALC loop is to correct 

power drift and keep the output power level of signal generator unchanged with time and 

temperature. 

Remote command: 

[:SOURce[1]|2]:POWer:ALC:STATe 

 Search mode 

It is used to activate or deactivate the automatic power search inside the signal 

generator when the ALC loop is open. The power search will make the power stabilize the 

signal generator on the output power selected by the user when the ALC loop is 

disconnected, and maintain the driving state of the internal modulator. The ALC loop is 

valid in the open loop state. 

“Man” Stop the automatic power search. The search mode is manual. 



Operation Signal Generator 

Configuration of RF signal (All) 

 

“Auto” The power is searched automatically with the change of RF output power or 

frequency. The search mode is automatic. 

Remote command: 

[:SOURce[1]|2]:POWer:ALC:SEARch 

 Search output 

Set the output type for search to normal or minimum. The ALC loop is valid in the 

open loop state. 

“Normal” If the step attenuator is not adjusted during the search, high-power signals 

may be output during the search. 

“Min” When searching, the step attenuator is adjusted to the maximum attenuation 

to ensure the minimum signal power during searching. After searching, the 

step attenuator returns to its original attenuation value. This mode will affect 

the search speed. 

Remote command: 

[:SOURce[1]|2]:POWer:PROTection[:STATe] 

 Output blanking 

Set the state of RF blanking. When blanking is on, if the signal generator is in a point 

frequency state, the RF output signal will be turned off during frequency switching.  If the 

signal generator is in sweep state, the RF output signal will be turned off during frequency 

band switching and retrace. 

Remote command: 

:OUTPut[1]|2:BLANking[:STATe] 

 Implement search 

Click to implement search The ALC loop is valid in the open loop state. 

Remote command: 

[:SOURce[1]|2]:POWer:ALC:SEARch ONEC 

 Stabilization mode 

 Stabilization mode 

Select the ALC power stabilization mode applied by the signal generator according to 

the appropriate situation, including internal and external modes 

In the external level control mode, the output power of the signal generator is 

detected by an external probe, the detection voltage is sent back to the level control circuit 
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of the signal generator, and the output power is automatically corrected to keep the power 

constant at the detection point. The following figure shows the typical application 

connection diagram of the external stabilization mode. 

 

Remote command: 

[: SOURce<hw>]: POWer: ALC: SLEVel 

 Coupling coefficient of external detection 

Set the external detection coupling coefficient when the amplitude stabilization mode 

is external. 

Remote command: 

[:SOURce[1]|2]:POWer:ALC:SOURce:EXTernal:COUPling 

 

 ALC Bandwidth 

 Bandwidth selection 

In the internal amplitude stabilization mode, the signal generator adopts an automatic 

level control (ALC) circuit before RF output. 

ALC bandwidth has five options: Auto, 10kHz, 1kHz, 100kHz, and 1Hz. 

In auto mode (reset option), the signal generator automatically selects ALC 

bandwidth according to the configuration and settings; When the frequency is less than 

1MHz or when vector modulation is on, the bandwidth is 100Hz, when the frequency is 

greater than 1MHz but less than 10MHz, the bandwidth is 1 kHz; when the frequency is 

greater than 10MHz, if AM is on and pulse modulation is off, the bandwidth is 100kHz;  in 

other cases, the bandwidth is set to 10kHz. In non-automatic mode of ALC bandwidth, the 

bandwidth is set according to user selection. 

Remote command: 
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[:SOURce[1]|2]:POWer:ALC:BANDwidth|BWIDth 

User calibration compensation 

Ceyear 1466 supports power correction function to compensate external losses, such 

as losses caused by RF cables, to achieve accurate target power on the DUT. 

The signal at the RF output of Ceyear 1466 is flat. However, the DUT is usually not 

directly connected to the output of the instrument, but is connected through a connecting 

cable. Components such as cables, power combiners, switches or mixers will affect the 

signal flatness at the input of DUT. 

About user calibration compensation 

User calibration compensation is a method to determine the external level loss in a 

certain frequency range in advance. The difference between the output level of the signal 

generator and the DUT level determines the correction value at the corresponding 

frequency. 

Take USB power meter as an example to introduce: 

The USB power meter is connected to the input end of the DUT and the USB 

interface of Ceyear 1466. 

The power meter measures the level in the frequency range, and the measured value 

corresponds to the loss caused by the components between Ceyear 1466 and DUT, and 

the correction data is obtained by inverting the collected data; Load the correction 

parameters in Ceyear 1466. 

For frequencies not included in the user calibration list, the level compensation value 

is performed by interpolating the closest correction value. 

Setting user defined compensation value 

You can customize the compensation value in the following ways: 

•Internal 

– Use the "Edit Calibration Compensation File" function to directly modify the power 

compensation values of different frequencies through the calibration compensation file 

editor.  

After being defined, it can be saved in a file. 

- –Use Ceyear power meter to obtain the actual frequency response characteristics 

of the components used. 

– Using corresponding remote control commands.  

Please note that the user calibration compensation file must be created first. 
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• External 

Create a file with a more positive value as a CSV file with Microsoft Excel, notepad or 

similar tools and saves it with a predefined extension. Transfer the file to the instrument 

and load it into the instrument. 

 User calibration compensation setting 

Access: 

Setting: 

└User calibration compensation switch 

└Select calibration compensation file 

└Edit calibration compensation file 

└Interpolation switch between frequency points 

└Compensation value of current frequency point 

 User calibration compensation switch 

Activate user calibration compensation. 

Ceyear 1466 displays a "compensation" prompt in the power area of the main 

information bar. Only when the calibration compensation file is selected can the switch be 

turned on. 

Remote command: 

[:SOURce[1]|2]:CORRection[:STATe] 

 Select calibration compensation file 

Click on the file selection dialog box to select the edited calibration compensation file. 

When a file is selected, the control displays the file name. 

Remote command: 

[:SOURce[1]|2]:CORRection:FLATness[:FILE]:SELect 

 edits calibration compensation file 

Open the built-in editor to edit the calibration compensation file. 

Remote command: 

[:SOURce[1]|2]:CORRection:FLATness:FREQuency 

[:SOURce[1]|2]:CORRection:FLATness:PAIR 

 

 Interpolation switch between frequency points 
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Whether to start compensation data interpolation for the data of non-compensation 

frequency points. On by default. Only the frequency points in the calibration compensation 

table will add compensation data. If the switch is turned on, the data between frequency 

points will be compensated according to the linear interpolation algorithm. 

 Calibration compensation editor 

 Edit compensation list data 

You can directly click on the compensation list to edit the data. Including power, 

frequency compensation values. After editing, click the Save and Apply button, and the list 

will automatically delete the repetition frequency points and sort them according to the 

order of frequency from small to large. 

 Frequency following switch 

When editing compensation list data, when a row in the list is selected, whether the 

whole instrument is set to the specified frequency of that line. The advantage of this 

setting is that when the user edits the compensation data manually, the set data is 

updated to the current frequency point in real time, which is convenient for verifying 

whether the input compensation data is feasible. 

Remote command: 

[:SOURce[1]|2]:FREQuency[:CW|FIXed]:AUTO 

 Power meter compensation setting 

 Power meter type /USB power meter manufacturer 

When LAN and GPIB are selected for power calibration connection, the power meter 

manufacturer is selected through the current settings. At present, Ceyear1466 supports all 

power meter types of mainstream manufacturers. 

When USB is selected as the power calibration connection mode, this setting is made 

by USB power meter manufacturer and cannot be edited. The instrument automatically 

reads the manufacturer and model of USB power meter and displays it in this setting. 

 Power meter calibration connection mode 

Set the interface type of power meter connected for calibration, including LAN, GPIB, 

and USB. 

Remote command: 

[:SOURce[1]|2]:CORRection:PMETer:COMMunicate:MODe 

 Power meter IP/GPIB address /USB power meter serial number 
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When the power meter calibration connection mode is LAN, this setting item is the IP 

address of the power meter. 

When the power meter calibration connection mode is GPIB, this setting item is the 

GPIB address. 

When the power meter connection mode is USB, this setting item is the serial number 

of the USB power meter connected. It supports connecting four USB power meters at the 

same time, and you can select one for calibration through this item. 

 Calibration 

 Zero or not 

Whether the power meter should be zeroed first when the power is automatically 

compensated by the power meter? 

 

For an USB power meter, this setting is valid. For a power meters with host 

connection, it may be invalid. 

 

Remote command: 

[:SOURce[1]|2]:CORRection:PMETer:ZERO:STATe: 

 Start calibration 

Click to start calibration According to the frequency points set in the calibration list, 

the whole instrument is calibrated at the current output power. 

 Table setting 

[:SOURce[1]|2]:CORRection:EXECute 

 Index 

When editing a list, you can quickly locate the indexed row by setting the index. 

 Inserting frequency point 

Insert a new line in a specified line of the list being edited. The data of the new line is 

the same as that of the original line. This location is the specified line of the last edited list. 

 Append 

Notice 
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Appends a new line to the end of the list being edited.

 

 Delete (delete the current line/delete all line) 

Click the pop-up drop-down menu and select the deletion mode. 

[:SOURce[1]|2]:CORRection:FLATness:DELete 

 Store and apply 

After editing, click this button to save the file and load it. 

 Save as 

Save the list file through the file save dialog box.

 Import/export 

The "Import/Export" function includes importing externally created list data or 

exporting list data files accordingly. You can process and store lists in the format of 

*.csv(Plain text with the same field sequence). 

File and Data Management 

Ceyear 1466 series instruments use files to save all instrument data. You can store 

and load device settings, import and export user data for processing in other devices, and 

share screen shots. 

This section mainly introduces the following contents: 

• About the file system 

• Restore instrument (default) configuration 

• Save and call instrument settings 

• Use the file manager 

• How to transfer files between instruments and to instruments 

• Create a screenshot of the current settings. 

About the file system 
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The files on the instrument are divided into system files and user files. For security 

reasons, system files are protected and cannot be accessed. This section only discusses 

user files. 

• “User data type”

• “File storage location” 

•  “File processing” 

•  “File naming rule 

•  “File extension” 

User data types 

The user data includes instrument settings, data in various modulation formats, 

mapping tables, lists and arbitrary wave data. 

According to different file contents, user data can be divided into the following data 

types: 

• Instrument settings, e.g.:current instrument settings or GSM/EDGE frame settings, 

which can be saved first and then loaded later.

• SCPI record, which can be exported and applied in the instrument control 

program.  

• A list generated inside or outside the instrument, for example, a user calibration 

compensation file can be directly loaded into the instrument for use. 

• Complex modulation and control datagenerated inside or outside the instrument 

can also be loaded into the instrument. 

• The externally generated arbitrary wave waveform file can be loaded in the 

Arbitrary Wave Configuration Window. 

File storage location 

By default, the instrument will store the user's files in the directories specified in the 

table, but the user can also actively choose the file storage path, including USB memory. 

The default user directory is /home/Ceyear/SgData/user. You can access this 

directory through the File Manager. 

Document processing 

To access files on the instrument, please use a standard File Manager, such as 

copying and moving data. 

To transfer files or exchange files between instruments, please use USB memory to 

transfer. 
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File naming rule 

The naming of files shall conform to the following conventions, otherwise, the normal 

use of files in different file systems cannot be guaranteed: 

• File namelength should not exceed 256 characters, and should be case sensitive. 

• Letters and numbers are allowed. 

• Avoid using special characters. 

• Do not use slashes "\" and "/". These symbols are used for file paths. 

• Avoid using the following file names: CLOCK$, CON, COM1 to COM4, LPT1 到

LPT3 to LPT3, NUL or PRN, etc., which should be reserved by the operating system. 

 

 

File extension 

Instruments distinguish file types according to extension; Each type of file will open 

the specified directory when it is saved and loaded. You can change the path, but it is 

usually not necessary to do so. 

Restore instrument (default) configuration 

The instrument provides several options to restore the default settings. You can reset 

the instrument settings to the default state at any time. 

Preset functional description 

You can choose the following default options: 

• Reset all settings 

This is the most commonly used function. It resets all the settings of the instrument to the 

specified state, and retains the network, remote access or system settings. 

 To perform this function, press the [Reset] key on the front panel. 

• Reset grouping settings 

 

In some settings windows, a "Reset Defaults” button is provided. Click this button to set a 

set of related parameters of this window as default values, while all other settings will be 

kept.  

For example, in the "Arbitrary Wave Configuration Window", you can use the "Restore to 

Default" function to reset the arbitrary wave switch, arbitrary wave file path, and clock 

frequency parameters to the default state. 

file:///C:/Users/wangpeng-yi/AppData/Roaming/Microsoft/Word/591ab24482904118.htm%23ID_318fce70806c8ee10a0020190042a7ed-28def8a8622da3a20a001ae750fa851d-en-US
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  To reset the grouping settings, click the "Reset Defaults" button in the corresponding 

configuration window. 

• “Reset a parameter” 

Set a single parameter to its default value. 

 To reset a single parameter: open its context-sensitive menu and select "Restore 

parameters to default values". 

Reset the instrument to the predefined status 

By default, the rese function will set all parameters to factory default values. In 

addition to these default settings, you can: 

Reset to user status, as follows: 

• The user first sets the instrument parameters as needed. 

• Open the system configuration window, set the reset type selection parameter 

to ”User“ in the ”Reset Status“ attribute page, and then click “Save User Status”. 

• After completing the above settings, click the "Reset" button, and all parameters of 

the instrument will be set to the state just saved by the user. 

Save and call instrument settings 

You can save or call a file that contains all the settings of the instrument, or you can 

choose to save or call only the files that belong to the settings of a specific signal 

simulation option. 

Content 

• How to save and call all settings of the instrument 

• How to save and call the settings of signal simulation option 

How Save and call instrument All settings 

The instrument settings can be saved to a file and loaded again later so that you can 

repeat the test with the same settings. 

Save all settings of the instrument. 

1. Click the "Save/Call" button in the previous version, or click the system menu in the 

lower left corner of the main interface and select the "Save Call" menu item to open the 

"Save Call Configuration Window". 

2. In the "Storage Settings" attribute page, you can click "Storage Status 1-4" to 

quickly store four states (you don't need to name the state file), or you can select a 
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storage path, name the state file, and then click "Save" to store all the settings of the 

current instrument as a state file with a specified file name. 

 

Call all settings of the instrument. 

1. Follow the above steps to save all the settings of the instrument. 

1. Click the "Save/Call" button in the previous version, or click the system menu in the 

lower left corner of the main interface and select the "Save Call" menu item to open the 

"Save Call Configuration Window". 

2. In the "Call Settings" attribute page, you can click "Call States 1-4" to quickly call 

four states, or you can select a state file under the specified path, and then click "Call" to 

restore all parameters of the current instrument to the contents specified in the state file. 

 

How to save and call the settings of signal simulation option 

The setting of signal simulation option can be saved and called separately. The 

following is an example of signal simulation option LTE/LTE-A.. 
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• Open the LTE/LTE-A option window, click the “Save Profile” button in the “General 

Configuration” attribute page to pop up the “Save Profile” window, select the save path, 

name the status file and save it. 

 

• Similarly, in the “General Configuration” attribute page, click the “Call Profile” 

button to open the “Call Profile “window, select the status file to be called, and click the 

“Select” button to set the parameters of the option as specified in the status file. 

Use the file manager 

The “File Manager” is a tool similar to standard Windows Explorer. 

You can perform the following tasks: 

• For details about copying files from the instrument to other media, please refer to  

 

 “How to transfer files between the instrument and other devices” 

• For details about copying files to another directory, please refer to “Copy, Cut, 

Paste and Delete” 

•Renaming and deleting a file 

• For details about creating a  directory, please refer to  “Create a New File 

Folder” 

• For details about displaying saved files, please refer to “How to display all saved 

files” 

 

 Each “Save/Call” window and “File Selection” window provides quick access to the 

“File Manager”. 

Tips 
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In the "File Management" window, you can view all user files stored on the 

instrument, which provides the functions required for file management, including 

renaming, deleting, copying or moving files. 

Content 

• Using the File Manager 

• How to display all saved files 

Using the File Manager 

 

 File type 

Select the file types to be listed. If you select a file type with a specific file extension, 

only files with this extension are listed. 

For an overview of supported file extensions, please refer to “User File Extension”. 

 Browsing files and directories 

Select the directory where the files to be deleted or copied are located. It will list all 

files in this directory. The selected file will be highlighted. The path indication is above the 

directory tree. 

Unlike the “Save/Call“ and “File Selection” windows, the ”File Management“ window 

displays the complete file name, including the extension. 

 Cut, Copy, Paste and Delete 

Same as standard file management function. 

Before deleting files, you must confirm the deletion operation. 

Remote command: 

MEMory:DELete[:NAME] 

MEMory:COPY[:NAME] 

 

 Renaming 

Rename a selected file or directory 

Remote command: 
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MEMory:MOVE 

 Create new file folder 

Create a new file folder. 

How to display all saved files 

Display all files in the internal memory 

1. Open the “file management” window. 

2. Navigate to home/ceyear/SgData/user/. 

 

Display all files in the USB flash drive connected 

1. Open the “file management” window. 

2. Navigate to media/Ceyear/SN of the USB flash disk. 
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“How to transfer files between the instrument and other 

devices 

You can transfer files between the instrument and other devices with any of the 

following methods: 

• Upload and download files through Web services: 

 Please refer to “Upload and download files through Web services”. 

• Through connected USB storage devices    

 Please refer to “Transfer files through USB storage devices” 

Content 

• Upload and download files through Web services 

• Transfer files through USB storage devices 

Upload and download files through Web services 

This is a way to access the instrument file system from a remote PC. Please refer to 

“Remote operation through Web browsers”.  

1. Open the Web service home page. 

2. Navigate to the Instrument Control->File Transfer page.  

 

3. In the file selection box, select the file or directory to Download, click the 

"Download" button above, and then download and save as prompted. 
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4. In the file selection box, select the directory where the target file is to be stored, 

click the "Upload File" button above, and then upload the file as prompted, or select the 

directory where the target directory is to be stored, click the "Upload Directory" button 

above, and then upload the directory as prompted. 

Transfer files through USB storage devices 

You can also use USB storage devices to transfer files directly between instruments. 

Transfer files containing user data to the instrument. 

1. Connect a USB storage device (such as a USB drive) to one of the USB interfaces 

of the instrument. 

The instrument will automatically identify the connected USB storage device. 

2. Refer to Using the File manager, 打 open the file manager. 

3. In the directory tree, navigate to media/usbdrive. 

Select the desired file that contains user data. 

4. Select “Copy”. 

5. In the directory tree, navigate to the directory home/ceyear/SgData/user/. 

Select “Paste”. The file containing user data will be transferred to the instrument. 
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Create a screenshot of the current settings 

When using the instrument, you can follow the following steps to save screenshots of 

interested software interfaces. 

1. In any interface, click the "Screenshot" button (picture) in the toolbar on the right to 

open the "Screenshot Management Window". If the toolbar on the right is not displayed in 

the current interface, please click the small "handrail" (picture) on the right, and the toolbar 

will pop up. 

2. The currently captured screen is displayed at the top of the "Screenshot 

Management Window", and the settings related to the screenshot file are displayed at the 

bottom. You can accept the default settings and save directly, or you can cancel 

"automatic naming", choose a storage path, name the screenshot file yourself and save it, 

or you can save the screenshot file in other picture formats through the "File Type" setting.
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General Functions of Instrument 

General instrument functions include custom user menu, option authorization, 

operation revocation or restoration . 

Content 

• Custom user menu 

• Option authorization 

• Undoing and redoing 

• Turning off and restarting the instrument 

Custom user menu 

You can add commonly used parameter settings to the user-defined menu window 

for quick access in the future. The specific operating are as follows: 

• On the parameter setting control, press and hold or click the right mouse button to pop 

up the context menu, and select "Add to User Menu".
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• On the right toolbar, click “User Menu” to open User Menu Window, and you can use 

the above parameter settings.

 

 

Option authorization 

Several software options have been pre-installed in the instrument, and they can be 

activated for used through the license file or key provided by the manufacturer. The 

specific operating are as follows: 

Note: In order to ensure reliable operation, you usually need to select the latest 

firmware version of the software. So if your instrument uses an old firmware version, 

please update the firmware before authorizing the option. Please contact the 

manufacturer for firmware update. 
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1. Click the "System" button in the lower left corner of the main interface of the 

software, and select the "Add Option Module" menu item in the pop-up system menu to 

open the "Option Authorization Window". 

 

 

2. In the “Option Authorization Window”, click the "Export Hardware Information" 

button to export the instrument hardware information to a file, and provide the contents or 

files of this file to the manufacturer. 

 

3. In the “Option Authorization Window”, click the “Import Authorization File” button 

and select the license file provided by the manufacturer for authorization. You can also 

enter the key provided by the manufacturer into the registration code area, and then click 

the "Register" button to authorize. 

4. Restart the instrument after the option is authorized successfully. 
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5. Click the "System" button in the lower left corner of the main interface of the 

software, and select the "About Signal Generator" menu item in the pop-up system menu. 

In the "About Information Window", you can view all options installed in the instrument.

 

 

Notice: After entering the key, you must ress "Enter" to confirm, and then register for 

authorization. 

Undoing and redoing 

The instrument software provides "Undo" and "Redo" functions. The "Undo" function 

can cancel the recent setting operation, and the "Redo" function allows you to repeat the 

operation just canceled. You can execute this function with the “Undo”  and “Redo”

buttons on the right toolbar.  

Turning off and restarting the instrument 

The "On/Off" button on the front panel allows you to turn off or restart the instrument, 

and the instrument also supports remote turning off or restarting. 

Network Operation and Remote Control 

This section describes the basic knowledge of remote control operation. As an 

alternative to interactive operation directly on the instrument, you can operate the signal 

generator from a remote location. The following figure shows the interface of the physical 

connection for remote access. 
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GPIB

USB

LAN

Hislip
VXI-11

SOCKET

Hislip
VXI-11

SOCKET

 

Remote control interfaces and protocols 

The instrument supports various remote control interfaces. The following table 

summarizes the remote interfaces and protocols: 

Remote control interfaces and protocols 

Interface Protocol and resource symbol name Description 

LAN  HiSlip 

TCPIP::host address::hislip0::INSTR 

 VXI-11 

TCPIP::host address[::LAN device name][::INSTR] 

 Socket 

TCPIP: : host address: port: : SOCKET 

 

USB  USBTMC 

USB::<vendor ID>::<product ID>::<serial number>[::INSTR] 

 

GPIB  -GPIB::<address>[::INSTR]  

 

LAN interface 

In order to integrate into LAN, the instrument is equipped with a LAN interface, which 

consists of connectors, network interface cards and protocols. 

For remote control through the network, PC and the instrument must be connected to 

public network with TCP/IP network protocol through LAN interface. TCP/IP network 

protocols and associated network services have been pre-configured on the instrument. 

Software for instrument control and (only applicable to specified protocols) VISA library 

must be installed on the controller. 
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If multiple instruments are connected to the network, each instrument has its own IP 

address and associated resource string. The controller identifies these instruments by 

resource strings. 

 VISA resource character string 

VISA resource string is required to establish communication session between 

controller and instrument in LAN. The resource string is a unique identifier, which consists 

of the specific IP address of the instrument and some network and VISA-specific 

keywords. 

TCPIP::host address[::LAN device name][::INSTR] 

TCPIP = Specified network protocol 

host address =  IP address or host name of the specify instrument 

[::LANdevice name] = Protocol and instance number of the defined instrument 

[:: INSTR ]= the instrument resource category (optional) 

IP address (host address/computer name) is used to identify and control the 

instrument. Users can configure the IP address through “System”-> “Port Settings”-> “LAN 

Interface”. 

 HiSLIP protocol 

HiSLIP (High Speed LAN I nstrument Protocol) is the follow-up protocol of VXI-11 for 

TCP-based instruments designated by the IVI Foundation. The protocol specifies a 

connection and uses two TCP sockets at the same time, one for fast data transmission 

and the other for non-sequential control commands. (E.g., Device Clear or SRQ). 

HiSLIP has the following characteristics: 

• High performance as the original socket network connection. 

• Compatible with IEEE 488.2 supports message exchange protocol, device 

clearing, serial polling, remote/local, triggering and service request. 

• Simplify firewall configuration by using a single IANA registration port (4880) 

• By providing a multifunctional locking mechanism, multiple users can access at 

the same time 

• It can be used in IPv6 or IPv4 networks 

The resource symbol names used for connection via the HiSLIP protocol are as 

follows: 

TCPIP::host address::hislip0[::INSTR] 
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hiSLIP0 = HiSLIP device name, specifying the use of HiSLIP interface protocol 

(required) 

hislip0 由 is composed of [::HiSLIP device name [,HiSLIP port]]. 

 

 VXI-11 protocol 

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote 

Procedure Call) protocol, which is the network/transport layer of the TCP/IP protocol. The 

TCP/IP network protocol and associated network services are pre-configured for 

communication. Such connection-oriented communication, which follows the sequential 

exchange and can identify the interruption of the connection, ensures no loss of 

information. 

The resource symbol names used for VXI-11 connection are as follows: 

TCPIP::host address[::instr0][::INSTR] 

[::inst0] = LAN device name, representing using VXI-11 protocol (optional) 

inst0  VXI-11 protocol is selected by default at present, which can be omitted. 

 

 

 Socket communication 

The TCP/IP protocol connects a signal source over a LAN socket in the network. As a 

basic method used in computer network programming, the socket allows applications 

using different hardware and operating systems to communicate over a network. With this 

method, two-way communication between the signal generator and the computer is 

realized through port. 

As a software class programmed specially, the socket defines the IP address, device 

port number and other necessary information for network communication, and integrates 

some basic operations in network programming. Sockets can be used after installing 

packaged libraries in the operating system. Two commonly used socket libraries are the 

Berkeley socket library for UNIX the Winsock library for Windows. 

Sockets in the signal generator are compatible with Berkeley sockets and Winsock 

through the application program interface (API). In addition, it is compatible with the API of 

other standard sockets. When SCPI are used to control the signal generator, the socket 

program established in the program issues the command. Before using a LAN socket, the 

socket port number of the signal generator must be set. The socket port number of the 

signal generator is 5025. 
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The resource symbol names used for socket links are as follows: 

TCPIP: : host address: port: : SOCKET 

port = Number of the port used 

SOCKET= the raw network socket resource category 

USB interface 

For remote control through USB connection, PC and instrument must be connected 

through USB B interface. USB connection needs to install VISA library. When the USB 

connection is established, VISA will automatically detect and configure the 1466 signal 

generator. It is not necessary to install a separate driver. 

The resource string represents the addressing scheme used to establish a 

communication session with the instrument. It is based on the address of the instrument 

and some information specific to the instrument and supplier. 

The syntax of USB resource string is as follows: 

USB::<vendor ID>::<product ID>::<serial number>[::INSTR] 

USB = indicates the interface used. 

<vendor ID> = manufacturer code, which is fixed to 0x3399 (Ceyear Technologies 

Co., Ltd.) 

<product ID>= instrument code, 1466 信号发生器为 0x2800 for 1466 signal generator 

<serial number>= serial number of the instrument 

[::INSTR] = represents instrument resource class (optional) 

GPIB interface (IEC/IEEE bus interface) 

As an instrument remote control interface widely used at present, GPIB interface is 

connected to different types of instruments through GPIB cable, so as to build a test 

system with the host computer. In order to realize remote control, the host computer 

should be equipped with GPIB bus card, driver and VISA library in advance. During 

communication, the host computer first addresses the controlled instrument through the 

GPIB bus address. The user may set the GPIB address and ID query string, and the GPIB 

communication language may be in the form of SCPI by default. 

GPIB provides channel addresses from 0 to 30. 

The syntax of GPIB resource string is as follows: 

GPIB::<address>[::INSTR] 

GPIB = indicates the interface used. 
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<address> = GPIB address used 

[::INSTR] = represents instrument resource class (optional) 

 

If the VISA implementation supports GPIB interface, you can choose to define VISA 

instrument control resource (INSTR). It is used to define the basic operations and 

properties of the device, such as reading, writing or triggering. 

 

Browser interface 

The browser interface allows for easy configuration of LAN and remote control of 

1466 signal generator without additional installation requirements. The browser interface 

of the instrument can work normally with all browsers conforming to W3C standards. 

 

Remote access settings 

Remote access settings 

Network settings 

The configuration of network interface is in the LAN configuration window, which can 

be accessed through “System”-> “Port Settings”-> “LAN Interface”. The configuration of 

LAN interface mainly includes configuration items such as network status, network restart, 

instrument name, workgroup name, DHCP switch, local IP address, subnet mask, 

gateway, port number and MAC address. 

Network status 

Indicate whether the instrument is connected to the network. When the instrument is 

connected to the network, the network status is green, indicating that the network is 

connected; When the instrument is not connected to the network, the network status is 

gray, indicating that the network is not connected. 

Restart the network 

Terminate the network connection of the instrument and reset it. You can fix network 

problems with this feature. 

Note: This function only restarts the connection of the instrument to the network. It 

will not affect the network itself. 

Notice 
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Remote command: 

:SYSTem:COMMunicate:LAN:RESTart 

Host name 

Display the host name. 

Each instrument has an assigned host name, a logical name that can replace the IP 

address. Use the default network settings, and the IP address is assigned by the DHCP 

server. This address changes every time the instrument is reconnected. Unlike IP 

addresses, host names do not change. 

• We recommend that you do not change the default host name to avoid network 

problems.  

If you change the host name, be sure to use a unique name. 

Remote command: 

:SYSTem:COMMunicate:LAN:HNAMe|HOSTname 

Working group 

Working group is the most common, simplest and most common resource 

management mode. Different instruments are put into different groups through working 

group, which is convenient for management. 

Address mode 

Select the mode for assigning IP addresses. 

“DHCP ON”  Automatically assign IP addresses, provided that the network supports 

DHCP (Dynamic Host Configuration Protocol) 

“DHCP OFF” Manually set the IP address of the instrument. Remote command: 

 

 

It is recommended not to turn off DHCP and set the IP address manually, otherwise 

the IP address will change every time the instrument is connected, so as to avoid causing 

trouble. 

 

IP address 

Set and display the IP address of the instrument in the network. When the setting is 

completed, the IP address will not change when the computer is turned on next time. To 

set the IP address manually, DHCP needs to be set to OFF. 

Notice 
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Remote command: 

:SYSTem:COMMunicate:LAN:ADDRess|IP  

 

Subnet 

A subnet mask is a 32-bit address, which is used to mask a part of an IP address to 

distinguish the network identification from the host identification, and to explain whether 

the IP address is on a local area network or a remote network. 

To assign subnet masks manually, DHCP needs to be set to OFF. 

Remote command: 

:SYSTem:COMMunicate:LAN:SMASk|SUNNet 

Gateway 

Set and display the gateway address. This address identifies the router on the same 

network as the instrument used to forward traffic to a destination outside the local network. 

If VXI-11 is used for automatic discovery, it is necessary to set the default gateway of 

remote control calculation to be the same as the default gateway of the instrument, 

otherwise it cannot be automatically discovered. 

To assign gateway addresses manually, DHCP needs to be set to OFF. 

Remote command: 

:SYSTem:COMMunicate:LAN:DGATeway|GATeway 

MAC address 

Display the MAC address, which is the unique identifier of the network adapter in the 

signal generator. This address cannot be modified. 

Remote command: 

:SYSTem:COMMunicate:LAN:MAC  

Port number 

Set and display the port number used for remote control of the instrument, with the 

range of 1024~65535. The value of the port number remains the same every time it is 

turned on. 

Remote command: 

:SYSTem:COMMunicate:LAN:PORT 

GPIB address setting 
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Open the GPIB configuration window through “System”-> “Port Settings”-> “GPIB 

Interface”, and modify the GPIB address of the signal generator by setting the local GPIB 

address. The default GPIB address of the signal generator is 19. Value range: 0 - 30. 

Remote command: 

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess  

Program-control compatibility settings 

Program-controlled compatibility refers to the 1466 signal generator, which supports 

the programed control instructions of other signal generators. It is necessary to switch the 

programmed control commands. At present, other supported instruments include 

SMW200A of 1465 and RS. When other programmed control command sets are selected, 

the instrument only supports the programmed control commands of the selected 

instrument. This function is convenient for users to control the 1466 signal generator with 

the original test system. 

Open the system configuration window through “System”-> “System Settings”-> 

“Basic Settings”, and select the "Programmed Control Compatibility" property page in this 

window to open the programmed control compatibility configuration interface. 

In addition, the programmed control command recording configuration is also 

designed in this configuration interface. The default programmed control command 

recording is off. When this function is turned on, all programmed control commands 

received by the signal generator will be recorded and stored in the 

file/sgdata/user/rmtscpirecord/rmt _ scpi.txt in turn.  

QR code 

Access: 

 Select “System Configuration” > “Basic Settings” > “Web Service”. 

The “Web Service” attribute page displays the current instrument address (IP 

address) in QR format. 

Connect the instrument to the local area network. In the same local area network, 

smart phones or tablet computers can access the instrument quickly through this QR 

code. 

ping command 

Ping is a very powerful TCP/IP tool, which can be used to detect the connectivity 

between the instrument and other equipment networks. 

The ping command uses ICMP echo request and echo reply packet. This function 

checks whether the communication with the device through LAN works properly. Ping is 

very useful for diagnosing IP network or router faults. 
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Start ping: 

1. In the Windows system, press tWindows+r to open the “Run”, and enter cmd in the 

opening to open the cmd.exe; 

2. In the Linux system, open the terminal (or press Ctrl+Alt+t). 

3. In cmd.exe or command terminal, enter the ping command followed by an IP 

address, such as ping 202.112.80.106 to enter, and then you can test the network 

connectivity of the input IP. 

When programming the instrument through the network, first ensure that the network 

is connected. 

Return to manual operation 

When the instrument is remotely controlled, the word "Remote Control" will be 

displayed on the status bar at the bottom of the instrument, and the button "Return to 

Local" will be displayed at the bottom right of the main interface. At this time, the 

configuration items in the instrument configuration window will be disabled and the keys 

on the instrument front panel will be invalid. Users can't configure the instrument by 

pressing keys or on the instrument interface. Users can resume local operations in the 

following three ways. 

 Click the "System/Local" button on the front panel. 

 Click the Return to Local button on the instrument interface. 

 Use the programmed control command SYSTem:COMMunicate:GTLocal. 

You can return to local area with the above three methods. It should be noted that 

when returning to the local area, it is necessary to ensure that all the sent programmed 

control commands have been executed, and no other programmed control commands will 

be sent later, otherwise the instrument will immediately enter the remote control state 

again after returning to the local area. 

Remote operation of instruments through Web services 

The instrument supports remote operation through Web browsers, such as Chrome

等 HTML5 Web browsers such as Microsoft Edge, Mozilla Firefox, or Google Chrome. 

Operate the instrument remotely through a web browser: 

1. Enter the IP address of the instrument in the address field of the browser, such as 

10.42.114.1, and open the instrument home page. 

2. Use the left navigation bar to navigate to the Instrument Control->Web Contrl page, 

you can see the screen of the instrument, and you can use the mouse/keyboard to 

remotely operate the instrument. 
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Automate tasks using remote command scripts. 

Considering the need of users' automatic test, 1466 signal generator provides a more 

convenient way for users to obtain programmed control commands and programmed 

control sample programs. Users can obtain programmed control commands through the 

instrument interface, which is convenient for matching functions with instructions; The 

obtained instructions are the functions you see. The 1466 signal generator provides 

programmed control sample projects in various programming languages, and users can 

choose different programmed control sample projects according to their own needs. The 

programmed control example project is a source code project, which can be compiled and 

run by users, and can be improved and modified according to the needs of SPCI 

commands to form an automatic test program for the required functions. 

Display SCPI command 

In the instrument configuration sub-window, click the right mouse button under any 

configuration item, or press it through the touch screen for a long time, and the following 

menu will pop up. Select the SPCI command to pop up the programmed control command 

window of this configuration item.  
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SCPI command recording and exporting 

The 1466 signal generator also provides a programmed control command recording 

function, and the user converts the user's local operations into corresponding 

programmed control commands in turn. It is convenient for users to obtain all SCPI 

commands of a complete configuration. 

Users can click icon 1 on the homepage to display the tool menu bar, and selects the 

icon of recording SCPI tool in the tool menu bar to open the SCPI recording function. At 

this time, the icon of "SCPI recording" is displayed at the lower right of the main interface 



Operation Signal Generator 

Network Operation and Remote Control (All) 

 

of the instrument, indicating that SPCI is being recorded, and any operation at this time 

will be converted into corresponding programmed control commands for recording. 

 

Users can also open the SCPI command recording function in any configuration item 

through the start recording SCPI command in the right-click menu. 

Users can open the SCPI recording management window to view the recorded 

programmed control commands by clicking Show SCPI Record in the toolbar, as shown in 

the figure. In this window, users can also manage the recorded instructions, such as 

Delete Current Item, Remove All, Save As File, and Save As Sample Project. With Save 

As File, you can save all the currently recorded programmed control commands as files in 

"*.txt" format. The default saving path is /SgData/user/ScpiRecord/. 
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There are three ways to stop SCPI recording. 1. Click the recording SCPI in the 

toolbar. 2. Directly click the red termination box in the icon in SCPI recording; 3. Select 

Stop Recording SCPI command from the menu popped up by right-clicking any 

configuration item. The three methods above allow you to stop the recording of SCPI 

instructions. 

 

Generaing a programmed sample project 

In the SCPI recording management window, recorded programmed control 

commands can be saved as sample projects; When you click “Save as Sample Project”, a 

window for generating sample projects will pop up as shown in the figure. 
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As shown in the figure, this window contains three configuration items: language 

selection, connection type and SCPI sample project generation. Language selection is 

used to select the language to generate the sample project, including five commonly used 

programming languages: QT, C++, C#, CVI and MATLAB. Where, except CVI, other 

language sample projects do not use VISA library, so only LAN interface connection types 

are supported. CVI language uses VISA library, so it supports many connection types 

such as LAN, GPIB and USB. 

 

 

After selecting the language and connection type, click the Generate SCPI sample 

project button, and the corresponding sample programmed control will be generated. The 

sample project is saved in the folder home/ceyear/sgdata/user/scpirecord/demo/ by 

default. 
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Fault Diagnosis and Troubleshooting 

This section introduces the way on how to judge and handle failures (if any) of the 

Ceyear1466 series signal generators, and feed them back to the manufacturer as 

accurately as possible if necessary for quick solution. 

Fault description 

Content 

• System Problems 

• Hardware Loss of Lock 

• Unleveled 

• Time base not hot 

• RF Output Power Failure 

• No Modulation at RF Output Port 

• Sweep Failure 

• Data Memory Problem 

• No Response From Front Panel Keys 

• Remote Control 

System Problems 

Standby lamp not on 

Check whether the 220V AC input (with max. allowable deviation of 220V±10%) of 

the signal generator is normal, which cannot be too high or too low. Otherwise, the 

instrument will run abnormally. If it is abnormal, check the external lines for any failure. 

After troubleshooting, power on the instrument again and start it. If the failure is caused by 

the power supply of the instrument itself, send the product back to the manufacturer for 

repairing or power supply replacement. 

No Fan Rotation After Startup 

In case of no fan rotation after startup, check the fan for any obstacle or too much 

dust. In this case, shut down the instrument, and remove the obstacle or clean the fan. 
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After that, power it on. If the fan still does not rotate, send it back to the manufacturer for 

repairing or fan replacement. 

Hardware Loss of Lock 

Reference loop unlocked 

The warning message “Reference loop losing lock” appears in the UI status indication 

area. If the signal generator is subject to cold start in the non-standby status, temporary 

reference loop losing lock may occur. If is ignored at this time, such message will 

disappear automatically 10 min. after startup. Otherwise, it deems to be a failure. In case 

of any failure, follow the steps below for troubleshooting: 

Operation steps: 

Step 1. Click 【System】 on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3  Search and check [Reference Board] via the Up/Down direction key, and 

continue to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the manufacturer. 

Local oscillator unlocked 

If “LO losing clock” appears in the UI status indication area, follow the operations 

below: 

Operation steps: 

Step 1. Click [System] on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3.  Search and check [Frequency Synthesis Board] -> [LO Loop Test] via the 
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Up/Down direction key, and continue to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple key steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the 

manufacturer. 

Note: For step 3, if the instrument is a dual-channel model, it is necessary to select 

the frequency synthesizer board of the corresponding channel for self-test according to 

the specific channel that is out of lock. 

 

YO loop loss of lock 

If “YO losing clock” appears in the UI status indication area, follow the operations 

below: 

Operation steps: 

Step 1. Click [System] on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3.  Search and check [Frequency Synthesis Board] -> [YO Loop Test] via the 

Up/Down direction key, and continue to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple key steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the manufacturer. 

Note: For step 3, if the instrument is a dual-channel model, it is necessary to select 

the frequency synthesizer board of the corresponding channel for self-test according to 

the specific channel that is out of lock. 
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DDS loop unlocked 

If “DDS Loss of Lock” appears in the UI status indication area, follow the operations 

below: 

Operation steps: 

Step 1. Click [System] on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3.  Search and check [Frequency Synthesis Board] -> [DDS Loop Test] via the 

Up/Down direction key, and continue to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple key steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the manufacturer. 

Note: For step 3, if the instrument is a dual-channel model, it is necessary to select 

the frequency synthesizer board of the corresponding channel for self-test according to 

the specific channel that is out of lock. 

 

Unleveled 

If the amplitude level setting of the signal generator exceeds the index range, an 

“Unleveled” indication may appear, which is normal, reminding the user of output 

amplitude uncertainty of the signal generator. 

If “Unleveled” appears in the UI status indication area, follow the operations below: 

Operation steps: 

Step 1. Click 【System】 on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3.  Search and check [ALC Board] via the Up/Down direction key, and continue 



Fault Diagnosis and Troubleshooting 

Fault Description 

325 
 

to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple key steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the manufacturer. 

Note: For step 3, if the instrument is a dual-channel model, it is necessary to select 

the ALC board of the corresponding channel for self-test according to the specific channel 

that is out of lock. 

Time base not hot 

When the 10M crystal oscillator of the signal generator is unstable, there may be an 

indication that the time base is not hot, which usually appears when the instrument is just 

started. If it doesn't happen at the start-up, the 10M crystal oscillator may be damaged, 

contact the manufacturer for maintenance. 

If “Time Base Not Hot” appears in the UI status indication area, follow the operations 

below: 

Operation steps: 

Step 1. Click 【System】 on the front panel to activate the system configuration 

window. 

Step 2.  Click [Instrument Self Test] to open the self test window for starting the 

instrument self test process automatically. 

Step 3  Search and check [Reference Board] via the Up/Down direction key, and 

continue to perform the following operations: 

Step 4. Set [Single Step Test ON/OFF] to ON; 

Step 5. Set [Mode Always/Error] to Error; 

Step 6 . Click [Run Test]; 

Step 7. It a self test contains multiple key steps, click [Continue] till the self test is 

completed. 

Step 8. Record the configuration value in each step and return it to the manufacturer. 

No response from front panel keys 
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If the signal generator has no response to the front panel keys, check whether the 

signal generator is in the remote control mode (The display will show a remote control 

mark in such mode). To exit the remote control mode, press 【Local】 to switch the status 

of the signal generator from remote control to local control. 

Remote control failure 

Command channel blocked 

In the remote control mode, when the signal generator receives a series SCPI 

program control commands and execution failure is overtime (for example, in the trigger 

sweep mode, the signal generator never receives any trigger signal, resulting in master 

waiting overtime and blockage of the remote control channel (GPIB, LAN or other 

interfaces) between the master and signal generator, failing to receive other commands), 

current remote configuration process must be interrupted, so that the master can control 

the remote control channel again, with specific steps shown below: 

Step 1 The master sends the “Clear Instrument” command to let the signal generator 

clean all commands running in the remote control channel currently 

and receive new program control commands. Send the command as per the 

interface and protocol types:

 Visa: viClear(); 

 GPIB: ibclr();

 RSIB: RSDLLibclr(). 

Step 2 Send the SCPI command “ABORt” during program control configuration to 

cancel current configuration and reset the trigger system. 

Error message 

The error messages of Ceyear 1466 series signal generators can be divided into local 

error and program-controlled error according to the operation mode, and fatal error, 

serious error, warning information and prompt information according to the important 

procedures of error information. Error messages of different importance will be presented 

in different ways. For example, fatal errors are usually displayed in the form of fatal level 

icon+content scrolling, while prompt messages are only displayed in the form of prompt 

icon+content for about 3 seconds. 

Local error 
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Error message view 

View via interface operation: 

In case of any error prompt in the taskbar at the bottom of the signal source during 

use, there is something wrong with the software or hardware of the signal source. You can 

basically judge the error type as per the error code, and take corresponding measures for 

troubleshooting. 

Signal source error information display area can only display error summary 

information. If you need to view more detailed error information, you can view the detailed 

information of all errors by doing one of the following: 

Click the "System" menu in the lower left corner of the main interface of the software, 

and select the “Instrument Error Information" menu item to open the "Instrument Error 

Information Window", where you can view the details of all error information. 

Or you can click the error display area of the taskbar to pop up a scrolling list of errors, 

and then click any of the list items to open the "Instrument Information Window". as shown 

in the following figure: 

 

 

 

 

 



Fault Diagnosis and Troubleshooting 

Error Message 

 

Error message description 

If the signal generator detects an error during operation, the error summary 

information (error level icon+error summary description) will be displayed in the error 

display area of the taskbar, and you can view the detailed information of all errors in the 

"Instrument Information" window. 

List of local error message description 

False code Error level Description of error 

-4001 Fatal error Reference loop loss of lock, the reference loop inside 

the signal generator is losing lock. 

-4002 Fatal error Time base not hot 

-4003 Fatal error Unstable amplitude, for overpower or no power 

-4004 Fatal error LO loop loss of lock, the LO loop signal inside the 

signal generator is losing lock. 

-4005 Fatal error YO loop loss of lock, the YO loop signal inside the 

signal generator is losing lock. 

-4006 Fatal error DDS loop loss of lock, the DDS loop signal inside the 

signal generator is losing lock. 

-4007 Fatal error Unstable amplitude of channel B, for overpower or no 

power 

-4008 Fatal error LO loop loss of lock of channel B, the signal inside the 

signal generator is losing lock. 

-4009 Fatal error YO loop unlock in Channel B, the YO loop signal inside 

the signal generator is out of lock. 

-4010 Fatal error DDS loop unlock in Channel B, the DDS loop signal 

inside the signal generator is out of lock. 

-4100 Fatal error Baseband board initialization failed 

-4101 Fatal error Baseband program configuration failed. 

-4102 Fatal error Baseband JESD not ready. 

-4110 Fatal error CPU initialization failed. 

-4120 Fatal error I2C bus initialization failed. 

-4130 Fatal error Motherboard initialization failed. 

-4140 Fatal error SmBus initialization failed. 
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-4200 Fatal error No enough space on the hard disk. Please clean the 

hard disk immediately and restart it. 

-2001 Alarm message There are frequency points in the sweep list whose 

output power exceeds the limit. 

-2002 Alarm message The output power of the current power sweep point 

exceeds the limit. 

-2010 Alarm message Programmed control error during calibration. 

-2020 Alarm message There are still a few days before the validity of option 

XXX. 

-1001 Prompt 

information 

Failed to open file 

-1005 Prompt 

information 

List sweep file content is empty 

-1006 Prompt 

information 

Step sweep off 

-1007 Prompt 

information 

List sweep off 

-1008 Prompt 

information 

Power sweep off 

-1009 Prompt 

information 

Slope sweep turned off 

-1010 Prompt 

information 

Arbitrary wave modulation off 

-1011 Prompt 

information 

Multi-tone modulation off 

-1012 Prompt 

information 

Digital modulation off 

-1013 Prompt 

information 

Please select the modulation type first. 

-1014 Prompt 

information 

5GNR off 

-1015 Prompt 

information 

4G-LTE off 

-1016 Prompt 

information 

3G off 
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-1017 Prompt 

information 

GSM/EDGE off 

-1018 Prompt 

information 

Radar signal simulation off 

-1019 Prompt 

information 

WLAN802.11 off 

-1020 Prompt 

information 

AMPath1 off 

-1021 Prompt 

information 

AMPath2 off 

-1022 Prompt 

information 

IQ modulation off 

-1023 Prompt 

information 

FM and PM mutually exclusive, original FM or PM 

switch turned off 

-1024 Prompt 

information 

Hopping off 

-1025 Prompt 

information 

IOT off 

-1026 Prompt 

information 

Intra-pulse modulation off 

-1027 Prompt 

information 

Pulse modulation off 

-1028 Prompt 

information 

DVB off 

-1029 Prompt 

information 

WLAN off 

-1030 Prompt 

information 

EMTC off 

-1031 Prompt 

information 

OFDM off 

-1032 Prompt 

information 

UWB off 

-1033 Prompt 

information 

Bluetooth off 

-1100 Prompt 

information 

USB power meter input frequency out of limit 
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-1101 Prompt 

information 

USB power meter zeroing failed 

-1102 Prompt 

information 

USB power meter reading power failed 

-1103 Prompt 

information 

USB power meter setting frequency failed 

-1110 Prompt 

information 

Local IP consistent with calibrated IP. Please check. 

-1111 Prompt 

information 

Local GPIB consistent with calibrated GPIB. Please 

check. 

-1120 Prompt 

information 

Set power out of limit in current band 

-1121 Prompt 

information 

Output power overload, accuracy out of limit 

-1150 Prompt 

information 

User power flatness compensation file is empty 

-1200 Prompt 

information 

Pulse modulation source set to auto 

-1201 Prompt 

information 

Modulation source of LF output 1 set to function 

generator 1 

-1202 Prompt 

information 

Modulation source of LF output 2 set to function 

generator 2 

-1203 Prompt 

information 

Modulation source of AM PATH1 set to internal 

modulation source 

-1204 Prompt 

information 

Modulation source of AM PATH1 set to internal 

modulation source 

-1205 Prompt 

information 

Modulation source of FM PATH1 set to internal 

modulation source 

-1206 Prompt 

information 

Modulation source of FM PATH2 set to internal 

modulation source 

-1207 Prompt 

information 

Modulation source of PM PATH1 set to internal 

modulation source 

-1208 Prompt 

information 

Modulation source of PM PATH2 set to internal 

modulation source 

-1209 Prompt 

information 

Please select the correct signal analog channel first. 



Fault Diagnosis and Troubleshooting 

Error Message 

 

-1210 Prompt 

information 

Error in format of arbitrary wave file content 

-1211 Prompt 

information 

The difference between the max. and min. frequencies 

of the hopping list is out of the bandwidth range 

-1212 Prompt 

information 

Pulse stagger file content is empty 

-1213 Prompt 

information 

Pulse train file content is empty 

-1301 Prompt 

information 

E2PROM reading successful 

-1302 Prompt 

information 

E2PROM writing successful 

-1303 Prompt 

information 

The current model does not support B-channel 

E2PROM reading and writing. 

-1304 Prompt 

information 

E2PROM wring or reading failuer 

Programmed Control Error 

Error message view 

In remote control mode, errors are recorded in the error/event queue of the status 

reporting system, and can be queried with the command "SYSTem:ERRor?". The format 

is as follows: 

"<Error code>, "<Error in error queue>; <Detailed error description>" 

Example: 

“-190,” data exceeding the maximum range; alreadt set to the maximum value.” 

A negative error code defined by the SCPI standard. This type of error is not specified 

here. 

List of descriptions on instrument feature error messages 

 

Failure 

code 

Error Description 

-101 Invalid character 

Invalid character: There are invalid characters in the command string 
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(command or parameter). 

For example: FREQ:!ERD 10GHz 

-108 Parameter not allowed 

Parameters are not allowed: the command has too many parameters, or the 

command without parameters follows the parameters. 

E.g.: *TRG 10 

-109 Missing parameter 

Missing parameters: The command has too few parameters. 

For example, POW 

-112 Program mnemonic too long 

Command string is too long: A single segment of the command has more 

than 12 characters. 

For example: OUTPutROSCillatorSTATe ON 

-113 Undefined header 

Undefined header: signal source receives an unrecognized command. 

Possible causes: Wrong spelling, or wrong abbreviation  of the command, 

etc. 

E.g.: FREQ:ALC 1 

-114 Header suffix out of range 

Command suffix out of range: when the set command suffix is within the 

allowable range, but there is no corresponding configuration item in the 

instrument. 

For example, when there are only 10 data in the multi-carrier configuration 

list, set RADio:ARB:MCAR:CARR53:FREQ 10. 

-115 Unexpected number of parameters 

Wrong number of parameters: for multi-parameter commands, when the 

number of parameters passed is too small or too large. 

E.g.: PULM:INT:STAG:DATA 10us 

-121 Invalid character in number 

Invalid characters in the numeric value: there are invalid characters in the 

numeric parameter. 

E.g.: FREQ 8 

-128 Numeric data not allowed 

Numeric parameters are not allowed: commands that cannot receive 

numeric parameters receive a numeric value. 

-131 Invalid suffix 
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Invalid suffix: when the set command suffix is within the allowable range and 

there is this configuration item in the instrument, but it’s not allowed to be set 

due to certain status. 

-150 String data error 

Character data error: check whether quotation marks need to be added. 

E.g.: MEM:DEL 123.txt   (File 123.txt exists) 

Correct: MEM:CLE "123.txt" 

-151 Invalid string data 

Invalid string data: the set string type data is illegal. 

E.g.: SYSTem:COMM:LAN:IP “10.10.0.” 

-161 Invalid block data 

Invalid block data: Check according to Section 7.7.6 of IEEE 488.2. 

-190 Out of range,set max value 

Data exceeding the max. range: it is detected that the parameter exceeds 

the latest value, and the signal source has sety the data to the max. value. 

For example: FREQ 10000GHz 

-191 Out of range,set min value 

Data exceeding the min. range: it is detected that the parameter exceeds the 

latest value, and the signal source has sety the data to the min. value. 

For example: FREQ 10000GHz 

-195 No Channal B 

Channel B option not installed: when the instrument adopts single channel, 

the instructions sent begin with SOURce2 or OUTput2. 

For example: SOURce2:POWer 10 

-200 Execution error 

Execution error: The signal source has received the instruction, but there 

was an error during execution. 

-224 Illegal parameter value 

Illegal parameter value: a discrete parameter was received, but it is invalid 

for this command. 

-256 File name not found 

The file name is not found: when the specified file does not exist 

Error type 
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The error event corresponds only to one type of error message, and the error 

message types are introduced in details below: 

 Query error (–499 to –400): indicates the output queue control of the instrument 

detects the message exchange protocol error specified in Chapter 6 of IEEE 488.2. At this 

point, the query error bit (bit2) of the event status register is set to 1 (please refer to IEEE 

488.2, 6.5 for details). The data cannot be successfully read from the output queue at this 

time (no kind of error is produced at present). 

 Instrument characteristic error (-399 to -300, 201 to 703, and 800 to 810): 

indicating that the instrument operation is not successful, and the reason may be 

abnormal hardware or firmware state. Such error codes are often used self-detection of 

the instrument. At this point, the instrument characteristic error bit (bit3) of the event status 

register is set to 1(no kind of error is produced at present). 

 Execution error (-299 to -200): indicating that an error is detected during the 

measurement of the instrument. At this point, the execution error bit (bit4) of the event 

status register is set to 1. 

 Command error (-199 to -100): indicating a syntax error detected during 

command parsing of the instrument, usually due to an incorrect command format. 

At this point, the command error bit (bit5) of the event status register is set to 1. 
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Method to Obtain After-sales Services 

Contact Us 

In case of any failure to the Ceyear 1466 series signal generators, check and save 

the error message, analyze possible causes, and refer to the methods provided in 

“Troubleshooting and Failure Removal” for preliminary troubleshooting. If the problem 

cannot be solved, contact the service and consultation center of the Company as per the 

contact information provided below and provide us with the error collected. We will 

coordinate with you to solve the problem as soon as possible. 

Contact information: 

Service Consultation: 0532--86889847   400--1684191 

Technical Support: 0532--86880796 

Quality Supervision: 0532--86886614 

Fax:0532--86889056 

Website: www.ceyear.com 

E-mail: techbb@ceyear.com 

Address: No. 98, Xiangjiang Road, Huangdao District, Qingdao, Shandong Province 

Post Code: 266555 

Package and Mailing 

In case of any failure to the signal generator that is difficult to be eliminated, contact 

us by phone or fax. If it is confirmed that the signal generator has to be returned for 

repairing, pack it with the original packing materials and case by following the steps 

below: 

1) Prepare a detailed description of the failure of the signal generator and put it into 

the package along with. 

2) Pack it with the original packing materials, so as to minimize possible damage. 

3） Place cushions at the four corners of the outer packing carton, and place the 

instrument in the outer packing carton. 

4) Seal the opening of the packing carton with adhesive tape and reinforce the 

packing carton with nylon tape. 

5) Specify text like “Fragile”! Do not touch! Handel with care!” and so on. 

file:///C:/Users/liuqingsong/AppData/Local/Temp/www.ceyear.com
file:///C:/Users/liuqingsong/AppData/Local/Temp/techbb@ceyear.com
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6) Please consign it as precision instruments. 

7) Keep a copy of all shipping documents. 

 

Precautions on packing the signal generator 

Using other materials to pack the signal generator may damage the instrument. 

Never use polystyrene beads to pack the instrument due to two reasons, that is, they 

cannot provide sufficient protection on the instrument, and they can be sucked in to the 

instrument fan by the static electricity generated, resulting in instrument damage. 

 

Instrument package and transportation 

Please follow carefully the precautions described in “Unpacking and Inspection” when 

transporting or handling the instrument (for example, damage occurred during delivery). 

 

Notice 

Tips 


